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1. Introduction

This user guide combines both Designer Pro and Designer PowerForms instructions. Product level info
notes help you differentiate and inform you which features are available under which product level.

Solutions section is only available under Designer PowerForms edition.

1.1. Basic Designer Concepts

This section describes the Designer elements that enable you to efficiently design label templates or to
create and manage a complex labeling solution that includes multiple labels, dynamic data sources, and
automatically run actions.

@ PRODUCT LEVEL INFO

Solution building is available in PowerForms.

Listed below are the essential Designer concepts. Being familiar with them provides a perfect starting point
for successful labeling projects.

+ Label

* Form

+ Solution

+ Object

* Document

+ Design Surface

+ Data Sources

+ Dynamic Data Manager
+ Dynamic Data Explorer
+ Solution Manager

« Action Editor

If you come across any other unfamiliar items while working with Designer, refer to the Help tab.

1.2. Label

Label works as a template to add label objects and print using any kind of printing media.
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Each object adds a different kind of content such as text, line, ellipse, barcode or rectangle to a label. The
content is either fixed (manually entered by the user) or dynamic (defined using values from connected data
sources).

After finishing with your label design, you can print the labels using any of your installed printers.

PRODUCT LEVEL INFO

Solution building is available in PowerForms.

Designing of a printable label belongs to basic Designer tasks. Designer allows creating and printing of
stand-alone labels and labels that are included in a printing solution.

Read about how to create, design, or edit a label here.

1.3. Form

|§ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

NicelLabel Designer form serves as a panel for entering, manipulating and viewing the data. The advantage
of using a form are simplified data-entry and label printing process for the end-user.

In NiceLabel Designer, a form is created within a printing solution. This means that a form is usually built in
combination with a predesigned label.

TIP

Forms allow you to build an entire tailor-made data handling system adaptable to current
business needs.

Read about how to create, design, or edit a form here.

1.4. Solution

|§ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

NicelLabel Designer solution acts as a container which includes multiple documents - labels, forms and
shared data sources. A single solution enables dealing with any number of labels, forms and shared
variable data sources.
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How do labels and forms cooperate in a solution? A label alone can be designed and printed. Multiplied
manual printing of a single label file is time consuming and difficult if the content needs to be constantly
updated. Therefore, NiceLabel introduced the ability to create forms which are combined with labels in a
solution.

As a part of a solution, label document(s) specify the layout of printed labels. Forms make sure the content
of printed labels is easily defined, edited, and updated. Forms also offer the user the control over a wide
range of data- and print-related actions.

The advantages of keeping multiple labels and forms in a single file are:

+ Simplified management print outputs.
« Simpler and time efficient label designing and printing.

+ Simplified use of shared variable data sources.

Read about how to create or edit a solution here.

1.5. Object

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Object is the basic building block for designing labels and forms. To design a label or form means to select,
add, and position the objects on the design surface.

Example

Each object performs a different role. Text object is in most cases used for single-line textual content that
does not need to adapt its font size to the label design. Barcode object adds a barcode whose type and
content can be adapted to the needs of current document. Radio Group object to allow a user to select a
single item from a set of mutually exclusive items.

Label object types and their purpose are listed here.

Form object types and their purpose are listed here.

1.6. Document

The term document is used for labels and forms - it can be used interchangeably.
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@ NOTE

Be careful not to mistake document with solution. A solution is always a stand-alone file
while a document - be it label or form — may be used as a stand-alone file or as a part of a
solution.

1.7. Design Surface

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Your design surface is a place to create, add, position, and interconnect label, and form objects.

To help you design labels and forms as simply and efficiently as possible, your design surface uses
usability and functional principles from Microsoft Office.

TIP

Use View tab to customize your design surface.

+ Learn more about design surface elements here.
+ Learn more about design surface editing actions here.

+ Learn more about design surface visual aid elements here.

1.8. Data Sources

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Data sources are containers that provide content for label or form objects. Available data sources of
NicelLabel Designer are listed and described in the table below:
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Fixed data Fixed content allows you to manually insert a value into an edit box using a
keyboard. The inserted value remains unchanged on every printed label.

All standard Windows editing features are supported for inserting and
editing the fixed content (cut, copy, paste, etc.). Special characters are
accessible via arrow button on the right side of the edit fields or via context
(right click) menu.

Variable If a label or form object is connected to a variable, its current value is
always displayed as the object's content. When the variable's value changes,
the change reflects in the appearance of the selected object.

Create and manage multiple types of variables using the Designer's
Dynamic Data Manager tool.

Function Functions process the existing data source values and store the result in
function-generated data sources.

Designer offers multiple types of functions that allow you to transform the
variable object content according to the current needs.

Database Various types of databases can be used as dynamic data source for
label or form objects. Select a database from the list of defined database
connections. When done, select the fields and use them as a data source
for an object.

1.9. Dynamic Data Manager

|§ PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

Dynamic Data Manager is a dialog that enables the user to manage the dynamic data sources for label and
form objects.

Label and form objects can be connected to multiple variables, functions and databases.

To open the dialog, click the Dynamic Data Manager button in the Designer ribbon.
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Read more about how to define the data sources in the following sections:

+ Work with variables.

+ Work with functions.

+ Use databases as content source.

+ Use internal variables as content source.

+ Use global variables as content source.

1.10. Dynamic Data Explorer

@ PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

Dynamic Data Explorer is a Designer tool for managing the data sources that are connected to label or form
objects.

Dynamic Data Explorer is located at the bottom left side of the Designer window. It offers an overview of
existing Variables, Functions and Databases and allows adding new sources.

Read more about the Dynamic Data Explorer and how to work with it here.
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1.11. Layers

Layers act as transparent surfaces that allow you to place your objects on labels or forms on multiple
levels.

When designing labels or forms that contain a large number of objects, layers help you manage the
positioning and visibility of added objects.

NiceLabel 10 allows you to use layers when designing labels and forms using the Layers panel. This helps
you design adaptable label templates and create forms that align with your business logic. Read more in
the section Layers Panel.

1.12. Solution Explorer

@ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

Solution Explorer is the Designer's dedicated tool for managing the labels and forms in a solution.

Solution Explorer is located at the bottom left side of the Designer window. It displays the existing labels
and forms and allows adding new ones.

Solution and Data source buttons toggle between Solution Explorer and Dynamic Data Explorer.
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1.13. Actions Editor
PRODUCT LEVEL INFO

This section is applicable to PowerForms.

Actions Editor is a dialog for managing actions in a Designer solution.

Th Copy + 4 *0 [‘ilﬁfg.n
oo €3 A  Omia s ox  Ribbon
Chpboand  Undo i Redo  Arioe grder Agd
Artan E. Condtion
1+ [ Opan Labst i A
11 R et Privter ¥ Mare Gpan Label
Bacition
B Fries Litel 7 £
Eaten bpe e Labal
Actions Explorer Satings
[t W B tact - rsnust irgus =[] 177 cuwta somsren
+ I Loy
o+ i v s
T e o - g impt
e

Editing Field

ok Cancel

Actions can be defined for:
+ Form: these actions are triggered with form events. They are applicable to the following events:
- On form load: action(s) are run after a form is loaded.
- On form close: action(s) are run after a form is closed.

- On form timer: action(s) are run after a specified time interval.
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- On Form Inactivity: action(s) are run after the form has been inactive for a given time interval.
+ Form object: these actions are triggered with object-related events.

+ Variable: these actions are triggered according to the received values.

1.13.1. Ribbon

Actions Editor Dialog ribbon includes commands for adding, removing and ordering the actions. It also
provides a direct access to frequently used actions.

Clipboard group icons activate the following actions:

+ Paste: pastes the clipboard data.

Cut: cuts the selection to the clipboard.
+ Copy: copies the selection to the clipboard.

+ Delete: deletes the selected items.

Undo & Redo group allows undoing or repeating actions.

+ Undo: Designer allows the user to undo the entire sequence of actions since opening the editor.

+ Redo: repeats the requested range of actions.

Action Order group defines the action execution order of selected actions.

+ Up and Down: arrows place the selected action in front or after any other existing action.

+ Right: arrow nests the selected action under the previous existing action.

NOTE

Nested action is any action that starts when the parent action is already in progress.

« Left: arrow makes a nested action independent of the preceding action.

NOTE

Certain actions cannot exits independently. If such action is added to the action list, a
warning appears. The warning defines which action should it be nested under.

Add assigns actions to the selected form object.

+ All actions button gives access to the entire range of Designer actions. Recently used actions are
listed on the top. Use Search... field to quickly locate any action by entering its name.
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+ Four buttons give direct access to the most commonly used actions:
+ Open Label: button adds the Open Label action to the event list.
+ Print Label: button adds the Print Label action to the event list.
+ Set Printer: button adds the Set Printer action to the event list.

« Quit: button adds the Quit action to the event list.

1.13.2. Actions Explorer

Actions Explorer is a tool for adding, removing and ordering the assigned actions. Use ribbon commands to
manipulate with existing actions or to add new actions.

The explorer columns provide instant overview of actions' execution options and their descriptions.
+ Enabled: enables or disables the included action.
+ Condition: display the condition for executing an action (if set).
+ Description: displays the information about an action as defined by the user.

Actions Explorer enables you to make a selection of multiple actions, and to perform copy, paste, and
delete operations with them. To make a selection, Use Ctrl/Shift + Click on the required actions.

NOTE

Multiple actions can only be selected under the same parent action, i.e. all selected actions
must be on the same level. See picture below.

X Delete /" Selection of actions on the same |

Clipboard = Undo & Red}/
Action Vs i - &
1.4 [ Open Labe //

11 '3' Set Pinter [l

12 R Redirect Printing to File Up Crl+Up r_PrmtTmFlle =...

i S I_WIHI'E'IT
evel

13 &8 Print Label Down Ctrl+Down
Left Ctrl+Left
Right Ciri+Right

[ Copy Ctrl+C
PE& Cirl+V

¥ Delete Del

1.13.3. Editing field

Editing field allows editing the advanced action properties.

+ Main properties of the selected action are available for editing on the top of the Main/editing field.
Main properties differ with each action - read the dedicated action description sections for details.
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+ About group allows you to describe all NiceLabel 10 actions.

+ Name: by default, action name is defined by its type and is therefore not unique. Define a
custom name to make it instantly recognizable among other actions, in logs and in potential
error messages.

- Description: user notes for the selected action. Description is displayed in actions explorer.

+ Action Type: read-only field which displays the type of action.

|§ NOTE

When upgrading from legacy solutions (created with NiceLabel V6 and back), update
the action names based on the currently selected language. Solution version becomes
updated.

+ Hidden properties define the less frequently defined properties. Hidden properties differ with each
action — read dedicated action description sections for details.

1.14. Keyboard and Mouse Support

To efficiently perform and complete the Designer tasks, follow the guidelines related to the use of keyboard
and mouse:

+ How to efficiently use keyboard and mouse

+ Keyboard shortcuts

1.14.1. Efficient Use of Keyboard and Mouse

Use the following list of tips to make your work with Designer easier and more efficient.

1. Select object anchoring point. Press <Ctr 1> key and click the object placeholders to quickly define
the anchoring point.

2. Label scrolling and zooming. Use mouse wheel to scroll the label. Holding <Ctr 1> when rotating
the wheel, adjusts zoom factor. <Shift> scrolls label left or right.

3. Set label or form properties. Double-click the design surface to open the label or form properties
dialog.

4. Vertical or horizontal object moving. Hold <Shi ft> while moving an object over the design
surface. The object is moved in straight vertical and horizontal lines.

5. Resize an object with arrow keys. Holding <Shi ft> while pressing arrow keys resizes the object.
6. Fine-tune the object position. Hold <Ctr > while pressing arrow keys.

7. Open contextual menus. Right-click the object or design surface to access the label, form or design
surface contextual menus.
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8. Select multiple objects. Hold <Shift> and click the objects to add them to the selected objects in

a group.

9. Quickly add an object with connected data source. Click the object's shortcut handle in the object
toolbox. A list of available data sources appears. Select a data source or add a new one, and click
the design surface to add an object which already has a dynamic data source connected to it.

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

1.14.2. Mouse Wheel Support

Use mouse wheel to speed up design object zooming and design surface scrolling.
+ Turning the wheel scrolls the label in a vertical direction.
+ Holding <Shift> and turning the wheel scrolls the label left or right.

+ Holding <CtrI> and turning the wheel zooms the label in or out.

1.14.3. Keyboard Shortcuts

Use keyboard shortcuts to reduce the time needed to accomplish frequent tasks with Designer. To
complete these tasks, use a standard combination of keys.

TIP

Keyboard shortcuts are just a faster and more convenient way of choosing commands. The
command itself is executed in the same way as if it was run from the menu or toolbar.

Action Press

Select all Ctrl+A

Run the startup form Ctrl+D

Paste Ctrl+V

Cut Ctrl+X

Move up 1

Move right =

Move down l

Move left «

Close Alt+F4
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Action Press
Zoom to document Ctrl+0
Bold Ctrl+B
Copy Ctrl+C
Italic Ctrl+
Close solution Ctrl+L
Zoom Out Ctrl+minus sign on numeric keypad
Zoom In/Out Ctrl+mouse scroll up/down
Open Ctrl+0
Print Ctrl+P
Zoom In Ctrl+plus sign on numeric keypad
Run the currently opened form Ctrl+R
Save Ctrl+S
Open blank label connected to default printer Ctrl+Shift+N
Redo Ctrl+Y
Undo Ctrl+Z
Undo all * Erases all changes from previously saved label/ Ctrl+Shift+Z
solution. Redo is not possible.
Cancel Esc
Move Focus Tab or Shift+Tab
Run Form Debugger when form is running Ctrl+Shift+F12
Start form and Form Debugger at the same time to debug the Ctrl+Shift+R
onFormLoad events
Format painter — copy object properties Ctrl+Shift+C
Format painter — paste object properties Ctrl+Shift+V

1.15. Options (Configuring the Program)

PRODUCT LEVEL INFO

Solution building is available in PowerForms.

To customize the general program configuration of Designer, open the Options dialog which is accessible
from your File tab.
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Language Labels: C:\Users!, \Decuments\Nicelabel\Labels

Global Variables Selutions (Forms): C\Users\) \Documents\NiceLabel\Solutions

=]
=]
=]

Licensed Printers Database: C:\Users!, \Decuments\Nicelabel\Datahase

Control Center Pictures: CAimages

Automation

Designer

OK Cancel

Designer configuration options are grouped on the following tabs:

+ Folders: allows you to set the default locations for storing the labels, forms (solutions), databases and
picture files.

+ Language: selects the user interface language. Select the preferred language from the listed options.
+ Global Variables: storage location for global variables.

+ Printer usage: locally logged usage of installed printers.

+ NiceLabel Control Center: allows you to enable and configure the monitoring of events and print jobs.
+ Automation: enables you to configure NiceLabel Automation settings.

+ Designer: enables you to configure opening behavior of NiceLabel 10.
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2. Workspace Overview

PRODUCT LEVEL INFO

Data source explorer and Solution manager are available in NiceLabel Designer Pro and
PowerForms.

Your Designer workspace provides a flexible and easy-to-use environment for both — simple label designing
and complex solution building.

Your Designer workspace follows widely used application interface guidelines and is equipped with tools
and interface elements familiar to most users.

Designer workspace includes the following:
+ Landing page
+ Object and Explorer Panels
+ Layers panel
+ Printer and Status bar

+ Tabs and Ribbons

+ Design Surface

F_ T )

DTQXE Design Surface

[Opamcom | Property ’
: Editor

Data source
=== explorer and
Solution manager

£ Printer and
status bar

-4
Label
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2.1. Landing Page

Your landing page in Designer is an introduction which opens after the application loads. The page includes
the following:

+ New document area: create new or open existing Designer documents.
+ Create a New Label: create new label documents.

+ New Solution: create solutions with labels and forms.

PRODUCT LEVEL INFO

Solution building is available in PowerForms.

+ Open from Document Storage: open labels or solutions from Document Storage on your
connected NicelLabel Control Center.

PRODUCT LEVEL INFO

Opening from Document Storage is available when connected to NicelLabel
Control Center, and requires an LMS license.

+ Open...: open existing label and solution files from your workstation, cloud or network locations.

@ TIP

When you create new labels based on sample templates, Designer creates a new
folder inside your Solutions folder. Your new folder is named after your sample. It

is located at: C:\Users\username\Documents\NiceLabel\Solutions\newly
created folder

+ Recent Files: lists recently used Designer files.

TIP

Your landing page and its sections are different when you run licensed Designer editions or
trial versions.

+ Learning resources: access useful resources to help you create labels and solutions, and learn more
about NiceLabel 10.

+ Training Videos: access your NicelLabel video tutorial library. Video tutorials help you learn label
design basics and solution building in just minutes.

+ User Guides: access the entire online library of NiceLabel user guides. User guides provide you
comprehensive descriptions and instructions for using NiceLabel 10.
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- Sample Files: access sample label collections and solution files. Use samples to get familiar
with NiceLabel 10, start building new documents, and to explore software capabilities. Samples

help you create labels compliant with industry standards like GS1 and GHS, and labels equipped
with mandatory objects like allergens or nutrition tables.

+ Printer Drivers: access NicelLabel printer drivers. Drivers let you optimize your labels to print on
specific printer models.

+ Software Information: contains information about your installed copy of NiceLabel 10 - license,

license key, and installed version. If a newer version of NiceLabel 10 is available, notification links
appear automatically. Click the link to download and install the latest version.

2.2. Object and Explorer Panels

Object and explorer panels are located at the left-most area of the Designer window. They provide access to
objects, Solution Manager and Dynamic Data Explorer.

+ Object Toolbox: Contains available objects. These objects are ready to be used on a label or form.
Click the selected object and drag it to the design surface.

Frame Text Picture
v
Button Button Edit
Group Field
[abc*| i =
Memo Combo List
Field Box Box
o
8= R
Radio Check Database
Group Box Table
=] =
I
Database Database Label
Navigator Search Preview
o &
Data Printer Print

Initialization ~ Settings Quantity

Object Toolbox

Solution Explorer Dynamic Data Layers

Search...

4 [l Labels - ~
':dc: . fabel Solution Manager/
aoe e .
A4 _~~ Dynamic Data Explorer/
letter = Layers Panel
4 [E] Forms
+ Add new form E

[ G51 Logistic Label Creator

+ Solution Manager: The tool for managing the labels and forms in a solution.

+ Dynamic Data Explorer: The tool for managing the data sources in a solution
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+ Layers Panel: The tool for managing the layers while you design labels or forms.

2.3. Layers Panel

@ PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

In NiceLabel 10, the Layers panel is a tool that helps you manage your layers and added objects while
designing labels or forms.

NOTE

Layers act as transparent surfaces that allow you to place your objects on labels or forms in
multiple levels.

+ Working with the Layers panel
+ Positioning your objects using layers
+ For easier designing: layer states

+ Keeping layers organized using the right-click menu

2.3.1. Working with the Layers panel

( ) '?\c‘lovelayer )
Delete layer up/down
s N — ~—
N n ! !
Add layer < 'E'""|T tayers /
[

- ,»’r N
\ J “}I_ % v Cur.rently
active layer
German =

Italian '8 )
J

English @ 0 yﬁ; Highlight layer
7 NS

L = .

L~ — > B
h"!#::'?:ir I [Lock/unlock
visible/hide layer layer

+ Adding a layer: Click the green plus button to add a new layer. This adds a new layer on top of the
default layer. The number of layers is not limited.

+ Setting the layer properties: The Layer Properties window appears automatically when you add a
layer. Use this window to set the properties of the added layer:

« Add Name and Description to make your layers easy to find and edit later when you add more
layers.
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+ The Visibility settings allow you to define if objects on layers are visible when you print the label,
or after you run the form.

@ NOTE

In comparison with layer states (see section Section 2.3.3, “For easier designing:
layer states”), the visibility settings affect the layout when you print a label, or
when you run a form.

+ Visible: defines if the objects on the selected layer appear on the printed label, or are visible
when you run the form.
Condition: the layer is visible if the result of the given condition is "True".

Example

You can create a single label template for labels in multiple languages. Stack the objects with
text in the required languages on the dedicated layers. Use visibility conditions to only display
the layer with the right language - in this case German.

Set layer visibility

About 7
Mame: German language A here.
~ /A 1
7
Description: Displays label template in Germap~~
L
//’/—
Visibility when label is printed .
y
Visible //'
Condition: | 1 Language selection v =
Ca

+ Deleting layers: Select a layer and click the red X button. This deletes the layer with all of its objects. If
the layer is locked, you cannot delete it.

+ Moving layers up or down: You can change the stacking order for your existing layers. This allows you
to define how the objects overlap. If you move one layer above another, you also place the objects on
this layer in front of the objects that belong to the layer below.

2.3.2. Positioning your objects using layers

Layers help you position label or form objects on the z-axis. This means that you can place your objects on
top or beneath the objects on other layers. If you change the stacking order of layers, you also change the
stacking order of objects.

@ NOTE

When designing labels or forms, the stacking order of layers tells you the vertical position
of each individual layer within all existing layers.

By default, you add all objects on a single layer. If you decide to add more layers, you can move your objects
onto newly added layers, or move objects from one layer to another at any time.
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To add objects to a specific layer, click the layer in the Layers panel to make the layer active, and drag the
objects onto the currently active layer.

B &[0

x AN NS

English
German

Italian

NOTE
You can only group the objects that belong to the same layer. To group objects from
multiple layers, move these objects onto the same layer first.

2.3.3. For easier designing: layer states

Layer states allow you to show/hide, lock/unlock, or highlight your layers.

|§ NOTE

Layer states only affect the label template or form layout during the design phase. After
printing a label or if you run a form, the layers remain visible even if you set their state
to invisible, locked, or highlighted. Manage the final visibility of layers using the Visibility
settings in the Layer Properties window.

_ N NT-Ea

[Make layer A /f/ N Q

visible/hide layer ( //’ Focus on layer
- 7

y,
e
@ VoA
Lock/unlock "/
layer (
—

Layer states allow you to:

+ Keep the layer visible or hide the layer. Toggle the states to make all layer objects visible or hidden
while you are designing your label template or form.

|§ NOTE

The ability to show or hide a layer helps you position the objects that appear above or
below other objects.

+ Unlock or lock the layer. If you lock a layer, you cannot:
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Add objects to this layer.
+ Move objects from other layers to this layer.

+ Change the position of the existing objects.

Delete this layer.

NOTE

Layer locking prevents unwanted layout changes.

+ Set focus on the layer. Use this option to determine which objects are on this on this layer by
defocusing the objects that belong to other layers. If you hover over the focus icon with your mouse
pointer, the objects on this layer remain visible, while all other objects become semi transparent.
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Print

2.3.4. Keeping layers organized using the right-click menu
Right-clicking a layer opens the contextual menu which helps you manage the layers of your label or form:

+ New layer adds a layer on top of the existing highest layer.
+ Copy makes a copy of the selected layer and all of its objects.
+ Paste pastes the copied layer.

+ Duplicate allows you to duplicate the selected layer with a single click.
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Print
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Main_Layer Duplicate
Rename
Hide Other Layers
Show All Layers
Lock Other Layers
Unlock All Layers.

Maove Down

Merge Down

Merge visible unlocked layers

Properties
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B

+ Rename allows you to change the name of the selected layer.

|§ NOTE

By default NiceLabel 10, names the layers as Layer_"number" where "number" tells
you the initial stacking position of the layer.

+ Hide Other Layers makes all layers with their objects invisible, except for the selected layer.
+ Show All Layers makes all layers with their objects visible.

+ Lock Other Layers makes only the selected object editable. This option locks the objects on all other
layers.

+ Unlock All Layers makes all layers editable.

+ Move Up/Down allows you to change the stacking order for the selected layer. Note that the layers
panel represents the stacking order of the layers. Use Move Up/Down to change the position of the
highlighted layer.

+ Merge Down moves the objects from the selected layer to the layer below. NiceLabel 10 places the
moved objects on top of the existing objects and deletes the merging layer.

+ Merge visible unlocked layers moves the objects from all unlocked layers to the lowest unlocked
layer. Objects from the upper layers are placed on top of the objects that belong to the lowest layer.
NiceLabel 10 deletes the merging unlocked objects.

+ Properties opens the Layer Properties window.

2.4. Objects Panel

In Designer, your Objects panel lists every object on your design surface, making it simple to find and
select exactly the objects you want on your label templates or forms. You can search and organize your
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objects within layers, both separately or in groups. Each layer shows your objects and object groups in a
tree structure.

You can find your Objects panel on the bottom left, next to your Solution, Data, and Layers panels.

®w g8
Data Printer Print
Initialization ~ Settings Quantity =

= 2 [3]

Search by name or data source...

4 Layer
I Pallet Label Preview
Print qty
0 Reset variables
3 Print Button

Searching and locating your objects with Objects panel.
Use your Objects panel to:
+ Search for objects by name or by connected data sources.
+ Display action indicator icons after object names when your objects have actions assigned.

+ Rename objects (when you press F2 on your keyboard).

|§ NOTE

When searching, press Enter on your keyboard, Object panel automatically selects the first
object within your search parameters.

You can move up and down between objects with your keyboard arrows.

Additional options in your object's context menu (right-click on objects or object names) include:
+ Copying, cutting, and deleting your objects or object groups.
+ Locking or unlocking your objects or object groups.
+ Arranging and aligning your objects or object groups.

+ Moving your objects and object groups between layers.

NOTE

In Objects panel you can't multi-select your objects and move them with drag.

When you design complex labels, your Objects panel helps you locate, organize, and update your label
objects.

39



2.5. Printer and Status Bar

Printer and Status bar stretches over the bottom part of the Designer window. The bar performs these
roles:

+ Printer Selection for the current print job. Select your preferred printer from the drop-down list of
installedprinters.

TIP

When changing a printer, label and paper size adapt automatically to the dimensions
defined by the printer driver.

+ Printer Properties: Gives you direct access to the properties dialog of the selected printer driver.
+ Design surface zooming.

« Windows mode indication. Windows mode is reported if the advanced printer driver interface has
been disabled in Label Properties > Printer.

TIP

Windows mode disables printing optimization methods.

+ Document protection indication: Indicates that the current document is password protected. To
manage document protection, go to File tab > Protection.

Protection Indication Printer Properties Zoom Slider

. .

A CAB A3 203DP - EE =t + 7%
e AN

— 4 -~ N
- S N o
e / N~ N T~

Windows Mode
Indication Printer Selection Zoom to Object/Doc Zoom Level
\ \

2.5.1. Status Bar Printer Selection

Status Bar Printer Selection dropdown list allows instant printer selection for label printing. The list is
populated with printers, which are installed on the system.

Design surface dimensions adapt to the selected printer automatically — as defined by the printer driver.
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2.5.2. Windows Printing Mode

When designing and printing labels with Designer, it is recommended to use NicelLabel printer drivers to
ensure an optimal printing output.

Although the NicelLabel printer driver is available for your printer, you can still print labels using the
Windows printer driver. To achieve this, open label properties and disable the use of advanced printer
interface.

When printing in Windows mode, the labels print as graphic files. This increases the amount of data sent for
each label and can slow down the printing process.

2.6. Tabs and Ribbons

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Designer uses a standard Windows-based interface.

The Designer's top section interface segments are described below.

2.6.1. Tabs

Tabs represent subsets of Designer features. The tabs contain interrelated commands that are available to
the user in an organized way — grouped, and labeled:

+ File (background): opens the print form and document management panel.

+ Home: offers commonly used commands such as copy/paste, print, and style commands.
+ Data: offers data source related commands.

+ View: gives you control over layout tools, zooming options and element markers visibility.

+ Solution: allows adding new labels and forms, starts printing actions and enables label file importing
and exporting.

+ Contextual tabs: appear after clicking an object. They allow you to define object-specific settings. The
type of contextual tabs adapts to the selected object.

+ Help: besides offering the access to F1 help, this tab leads you to multiple helpful resources that
make your work with Designer easier and more efficient.
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2.6.2. Ribbon

Ribbon is a rectangular area that spreads across the top of an application window. Related commands are
divided into ribbon groups. The ribbon changes along with the selected tabs and adapts to the currently
used tools using the contextual tabs.

The following Designer dialog boxes are equipped with a dedicated ribbon:

* Dynamic Data Manager

&= =N =]
© f D D S Sh S % D
Variables Functions Internal Global  Database Excel Access SOL  Text All Prompt | Import Data
- - Variables~ variable Connections~ Server File Databases Order Sources
General Add Step-by-Step Database Wizard Variables Import and Export

» Actions Editor

Actions Editor - On Click Event

[ Copy -ﬁ# Dmlm%'m

) - _

All Open Print  Set Quit
X Delete Actions ™  Label Label Printer
Clipboard | Undo & Redo | Action order Add

» Rich Text Editor

Rich Text Box Editor

Insert View
= =~
—L I'l. ] Arial vl |7 v A A BB B 1= = &2 3= )
— '—E| AAB == w EEC ON
Import Export  Paste BlI UUS S X" X, Aa~E~A -~ = === 4=~ 2 - Find Replace
File Clipboard Undo Redo Font [F Text Box [F Editing

2.6.3. File Tab
m Home Data View Solution Help

File tab serves as document management panel. The following options are available:
+ Start: takes you to the Designer landing page.
+ New: creates a new stand-alone label or a complete solution.
+ Open: allows opening existing label and solution files.
+ Import: allows you to import labeling files from non-NiceLabel labeling software.
+ Save: saves the active label or solution.

+ Save As: allows saving the active label or solution file by defining its name and location.
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+ Print: opens the printing form.
+ Store: stores the current label as a template on the printer to be used in store/recall mode.
+ Protection: prevents the label or solution from editing.

+ Close: closes the current Designer document.

@ TIP

This note is applicable if you have Open or create documents in new instances option
enabled.

If a document is closed while another document is already open, its instance
(NiceLabel 10 window) is closed as well.

+ Options: opens the dialog for configuring the program defaults.
« About: provides license and software version information.

+ Exit: closes the application.

2.6.3.1. Start

Start panel takes you to Designer landing page. Use it to create or open documents, access recently
opened files, preview files, and learn more about Designer.

2.6.3.2. New

|§ PRODUCT LEVEL INFO

Solution building is available in PowerForms.

New Label creates a new stand-alone label. New Label Setup Wizard opens after clicking this button.

New Solution creates a complete solution including (multiple) labels and printing forms. Solution designer
opens after clicking this option.

New from Sample Templates creates a document based on a selection of industry-standard templates.

|§ NOTE

Adding new labels or forms is also available in the Solution explorer. See section Solution
explorer for more details.
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@ TIP

There are two ways of opening new labels or solutions. You can open each additional
document in a separate instance (window) of Designer. An alternative way is to open
documents within the already opened instance. To select the way that suits you better, go to
File > Options > Designer.

@ TIP

When creating a new label based on a sample template, Designer creates a new

folder inside the Solutions folder. The newly created folder is named after the sample.
It is located at: C:\Users\username\Documents\NicelLabel\Solutions\newly
created folder

2.6.3.3. Open

Open dialog allows opening existing label and solution files.

Browse allows selecting the label or solution files on local or connected network drives.

Document storage opens the document storage location of the connected NicelLabel Control Center .

Recent Files field lists the latest files that have been edited. Click any of them to open the file.

2.6.3.4. File Tab Import

PRODUCT LEVEL INFO

Solution building is available in PowerForms.

Import allows you to import files into a solution. Supported file formats are:
+ Solution file (.nsln)
+ Label file (.nlbl)
« Label file (V6) (.Ibl)

+ Form File (V6) (.xff)

When an import command is issued, the Open dialog opens. Select the file you want to import. The
imported file becomes visible in the solution manager.

NOTE

Label .Ibl and form .xff files are legacy NicelLabel file types used with version 6 and earlier.
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2.6.3.5. Save

Save panel saves the active label or solution using the same file name that was used to open it.

NOTE

If a file has been opened for the first time, Save directs you to the Save as on the File tab.

2.6.3.6. Save as

Save as allows saving the active label or solution file by defining its name and location.

Recent folders field lists the folders that were recently used to save the label or solution files.

2.6.3.7. Print

Print opens the print pane. In Designer, the print pane hosts a powerful and customizable default printing
form.

Printing form customization options are described here.

2.6.3.8. Store/Recall Printing Mode

Store/Recall printing mode is a method for speeding up the printing process. It increases printer response
by reducing the amount of data that needs to be sent during repetitive printing tasks.

NOTE

Store option becomes visible in File tab if enabled in the label properties printer panel and
supported by the currently selected printer.

With store/recall mode activated, does not need to resend the complete label data for each printout.
Instead, default labels (templates) and internal printer elements (graphics, fonts) are stored in the printer
memory, and only sends recall commands which render the stored label content during the printing
process. Typically, a few bytes of data are sent to the printer as compared to a few kilobytes in the case of
normal printing.

The action consists of two processes:

+ Store label. During this process, creates a description of the label template formatted in the selected
printer's command language. When done, sends the created command file to the printer memory and
stores it.

+ Recall label. A label stored in the printer's memory is printed out immediately. Using the recall
process, creates another command file to instruct the printer which label from its memory should
be printed. The recall label command occupies a few bytes of data only. The actual amount of
data depends on the current situation. For fixed labels without any variable contents, the recall
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command file only contains the recall label command. For variable labels that contain variable fields,
the command file includes the values for these variables and the recall label command.

NOTE

Before activating this mode, make sure the appropriate printer driver is selected for the
label printer. Not all label printers have the ability to use the store/recall printing mode.

Follow these steps to activate the Store/Recall printing mode:

1. Double-click the label design surface. Label Properties dialog appears.
2. To enable the mode, select Use store/recall printing mode on Printer tab. Click OK.

3. Define label template(s). All label objects with variable content must be formatted as internal
printer elements:

« Text object content must only use internal printer fonts (not Truetype!).
+ Use internal printer barcodes in barcode objects.

+ If using variable objects with Truetype fonts, variable pictures or database fields, the default
values are sent to the printer during the label store process.

4. Click File > Store. Make sure the Store variant points to the correct memory location in the printer.
Click File > Store. Make sure the Printer memory location points to the correct memory location in
the printer.

5. Insert or select values for variable objects that are not formatted as internal printer objects. These
variables will be given the same value on each label. They will behave as objects with fixed values.

6. Click Store to printer to create the command file with label template description and to send it to
the printer.

7. Insert values for prompted label variables. These variables are linked with internal printer objects on
the label. For this reason, their values can be changed during each printing.

8. Click Print to send variable values and recall label command to the selected label printer.

2.6.3.9. Protection
Protection prevents the label or solution from editing.

+ Prevent document from editing: locks the label or solution. Enabling this option prevents any
unauthorized changes on file — only copying and printing are possible.

+ Requires a password to unlock document: prevents file editing with password protection. Check this
option to set a password. A file becomes editable only after entering the correct password.
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2.6.3.10. Options (Configuring the Program)

PRODUCT LEVEL INFO

Solution building is available in PowerForms.

To customize the general program configuration of Designer, open the Options dialog which is accessible
from the File tab.

Options
(e Folders
Language Labels: ChUsers! “Documents\Micelabel\Labels =]
Global Variables Solutions (Forms): Cih\lsersh ) \Documentsi\Micelabel\Solutions E
Licensed Printers Database: C\Usersh ‘Documents\Micelabel\Database =]
Control Center Pictures: Chimages

Automation

Designer

OK Cancel

Designer configuration options are grouped on the following tabs:

+ Folders: allows you to set the default locations for storing the labels, forms (solutions), databases and
picture files.

+ Language: selects the user interface language. Select the preferred language from the listed options.
+ Global Variables: storage location for global variables.

+ Printer usage: locally logged usage of installed printers.

+ NiceLabel Control Center: allows you to enable and configure the monitoring of events and print jobs.
+ Automation: enables you to configure NiceLabel Automation settings.

+ Designer: enables you to configure opening behavior of NiceLabel 10.

2.6.3.10.1. FOLDERS

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.
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When moving or sharing the documents you create in Designer, the locations of related documents and
files might become inaccessible. To prevent broken references, define the default search locations that
instruct Designer to search for the documents and files on alternative locations.

Use the Folders tab to define the default search locations for the documents and files that you work with in
Designer. These folders serve as the default search location if:

+ Designer cannot find labels on the specified locations. In this case, Designer searches for them in the
Labels folder.

+ Designer cannot find solutions on the specified locations. In this case, Designer searches for them in
the Solutions (Forms) folder.

+ Designer cannot find the connected database on the specified location. In this case, Designer
searches for the database in the Database folder.

+ Picture object file paths in labels or solutions are incomplete or missing. In this case, Designer
searches for them in the Picture folder.

Example:

A form in your solution includes a picture file named picture . png without a specified path. This is why
Designer cannot locate the requested picture.

Solution: When searching for a graphic file named picture.png, Designer goes to
C:\Users\user\Documents\NicelLabel\Graphics. This is the location defined in the Folders tab.

|§ NOTE

Make sure read/write rights are granted to the account under which the Designer is running.

@ TIP

Details about the check algorithm which is used to locate the label and solution files is
described in detail https://help.nicelabel.com/hc/articles/4405121431953.

|§ NOTE

When opening and saving your documents, Designer remembers the last used location. The
next time you open or save your documents, Designer goes to the last used location.

2.6.3.10.2. LANGUAGE

Language tab allows selecting the Designer interface language. Select the appropriate language and click
OK.
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NOTE

Restart is necessary to make the user interface appear in the selected language. Make sure
you save your work before closing the program.

2.6.3.10.3. GLOBAL VARIABLES
Global Variables tab allows defining which location with stored global variables should be used:

+ Use global variables stored on the server (NiceLabel Control Center): sets the global variable storage
location on the NiceLabel Control Center.

S NOTE

Select the NicelLabel Control Center before selecting this option.

|§ NOTE

This option becomes available when using the NiceLabel Label Management Solution
license.

+ Use global variables stored in a file (local or shared): sets the global variable storage location in a
local or shared folder. Enter the exact path or click Open to locate the file.

By default, global variables are stored in Globals.tdb file in: C:\ProgramData\NicelLabel\Global
Variables\.

TIP

These two options become useful when designing solutions for multiple customers with
their own sets of global variables.

2.6.3.10.4. LICENSED PRINTERS

Licensed Printers tab displays printers which have been used with NiceLabel 10.

NOTE

Printer usage logging is available with multi-seat license. Details about printer licensing is
available in section Printer Licensing Mode.

Printer usage information group displays how many of the permitted printer ports are used by printing on
multiple printers.
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+ Number of printers allowed by license: number of permitted printers to be used with the current
Designer license.

+ Number of used printers in the last 7 days: number of printers that have been used with Designer
during the last 7 days.

|§ NOTE

If the used printer count exceeds the permitted number of used printers, NiceLabel 10
activates the grace period. The software grants the end-user a 30-day time extension during
which the number of licensed printers is doubled. If the doubled number is also exceeded,
printing becomes disabled on the additional printers.

Printing statuses are visible in multiple columns:

+ Printer: name or model of the printer that was selected for the print job.

|§ NOTE

If the connected printer is shared, only printer model is displayed.

+ Location: name of the computer from which the print job has been sent.
+ Port: port used by the printer.
+ Last Used: time passed since the last print job.

+ Reserved: prevents the printer from being removed after being idle for more that 7 days.

NOTE

If a printer remains unused for more then 7 days, it is removed automatically unless the
Reserved option is enabled.

Permissions group allows you to lock printer usage on local workstation.

NOTE

Before activating this option, make sure at least one printer is reserved. With no printers
reserved, an error is reported if you try to edit a label. Printing is disabled as well.

+ This workstation can only use reserved printers: with this option enabled, only reserved printers are
allowed for label editing and printing in NiceLabel 10.
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@ TIP

Use this option to avoid exceeding the number of available licensed printer seats by
printing on unwanted printers or print-to-file applications. Reserve dedicated thermal
or laser labeling printers and limit printing only to them to ensure continuous printing
of labels with a multi-user licence.

This option can also be enabled using the product.configfile:

1. Navigate to the System folder.

Example:

%PROGRAMDATA%\NiceLabel\NiceLabel 10

2. Make a backup copy of the product.config file.
3. Open product.config in atext editor. The file has an XML structure.
4. Add the following lines:

<Confi gurati on>
<Acti vati on>
<ReservePri nt er s>Example Printer</ ReservePrinters>
</ Activation>
<Conmon>
<Ceneral >
<ShowOnl yReser vedPri nt er s>True</ ShowOnl yReser vedPri nt er s>
</ Ceneral >
</ Common>
</ Configuration>

5. Save thefile. The Example Printer isreserved.

2.6.3.10.5. NICELABEL CONTROL CENTER

Control Center tab allows you to enable and configure the monitoring of events and print jobs. The use
of NiceLabel Control Center enables centralized event and print job reporting, and centralized storage of
global variables.

This tab is available only if LMS license is activated.

Address
Address group defines which NiceLabel Control Center server should be used.

« Control Center server address: URL of the connected NicelLabel Control Center server. You can select
from the list of automatically discovered servers on the network, or enter a server address manually.
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|§ NOTE

The license keys on the NiceLabel Control Center server and on the workstation must
match to enable the connection.

S NOTE

If your connected NicelLabel Control Center uses the application authentication, each
NiceLabel 10 startup requires you to type in your user name and password. Read more
about the authentication types and user privileges in the NiceLabel Control Center user
guide, section Authentication.

Event Monitoring

Event handling in the NiceLabel Control Center allows central management of labeling workstation
activities. Activities like label printing, errors, alerts, middleware application triggering, etc. are reported
and logged to NiceLabel Control Center.

Event Monitoring group defines what types of events should be logged by the connected NicelLabel Control
Center:

+ Print Events: logs the print related events from the workstation.

+ Error Events: logs all reported errors.

S NOTE

By default, Print Events and Error Events are logged to NiceLabel Control Center.

+ Trigger Activity: logs all fired triggers.

+ Trigger Status Change Events: logs the trigger status changes which have been caused by the fired
triggers.
Print Job Monitoring

Print Job Monitoring group enables you to log the completed and ongoing print jobs to the NicelLabel
Control Center.

+ Enable Print Job Logging to Server: activates print job logging.

+ Detailed printing control: enables monitoring of statuses that are reported by the connected printer.
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|§ NOTE

There are two requirements to make this option available:

« The printer must support bidirectional communication.

+ NicelLabel printer driver must be used for printing.

2.6.3.10.6. AUTOMATION

Automation tab enables you to configure NiceLabel Automation settings.

NOTE

This tab becomes visible with NiceLabel PowerForms Desktop and LMS licenses.

Service Communication group defines the communication settings.

+ Service communication port: number of the port which is used by the Automation service for
communication.

Log group configures how the below listed messages reported by the Automation Manager are logged.

|§ NOTE

The default data retention time is 7 days. To minimize log database size on busy systems,
reduce the retention period.

+ Clear log entries daily at: selects the time at which the daily log entries are cleared.
+ Clear log entries when older than (days): sets the log retention time in days.
+ Log messages: selects the message types that are logged.

+ All messages: saves all message types in the log.

+ Errors and warnings: saves errors and warnings in the log.

« Errors: saves errors in the log.

+ No log: no messages are logged.

Performance group enables improving the time-to-first label and general performance of the Automation
service.

+ Cache remote files. To improve the time-to-first label and performance in general, NiceLabel 10
supports file caching. When you load the labels, images and database data from network shares, all
required files must be fetched before the printing process can begin.
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TIP

If you enable local caching, the effect of network latency is reduced as label and
picture files are loaded from the local disk.

Automation service uses the following local folder to cache the remote files: %PROGRAMDATA%
\NiceLabel\\FileCache.

+ Refresh cache files (minutes): defines the time interval within which the files in the cache are be
synchronized with files in the original folder. This is the time limit for the system to use a version
which may not be the latest.

+ Remove cache files when older than (days): defines the time interval after which all files are
removed from cache.

NOTE

File caching supports label and picture file formats. After you enable file caching,
restart Automation service to make the changes take effect.

2.6.3.10.7. DESIGNER
Designer tab enables you to configure opening behavior of Designer.
Opening Mode group defines how your Designer opens new documents.

- Display each document in its own window: If enabled, additionally opened documents appear in
separate windows of Designer. This applies to both — newly created and existing documents.
If you decide to disable this option, additionally opened documents will appear within the currently
active instance of Designer.

2.6.3.11. About

The About dialog page provides information about your NiceLabel product license, enables license
purchasing (when in trial mode) and activation, provides software details, allows you to sign in to your
NiceLabel Cloud account, and enables you to change the Designer product level.

+ Product level tells you the product level you are currently running.

+ Change product level: opens the product level selection dialog. When in trial mode, you can choose
and evaluate all product levels. With an activated license, you can change your product level only to
lower levels.

+ Trial mode duration: information about the remaining days for product evaluation.
+ Purchase License: button directs you to the NiceLabel online store.

+ Activate license: button opens the Designer license activation dialog. See NicelLabel 10 installation
guide for details about the license activation process. After activating the license, this button is
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renamed to Deactivate License — after clicking it and confirming the deactivation, your copy of
Designer is no longer activated.

|§ NOTE

These segments are no longer visible after purchasing and activating the product
license.

|§ NOTE

Product level changes take effect after you restart Designer.

|§ NOTE

If NiceLabel 10 has been installed with predefined product level (i.e., the level has
been defined by the license key), product level selection is not required during first
start.

+ License type: is the type of license that you are using to run the NiceLabel 10. If you activated the
Designer by signing into the NiceLabel Cloud, here is where you see the Edition of your cloud.

+ Upgrade license: opens the product level upgrade dialog. See NiceLabel 10 installation guide for
details about the license upgrade process.

NOTE

NiceLabel 10 upgrades automatically if the upgraded license is available on your
network.

+ Printer limit: is the maximum number of printers that you can use with your NiceLabel license.
+ Account: if you are signed into NiceLabel Cloud, Designer displays the name of you cloud account.

+ User: if you are signed into NiceLabel Cloud, Designer displays your NiceLabel Cloud user name.

Software information contains information about the installed copy of NiceLabel 10 - license, license key,
and installed version. If a newer version is available, a notification link appears on the page automatically.
Click on the link to download and install the latest version.

2.6.3.11.1. WORKING OFFLINE (WITHOUT NICELABEL CLOUD CONNECTION)

@ PRODUCT LEVEL INFO

This section is applicable if your NiceLabel 10 is signed in to the NiceLabel Cloud

If your Designer is signed in to the NiceLabel Cloud, and you lose the internet connection, you must
reestablish the connection in up to five days. Without reconnecting with your NiceLabel Cloud, Designer
closes automatically.
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After losing the internet connection, and if your computer stays offline, a warning appears in 5 days.
Designer closes 5 minutes after you see the warning.

After you reestablish the internet connection, open Designer and sign in to the NiceLabel Cloud. This makes
your copy of Designer active again.

A WARNING

Save your work to an offline location (your computer) to prevent losing any changes.

2.6.4. Home Tab

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Data View Solution Help Design Text
% cor ® g 5 & BEd & o
= on =
B ory = G rmn +u M X
. . Print Customize Run Dynamic Data Document Group Arrange Delete
< Farmat Painter Print~  Form Manager~  Properties Objects>  ~
Clipboard Font ] Action Management Align Objects

Home Tab provides access to frequently used commands and settings in the following ribbon groups:

+ Clipboard: group temporarily stores the selected elements, objects or groups of objects.
+ Font: group lets you define the font properties.
+ Action: group contains the Print button which starts the printing procedure or runs a form.

« Management: group provides direct access to the Dynamic Data Manager and Document properties —
active label or form properties dialog.

+ The Align group options define relative horizontal and vertical positioning for the object content.

+ Objects: group allows you to align, group or arrange label objects.

2.6.4.1. Clipboard

Clipboard group temporarily stores the selected elements, objects or groups of objects. Use the selected
and stored objects to transfer them from one label or solution to another.

TIP

Copying and pasting of textual (plain text, RTF) and graphical (bitmaps) content between
multiple applications is supported.

+ Paste: pastes the clipboard contents on the design surface. Multiple reuses of a single clipboard item
is allowed.
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+ Cut: removes the selected element(s) from the design surface and adds it to the clipboard to be
pasted elsewhere. Note that the first element is selected by clicking it. When selecting additional
elements, press and hold <Shi ft> key while clicking these elements.

+ Copy: copies the selected content to the clipboard. Multiple objects can be copied at once — select
them and click Copy.

+ Delete: deletes the selected elements or objects. They are not stored in the clipboard.

+ Format painter: copies the formatting properties from one object to another. This is how you multiply
the style of your reference object.

Example:

Use the format painter to copy font, font size, font color, alignment and spacing from your reference
Text object to all other Text objects using a single action.

To copy the object style properties:

1. Click your reference object. This is the object you want to copy the properties from.

2. Click the format painter.

3. Click the target object. This object now has the same properties as your reference object.
When using the format painter for different objects, you are copying and pasting the object's

properties from the Style tab. If there are matching Style properties between the objects, Designer
transfers these properties to the target object.

Example:

When multiplying the properties from a Rectangle object to Ellipse objects, all Style tab properties
apply, except for the corner radius. This property is only applicable to the Ellipse object.

NOTE

You can also copy properties between the objects on different labels, different forms,
or between objects on labels and forms.

2.6.4.2. Font
Font group defines font properties:

« Showr/hide printer fonts: button allows you to exclusively display internal printer fonts on the list of
available fonts. Graphical fonts are hidden in this case. After pressing this button again, all available
fonts are visible on the list once more.

+ Font: defines the font family to be used in a selected object.
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+ Font Size: defines the text size in an object. Select the desired point size from the dropdown selector
or enter it manually.

+ Font Style: defines the object text stylistic characteristics of text, such as bold or italic.
+ Alignment: defines horizontal text positioning in an object: Left, Center or Right.

+ Justify: makes a paragraph aligned along the left and right object margins.

TIP

When changing a font during the design process, Designer remembers the last used font
type and size.

2.6.4.3. Action

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

ﬂ@@ @ Group Objects ~

- ) . - r|I'|:| Arrange ~
Print |[Customize| Run Dynamic Data Document  Align
Print= " Form Manager  Properhies =
=
Q Create Shortcut for Printing

Bl Printing form: | (Default) -
| | |Searc*‘...
i g Edit Printing For
. 4 [E] Forms
(Default)
E Farm

Add Mew Form

0 -

Action group creates a printing shortcut, starts the printing procedure, customizes printing, or runs a form.
Print button opens the Designer Print pane as defined by the Default Printing Form.
Customize Print opens multiple options to adapt the printing options.

+ Create Shortcut for Printing: allows you to create a printing shortcut to a label or a form in a solution.
Creating the printing shortcut requires you to save the label or form document first.
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|§ NOTE

When creating shortcut to a solution, the shortcut is named Run [solution name]. After
double-clicking it, the form is run instantly.

+ Printing form: defines which form in the solution is used as default printing form.

NOTE

Selection of the default printing form is available when editing a solution.

+ Edit Printing Form: allows adding, removing, or rearranging the objects on a printing form. Read more
about the printing form customization here.

S NOTE

If the printing form has not been selected yet, the Edit Printing Form option adds a new
form and sets it as the default printing form. If an existing form is selected, the option
opens it for editing.

+ Recreate Printing Form: resets the printing form to its default layout and reestablishes the dynamic
content providers after being edited.

+ Add New Form: adds a new form to the solution. It can either be a blank form or a form designed as a
printing form. Use Form name to name the newly added form and make it easily recognizable among
other solution documents.

Run Form button runs the currently active form.

NOTE

If a label uses a customized printing form, this form remains open as a tab. The tab cannot
be closed.

2.6.4.4. Management
Management ribbon group provides direct access to:

+ Dynamic Data Manager dialog. Click the button to start managing the dynamic data sources that are
connected to objects.

+ Document Properties opens current label or form properties.
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2.6.4.5. Align

The Align group options define relative horizontal and vertical positioning for the object content:

+ Align Objects Left: aligns objects with the left border of the first selected object or with the leftmost
object.

+ Align Objects Center: aligns objects with the horizontal center of the first selected object or with
horizontal center of the largest object.

+ Align Objects Right: aligns objects with the right border of the first selected object or with the
rightmost object.

« Distribute Horizontally: distributes objects using equal horizontal spacing.

+ Align Objects Top: aligns objects with the upper border of the first selected object or with the highest
object.

+ Align Objects Middle: aligns objects with the vertical center of the first selected object or with vertical
center of the largest object.

+ Align Objects Bottom: aligns objects with the bottom border of the first selected object or with the
lowest object.

+ Distribute Vertically: distributes objects using equal vertical spacing.

2.6.4.6. Objects

The Objects group helps you work with multiple objects.

+ Group objects unites the selected objects and makes them behave as a single object.

+ Ungroup objects: separates the grouped objects.

Arrange the positions of the objects so that they appear either in front of or behind each other.

« Send Backward: sends the element back one level.
+ Send to Back: sends the element behind all other elements on the label.
+ Bring Forward: brings the element forward one level.

+ Send to Front: sends the element in front of all other elements on the label.

Delete allows you to remove the selected individual or group objects from your label template.

2.6.5. Data Tab

Data tab displays the Designer ribbon with groups that enable you to instantly connect an object with
commonly used data sources, or to define data connections in more detail:
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+ Step-by-Step Database Wizard ribbon group opens database wizard for typical database connection
types.

- Data Source Management ribbon group gives direct access to the Dynamic Database Manager and
Prompt Order dialogs.

2.6.5.1. Step-by-Step Database Wizard

Database wizard is a guided process that allows the user to configure a connection to a database and to
select which tables and fields will be used.

Dynamic Data Manager
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I Variable y
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Edit Database allows you to edit all existing connected databases using a wizard.

The wizard additionally allows you to sort, filter records, and to define how many label copies will be printed
per database record.

2.6.5.2. Data Source Management

Data Source Management ribbon group provides access to:

+ Dynamic Data Manager: dialog for managing and connecting to various data sources.

+ Prompt Order: dialog for defining the order of prompted variables on the print form.

2.6.5.2.1. DYNAMIC DATA MANAGER

@ PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

Dynamic Data Manager is a dialog that enables the user to manage the dynamic data sources for label and
form objects.

Label and form objects can be connected to multiple variables, functions, and databases.

To open the dialog, click the Dynamic Data Manager button in the Designer ribbon.
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Read more about how to define the data sources in the following sections:

« Work with variables.

+ Work with functions.

+ Use databases as content source.

+ Use internal variables as content source.

+ Use global variables as content source.

2.6.5.2.2. VARIABLE PROMPT ORDER DIALOG
Variable Prompt order dialog defines the order in which the variable values are prompted at print time.
The dialog displays the entire range of currently defined variables.

To change the prompt order, select a variable from the list and change its position using drag and drop or
Move up and Move down buttons. Repeat this step for each variable, whose prompting position needs to be
changed.

2.6.6. View Tab

Home Data Solution Help Design Text
@ @&, Zoom In Object Mame Data Source ® Align to Objects R
&, Zoom Qut Printer Element o Align to Gridlines -
Zoom to Zoom to - Gridlines . Rotate
Document Objects Q, 276% A Events - Do Mot Align View
Zoom Object Markers Visibility Alignment and Gridlines Rotation

View Tab gives you control over document zooming, marker visibility, visual aids and design surface
rotation. It makes the following ribbon groups available:
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+ Zoom: defines design surface zoom level and Designer window zoom behavior.
+ Object Markers Visibility: defines visibility settings for object properties.

+ Alignment and Gridlines: sets object positioning behavior and defines properties for design surface
gridlines.

+ Rotation: rotates the design surface clockwise for 90 degrees per click.

2.6.6.1. Zoom

Zoom group defines the design surface zoom level.

+ Zoom to Document: displays the entire label in the Designer window.

+ Zoom to Objects: displays all objects in the Designer window.

+ Zoom In: magnifies the design surface by a percentage of the currently defined zoom level.

+ Zoom Out: decreases the design surface by a percentage of the currently defined zoom level.

+ Zoom percentage drop-down menu: allows you to type in or select the exact zooming percentage for
your current document.

2.6.6.2. Object Markers Visibility

Objects markers visibility group toggles the visibility for the following object properties:

+ Object Name: displays the name of an object.

+ Printer Element: indicates that the object will be printed using a printer built-in function. This options
serves as an alternative to sending the object to printer as a graphic.

+ Events: indicates that the form object runs assigned Action(s).

- Data Source: indicates that the object is connected to a dynamic data source.

2.6.6.3. Alignment and Gridline Guides

Alignment and Gridlines group sets object positioning behavior and defines properties for design surface
gridlines.

+ Display gridline guides: makes the design surface grid dots visible.

+ Grid Size X: defines horizontal distance between the grid dots.

+ Grid Size Y: defines vertical distance between the grid dots.

+ Grid Offset X: defines the horizontal offset of the grid from the design surface center.
+ Grid Offset Y: defines the vertical offset of the grid from the design surface center.

+ Align to Objects: makes an object align with other objects on the design surface. When an object is
aligned, a line which marks the object alignment appears.
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+ Align to Gridlines: aligns the selected objects with gridlines.

S NOTE

Certain continuous inkjet (CIJ) printer models only print on predefined label surface
positions. If such printer is currently selected, grid settings are defined by the printer
driver and grayed out for this label. The Align to Gridlines option is automatically
enabled.

+ Do Not Align: makes the object position independent of gridlines and position of other object(s).

2.6.6.4. Rotation

Rotate view button rotates the design surface clockwise. Horizontal and vertical rulers adapt to the current
position of the design surface.

@ TIP

Rotation type is defined by the printer driver. Certain drivers support complete 360 degrees
rotation (90 degrees per click), while others allow 90 degrees rotation clockwise (portrait/
landscape).

2.6.7. Solution Tab

PRODUCT LEVEL INFO

Solution building is available in PowerForms.

Home Data View Help Design
36 Cut m — 2 4
e O M
Add New Add New Import into Export
Label Form= Solution  Label
Clipboard New Action Import and Export

Solution Tab enables quick and easy access to commands that are related to the entire print solution. The
tab makes the following ribbon groups available:

+ Clipboard: stores selected objects or groups of objects.
+ New: allows adding additional labels or forms to the active solution.
+ Action: starts the printing procedure or runs a form.

+ Import and Export: allows importing, publishing and exporting the solution files.
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2.6.7.1. Clipboard

Clipboard group temporarily stores the selected elements, objects or groups of objects. Use the selected
and stored objects to transfer them from one label or solution to another.

@ TIP

Copying and pasting of textual (plaint text, RTF) and graphical (bitmaps) content between
multiple applications is supported.

+ Paste: pastes a document (label/form) into the solution.

+ Cut: removes the selected document from the solution and adds it to the clipboard to be pasted
elsewhere.

+ Copy: copies the selected document to the clipboard.

+ Delete: deletes the selected object from the solution.

2.6.7.2. New

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

New allows adding additional labels or forms to the active solution. Labels and form that are included in the
solution are listed in the Solution explorer.

+ New Label: adds a new label to the active solution. After clicking the New Label button the Label
Setup Wizard appears.

+ New Form: adds a new form to the active solution. After clicking the New Form button, a blank design
surface appears. The form is ready for editing.
2.6.7.3. Action
Set as Startup Form sets the current form as your default Designer form. Next time you open your Solution,
the startup form is opened and ready to run or edit.
2.6.7.4. Import and Export
Import and Export group allows importing, publishing, and exporting the solution files.
Import into Solution allows you to import documents into the solution. Supported file formats are:

+ Solution file (.nsin)

+ Label file (.nlbl)
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+ Label file (V6) (.Ibl)

+ Form File (V6) (.xff)

When an import command is issued, the Open dialog opens. Select the file you want to import. The
imported file becomes visible in the solution manager.

NOTE

Label .Ibl and form .xff files are legacy file types used with version 6 and earlier.

Export Label: saves the document to disk and makes it available for use in another solution. After clicking
Export Label the Export label dialog appears. Select a location to save the label to.

2.6.8. Contextual Tabs

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Contextual tab is a hidden tab that becomes visible when a specific label or form object is selected on
the design surface. Contextual tabs appear on the right side of the standard Designer tab. The selection of
displayed tabs depends on the object that you are currently editing.

+ Label-specific contextual tabs are described here.

+ Form-specific contextual tabs are described here.

Data View Solution Help |

Contextual
Tabs

2.6.8.1. Label-specific Contextual Tabs
When editing various label objects, the following contextual tabs appear depending on the selected object:

+ Design tab
« Barcode tab

+ Shape tab
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+ Picture tab

+ Text tab

2.6.8.1.1. DESIGN CONTEXTUAL TAB

Design tab serves as a contextual tab that defines the layout and positioning of the selected label object.
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The following groups of settings are available on the Design tab:

+ General: defines object's visibility and printability on a label.
+ Positioning: defines the object's position on the design surface.

+ Arrange: positions the object relative to neighboring objects on a label.

General
General group defines the object's visibility and printability on a label.

+ Not printable: when enabled, this option prevents the object from being printed on the label. The
object remains visible on the label preview.

+ Visible: when disabled, the object neither appears on the print preview nor on the printed label. The
object is treated as if it does not exist.

+ Visibility settings: define if the selected object is going to appear on the printed label or not.
+ Condition: an object is enabled and/or visible if the result of the given condition is "True".

+ Printing Optimization: allows activating the use of printer elements (available with rectangle, barcode,
line, ellipse and inverse objects).

+ Use printer element if supported: speeds up the printing process.
If enabled by the printer model, a share of label element processing is handled directly by the
printer: internal fonts, shapes, barcodes, etc.

+ Always print as graphics: sends and prints the objects as graphic files.

+ Name: allows you to enter object name and its description.

Positioning
Positioning group sets the object location and size on a label.
Position button opens:

« XandY: coordinates set the exact position on the design surface.
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+ Width and Height: object dimensions.

+ Keep Aspect Ratio: makes sure both object dimensions change proportionally while resizing.

+ Rotation angle: rotates the object clockwise.

Anchoring Point button defines the spot where an object is pinned to the design surface. Variable size
objects increase or decrease their size in the direction that is opposite to the chosen anchoring point.

Keep Aspect Ratio: makes sure the object is resized proportionally.

Lock prevents the selected object from being moved during the design process.

Relative Position options define the position of an object when label size or positions of neighboring
objects are changing during the label design process.

+ Enable horizontal relative position: activates horizontal relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define horizontal offset for the object with regard to this border.

Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

Object: selects the reference object for horizontal relative positioning.

Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

Offset: horizontal distance from label border or reference object's anchoring point.

+ Enable vertical relative position: activates vertical relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define vertical offset for the object with regard to this border.

Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.

Object: selects the reference object for vertical relative positioning.

Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

Offset: vertical distance from label border or reference object's anchoring point.

NOTE

Object position changes if label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.
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NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

Arrange
Group objects: adds selected objects to a group.

+ Group objects: unites the selected objects and makes them behave as a single object.

+ Ungroup objects separates previously grouped objects.

Arrange: defines how objects are positioned in a group.

+ Bring forward: moves the selected object up one layer.
+ Bring to front: moves the selected object to the top of the object stack.
+ Send backward: moves the selected object down one layer.

+ Send to back: moves the selected object to the bottom of the object stack.

Align group allows setting the alignment and spacing for objects on the design surface. All objects can be
aligned according to the neighboring object or according to the document border.

Horizontal alignment options are:

+ Left: aligns the selected objects with the left edge of the leftmost object or with the left edge of the
first selected object. If a single object is selected, it is placed on the label's left border.

+ Center Horizontally: aligns the selected objects with the horizontal center of the largest selected
object or with the horizontal center of the first selected object. If a single object is selected, it is
placed in the horizontal center of a label.

+ Right: aligns the selected objects with the right edge of the rightmost object or with the right edge of
the first selected object. If a single object is selected, it is placed on the label's right border.

+ Distribute Horizontally: equalizes horizontal spacing between the objects.

Vertical alignment options are:

+ Top: aligns the selected objects with the top edge of the topmost object or with the top edge of the
first selected object. If a single object is selected, it is placed on the label's top border.

+ Center Vertically: aligns the selected objects with the vertical center of the largest selected object
or with the vertical center of the first selected object. If a single object is selected, it is placed in the
vertical center of a label.

+ Bottom: aligns the selected objects with the bottom edge of the lowest object or with the bottom
edge of the first selected object. If a single object is selected, it is placed on the label's bottom border.
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+ Distribute Vertically: equalizes vertical spacing between the objects.

TIP

Align to label/form is achieved by holding the <Ctr 1> key and clicking the above listed
align icons.

2.6.8.1.2. BARCODE CONTEXTUAL TAB

Barcode tab serves as a contextual tab that defines the type, layout and positioning of barcode object.
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The following groups of settings are available on the Barcode tab:
+ Barcode: defines basic barcode symbol type and its dimensions.
+ Settings: defines barcode details.

+ Arrange: positions the object relative to neighboring objects on a label.

Barcode Tab

Barcode group allows you to choose the barcode type and to set the dimensions of your barcode symbol.

NOTE

Settings in Barcode group depend on the selected barcode type.

+ Barcode Type: defines the type of the barcode symbol to be used on a label.

TIP

By default, Code128 barcode type is selected. For more details about the available barcode
types, see section Barcode Types and Available Settings.

- DataBar Type: if one of the DataBar barcode types is selected, DataBar Type defines its specific
subtype to be used on the label.

« X dimension: width of the barcode's narrow bar in the selected Unit of measurement.
+ Height: vertical dimension of your barcode in the selected Unit of measurement.

+ Ratio defines the ratio between the barcode's narrow and wide bar widths.
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Each barcode type's range of permitted ratios is limited by the standard. Designer only allows you to
use valid ratios. By default, the ratio is set to 3. This means that the wide bar is 3 times the width of a
narrow bar.

NOTE

The available ratios depend on the selected X dimension. If you are changing the X
dimension, this also affects the selection of available ratios.

+ Row height defines the height of a single data row in 2D barcodes. Row height is specified as a
multiple over the X dimension.

Settings
Settings group allows you to configure barcode details.
Human Readable button defines the human readable content's layout.
+ No human readable: makes the barcode appear without the human readable text.

+ Above barcode: locates human readable text above the barcode.

+ Below barcode: locates human readable text below the barcode.

Style group allows you to set custom properties for human readable text.

+ Custom Font: enables font and font size selection. Internal printer fonts cannot be used as a custom
human readable font.

+ Auto font scaling: If enabled (default setting), human readable text grows or shrinks proportionally
along with the changing size of the barcode. To set a custom size for human readable text, disable
this option and select the appropriate font size.

+ Bold: makes human readable text appear bold.

+ ltalic: makes human readable text appear italic.

Mask group sets the format of the input data before it is displayed on a label.

+ Content mask sets the format of the input data before it is displayed on a label.

« Mask character is a character used in the mask that is replaced with actual data on the printed label.

Example

A user needs to format a phone number to be more readable on the label. Data input is not formatted since
it is read from a database.

If the input value read from a database is:

+38642805090
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and the content mask is:
(****) **x*x*k _ KXk k
the resulting output is:

(+386) 4280 - 5090

If the data contains the asterisk "*" character, change the Mask character. The character should have a
unique value that does not appear anywhere in the data.

@ TIP

Barcode Details differ according to the barcode standards. Define the options that are given
with regard to the currently selected barcode type. Details for 1D and 2D barcodes are
described in dedicated sections:

+ 1D barcode details

+ 2D barcode details

TIP

Check digit is derived from the preceding barcode digits and is placed as the final digit of a
barcode.

Color: sets the barcode's line and human readable content color on the printed label.

Arrange
Group objects: adds selected objects to a group.

+ Group objects: unites the selected objects and makes them behave as a single object.

+ Ungroup objects separates previously grouped objects.

Arrange: defines how objects are positioned in a group.

+ Bring forward: moves the selected object up one layer.
+ Bring to front: moves the selected object to the top of the object stack.
+ Send backward: moves the selected object down one layer.

+ Send to back: moves the selected object to the bottom of the object stack.

Align group allows setting the alignment and spacing for objects on the design surface. All objects can be
aligned according to the neighboring object or according to the document border.
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Horizontal alignment options are:

+ Left: aligns the selected objects with the left edge of the leftmost object or with the left edge of the
first selected object. If a single object is selected, it is placed on the label's left border.

+ Center Horizontally: aligns the selected objects with the horizontal center of the largest selected
object or with the horizontal center of the first selected object. If a single object is selected, it is
placed in the horizontal center of a label.

+ Right: aligns the selected objects with the right edge of the rightmost object or with the right edge of
the first selected object. If a single object is selected, it is placed on the label's right border.

+ Distribute Horizontally: equalizes horizontal spacing between the objects.

Vertical alignment options are:

+ Top: aligns the selected objects with the top edge of the topmost object or with the top edge of the
first selected object. If a single object is selected, it is placed on the label's top border.

+ Center Vertically: aligns the selected objects with the vertical center of the largest selected object
or with the vertical center of the first selected object. If a single object is selected, it is placed in the
vertical center of a label.

+ Bottom: aligns the selected objects with the bottom edge of the lowest object or with the bottom
edge of the first selected object. If a single object is selected, it is placed on the label's bottom border.

+ Distribute Vertically: equalizes vertical spacing between the objects.

TIP

Align to label/form is achieved by holding the <Ctr 1> key and clicking the above listed
align icons.

2.6.8.1.3. SHAPE CONTEXTUAL TAB

Shape tab serves as a contextual tab that defines the appearance of ellipse, rectangle and line objects.

i wm H 0

File Home Data View Solution Help Design

The following groups of settings are available on the Shape tab:

+ Outline: defines how the line of the selected shape should appear.
+ Fill: group defines the shape's fill style and color.

+ Arrange: positions the object relative to neighboring objects on a label.
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Outline
Outline group defines how the line of the selected shape should appear.
Outline Style button options are:

+ None: makes the object line invisible.
+ Solid: makes the object line solid.

+ Dot: makes the object line dotted.

+ Dash: makes the object line dashed.

+ Clear: makes parts of other objects underneath the line invisible.

Outline Color defines the color of the shape's line.
Thickness defines the object line's width.

Corner radius makes the rectangle corners round. Higher values make the curve broader.

Fill
Fill group defines the shape's fill style and color.
Fill Style options are:

+ None: makes the object completely transparent.

+ Clear: makes other objects beneath the active one invisible.

+ Solid: fills the object with solid color.

+ Right Diagonal: fills the object with diagonal lines that ascend toward the right side.
+ Left Diagonal: fills the object with diagonal lines that ascend toward the left side.
+ Vertical: fills the object with vertical lines.

+ Horizontal: fills the object with horizontal lines.

+ Cross: fills the object with crossed lines.

+ Cross Diagonal: fills the object with diagonally crossed lines.

+ 25% of color: sets fill color opacity to 25 %.

+ 50% of color: sets fill color opacity to 50 %

+ 75% of color: sets fill color opacity to 75 %.

Background Color defines the color of the shape's fill.
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Arrange
Group objects: adds selected objects to a group.

+ Group objects: unites the selected objects and makes them behave as a single object.

+ Ungroup objects separates previously grouped objects.

Arrange: defines how objects are positioned in a group.

+ Bring forward: moves the selected object up one layer.
+ Bring to front: moves the selected object to the top of the object stack.
+ Send backward: moves the selected object down one layer.

+ Send to back: moves the selected object to the bottom of the object stack.

Align group allows setting the alignment and spacing for objects on the design surface. All objects can be
aligned according to the neighboring object or according to the document border.

Horizontal alignment options are:

+ Left: aligns the selected objects with the left edge of the leftmost object or with the left edge of the
first selected object. If a single object is selected, it is placed on the label's left border.

+ Center Horizontally: aligns the selected objects with the horizontal center of the largest selected
object or with the horizontal center of the first selected object. If a single object is selected, it is
placed in the horizontal center of a label.

+ Right: aligns the selected objects with the right edge of the rightmost object or with the right edge of
the first selected object. If a single object is selected, it is placed on the label's right border.

+ Distribute Horizontally: equalizes horizontal spacing between the objects.

Vertical alignment options are:

+ Top: aligns the selected objects with the top edge of the topmost object or with the top edge of the
first selected object. If a single object is selected, it is placed on the label's top border.

+ Center Vertically: aligns the selected objects with the vertical center of the largest selected object
or with the vertical center of the first selected object. If a single object is selected, it is placed in the
vertical center of a label.

+ Bottom: aligns the selected objects with the bottom edge of the lowest object or with the bottom
edge of the first selected object. If a single object is selected, it is placed on the label's bottom border.

« Distribute Vertically: equalizes vertical spacing between the objects.

TIP

Align to label/form is achieved by holding the <Ctr 1> key and clicking the above listed
align icons.
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2.6.8.1.4. PICTURE CONTEXTUAL TAB

Picture tab serves as a contextual tab that defines picture resizing options and object arranging.
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The following groups of settings are available on the Picture tab:

+ Resize: resizes the object relative to neighboring objects on a label.

+ Arrange: positions the object relative to neighboring objects on a label.

Resize
Resize group defines if the picture adapts to the label size at print time or not.
Picture Fit button opens the picture sizing options.

+ Resize options: define how the source file dimensions adapt to the size of object at print time.

+ Keep original picture size: disables resizing. The source file is displayed using the object with
its original dimensions.

 Resize proportionally: makes the source file resize proportionally. The aspect ratio of source file
dimensions is preserved.

* Resize to the designed size: resizes the picture horizontally and vertically to make it fit into the
bounding box. Using this option will most likely make the picture distorted.

+ Original size: displays the picture's Width and Height before resizing.

+ Revert to original picture size: removes resizing actions.

Keep Aspect Ratio makes sure both object dimensions change proportionally while resizing.

Arrange
Group objects: adds selected objects to a group.

+ Group objects: unites the selected objects and makes them behave as a single object.

+ Ungroup objects separates previously grouped objects.

Arrange: defines how objects are positioned in a group.

+ Bring forward: moves the selected object up one layer.
+ Bring to front: moves the selected object to the top of the object stack.

+ Send backward: moves the selected object down one layer.
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+ Send to back: moves the selected object to the bottom of the object stack.

Align group allows setting the alignment and spacing for objects on the design surface. All objects can be
aligned according to the neighboring object or according to the document border.

Horizontal alignment options are:

+ Left: aligns the selected objects with the left edge of the leftmost object or with the left edge of the
first selected object. If a single object is selected, it is placed on the label's left border.

+ Center Horizontally: aligns the selected objects with the horizontal center of the largest selected
object or with the horizontal center of the first selected object. If a single object is selected, it is
placed in the horizontal center of a label.

+ Right: aligns the selected objects with the right edge of the rightmost object or with the right edge of
the first selected object. If a single object is selected, it is placed on the label's right border.

+ Distribute Horizontally: equalizes horizontal spacing between the objects.

Vertical alignment options are:

+ Top: aligns the selected objects with the top edge of the topmost object or with the top edge of the
first selected object. If a single object is selected, it is placed on the label's top border.

+ Center Vertically: aligns the selected objects with the vertical center of the largest selected object
or with the vertical center of the first selected object. If a single object is selected, it is placed in the
vertical center of a label.

+ Bottom: aligns the selected objects with the bottom edge of the lowest object or with the bottom
edge of the first selected object. If a single object is selected, it is placed on the label's bottom border.

+ Distribute Vertically: equalizes vertical spacing between the objects.

TIP

Align to label/form is achieved by holding the <Ctr 1> key and clicking the above listed
align icons.

2.6.8.1.5. TEXT CONTEXTUAL TAB

Text tab serves as a contextual tab that defines formatting of Text and Text box objects.
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The following groups of settings are available on the Text tab:

+ Format: lets you define the text format.
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+ Text Settings: lets you define the layout of any textual content that is added to label object.

+ Arrange: positions the object relative to neighboring objects on a label.

Format
Format group lets you define the text format.

+ Show/hide printer fonts: button turns visibility of printer fonts on the font list on/off.

+ Font: allows specifying the typeface and its size. Fonts fall into two groups, OpenType fonts and
Printer fonts.

|§ NOTE

If the currently selected printer is a thermal printer, additional fonts will be visible on
the list of available fonts. These are the Printer fonts identified by the printer icon in
front of their names.

+ The font may appear Bold, Italic, Underlined or as a Strikethrough text.

+ Alignment buttons allow you to align the text to the left, center, right, or evenly.

+ Font color: specifies font and underscore color.

+ Increase/decrease font buttons allow you to gradually change the font size.

+ Scaling: factor that defines how much the font is stretched from its original proportions.

|§ NOTE

If the stretch factor is set to 100 %, the font has a normal look. If factor is 200 %, it
means that font is twice as wide as normal. If it is 50 %, the font is half as wide.

Text Settings
Text Setting group allows defining the layout of any textual content that is added to the object.
Character and Paragraph button opens line and character spacing options:

+ Line spacing: distance between each line in a paragraph.

+ Character spacing: distance between individual characters.

Effects button displays the available text effects:

+ Inverse: inverts the colors of text and background.
+ Mirror: mirrors the text.

+ RTL printing: prints the text from right to left.
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TIP

Most thermal printers automatically print Arabic and Hebrew text from right-to-left. Enable
this option it if the operating system does not provide native RTL support.

Text Fit button opens the automatic text sizing options:

+ None: disables the resizing. In this case, text field dimensions and font size do not adapt to the
amount of inserted content in a text box.

+ Ignore excessive content: removes the text content that does not fit into the object.

TIP

When enabled, the object only uses the amount of text that can be contained in the box. The
remaining text is discarded.

+ Adjust height to fit content: adapts the text box height to fit the content.

+ Fit content by adjusting font size: sets the acceptable label object font size range. Font size adapts to
the text box size automatically.

NOTE

Text Fit button is available when configuring the Rich text box object.

Arrange
Group objects: adds selected objects to a group.

+ Group objects: unites the selected objects and makes them behave as a single object.

+ Ungroup objects separates previously grouped objects.

Arrange: defines how objects are positioned in a group.

+ Bring forward: moves the selected object up one layer.
+ Bring to front: moves the selected object to the top of the object stack.
+ Send backward: moves the selected object down one layer.

+ Send to back: moves the selected object to the bottom of the object stack.

Align group allows setting the alignment and spacing for objects on the design surface. All objects can be
aligned according to the neighboring object or according to the document border.

Horizontal alignment options are:
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+ Left: aligns the selected objects with the left edge of the leftmost object or with the left edge of the
first selected object. If a single object is selected, it is placed on the label's left border.

+ Center Horizontally: aligns the selected objects with the horizontal center of the largest selected
object or with the horizontal center of the first selected object. If a single object is selected, it is
placed in the horizontal center of a label.

+ Right: aligns the selected objects with the right edge of the rightmost object or with the right edge of
the first selected object. If a single object is selected, it is placed on the label's right border.

+ Distribute Horizontally: equalizes horizontal spacing between the objects.

Vertical alignment options are:

+ Top: aligns the selected objects with the top edge of the topmost object or with the top edge of the
first selected object. If a single object is selected, it is placed on the label's top border.

+ Center Vertically: aligns the selected objects with the vertical center of the largest selected object
or with the vertical center of the first selected object. If a single object is selected, it is placed in the
vertical center of a label.

+ Bottom: aligns the selected objects with the bottom edge of the lowest object or with the bottom
edge of the first selected object. If a single object is selected, it is placed on the label's bottom border.

- Distribute Vertically: equalizes vertical spacing between the objects.

TIP

Align to label/form is achieved by holding the <Ctr 1> key and clicking the above listed
align icons.

2.6.8.2. Form-specific Contextual Tabs

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Contextual tab is a hidden tab that is displayed in the tab row when a specific form object is selected on the
design surface. Contextual tabs appear on the right side of the standard Designer tabs.

The following tabs appear offering easy access to the object-specific commands:

+ Object: allows defining object printability, its position, and arrangement.
+ Form Control: allows defining form object related specifics - its layout and assigned events.

+ Picture: gives access to picture-related events and picture resizing options.
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Design Contextual Tab

Design tab serves as a contextual tab that defines the layout and positioning of the selected label object.

I “J = s
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The following groups of settings are available on the Design tab:

+ General: defines object's visibility and printability on a label.
+ Positioning: defines the object's position on the design surface.

+ Arrange: positions the object relative to neighboring objects on a label.

General
General group enables/disables the object and defines its visibility on a form.

+ Enabled: defines if the object is going to be active (editable) at form startup or not.
+ Visible: defines if the selected object is going to appear on the form or not.
+ Conditions: an object is enabled and/or visible if the result of the given condition is "True".

+ Name: allows you to enter object name and its description.

Positioning
Positioning group sets the object location and size on a form.
Position button opens:

« X and Y: coordinates set the exact position on the design surface (in px).

+ Width and Height: object dimensions.

Anchoring Point button defines the spot where an object is pinned to the design surface. Variable size
objects increase or decrease their size in the direction that is opposite to the chosen anchoring point.

+ Horizontally resize with form and Vertically resize with form: object size automatically adapts to the
changing size of the form.

+ Horizontally resize with form: object width adapts to the resized form.

+ Vertically resize with form: object height adapts to the resized form.

@ NOTE

If both options are enabled, object width and height adapt to the resized form
simultaneously.
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Keep Aspect Ratio makes sure the object is resized proportionally.

Lock prevents the selected object from being moved during the design process.

Arrange

Group objects: adds selected objects to a group.

Group objects: unites the selected objects and makes them behave as a single object.

Ungroup objects separates previously grouped objects.

Arrange: defines how objects are positioned in a group.

Bring forward: moves the selected object up one layer.
Bring to front: moves the selected object to the top of the object stack.
Send backward: moves the selected object down one layer.

Send to back: moves the selected object to the bottom of the object stack.

Align group allows setting the alignment and spacing for objects on the design surface. All objects can be
aligned according to the neighboring object or according to the document border.

Horizontal alignment options are:

Left: aligns the selected objects with the left edge of the leftmost object or with the left edge of the
first selected object. If a single object is selected, it is placed on the label's left border.

Center Horizontally: aligns the selected objects with the horizontal center of the largest selected
object or with the horizontal center of the first selected object. If a single object is selected, it is
placed in the horizontal center of a label.

Right: aligns the selected objects with the right edge of the rightmost object or with the right edge of
the first selected object. If a single object is selected, it is placed on the label's right border.

Distribute Horizontally: equalizes horizontal spacing between the objects.

Vertical alignment options are:

Top: aligns the selected objects with the top edge of the topmost object or with the top edge of the
first selected object. If a single object is selected, it is placed on the label's top border.

Center Vertically: aligns the selected objects with the vertical center of the largest selected object
or with the vertical center of the first selected object. If a single object is selected, it is placed in the
vertical center of a label.

Bottom: aligns the selected objects with the bottom edge of the lowest object or with the bottom
edge of the first selected object. If a single object is selected, it is placed on the label's bottom border.

Distribute Vertically: equalizes vertical spacing between the objects.
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TIP

Align to label/form is achieved by holding the <Ctr 1> key and clicking the above listed
align icons.

2.6.8.2.2. CONTEXTUAL TAB FORM CONTROL
Form control tab enables you to assign actions to the object, and to set its appearance.
The following groups of settings are available on the Form control tab:

+ Events: lets you define various events that can be run using the selected object.

+ Style: defines how the content of a form object should appear. This group adapts to the currently
selected form object. The following variations are in use:

« Style group for textual content (objects: Text, Button, Memo Field, Combo Box, List Box,
checkbox,

+ Style group for graphical content (objects: Frame, Label Preview)
+ Style group for table content (objects: Database Table)

+ Arrange: positions the object relative to neighboring objects on a label.

Events
Events group lets you define various events that can be run using the selected object.

+ Events button opens the list of available events for the selected object.

Example:

Typical events in Designer are On Click, On Focus, On Exit, etc.

Each event is run using actions. Actions... button provides access to the Actions editor which serves as a
tool for managing actions in a labeling solution.

Style (for Textual Content)

Style group defines how the textual content of a form object should appear.

Show/hide printer fonts button makes the printer fonts available on the typeface list or hidden.

Font allows specifying the typeface and its size. Fonts fall into two groups, OpenType fonts and Printer
fonts.
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|§ NOTE

If the currently selected printer is a thermal printer, additional fonts will be available on the
list of available fonts. They are Printer fonts identified by the printer icon in front of their

names.

The font may appear Bold, Italic, Underlined or as a Strikethrough text.

Scaling is a factor that defines, how much the font is stretched from its original proportions. If the factor
is 100%, the font has a normal look. If factor is 200%, it means that font is twice as wide as normal. If it is

50%, the font is stretched.
Text alignment defines horizontal positioning of the object content.

+ Align Left: places the text on the left border of an object.
+ Align Center: places the text at the center of an object.

+ Align Right: places the text on the right border of an object.

Font color allows specifying the font and underline colors.
Background Color defines the color of the object background.
Border Color button opens border color settings.

Text Settings defines the text layout.

Style (for Graphical Content)
Style group defines the layout of graphic form objects.

+ Show Border defines if the object border is visible or not.
+ Border Settings button opens Border color and Border width settings.

+ Background color defines the color of object background.

Style (for Tables)
Style group defines the appearance of Database Table object on a form.

+ Table Style defines visual appearance of the object and its content.

+ Cell Style defines visual appearance of the selected cells in Database Table object.

Arrange

Group objects: adds selected objects to a group.

+ Group objects: unites the selected objects and makes them behave as a single object.
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+ Ungroup objects separates previously grouped objects.

Arrange: defines how objects are positioned in a group.

+ Bring forward: moves the selected object up one layer.

+ Bring to front: moves the selected object to the top of the object stack.

+ Send backward: moves the selected object down one layer.

+ Send to back: moves the selected object to the bottom of the object stack.
Align group allows setting the alignment and spacing for objects on the design surface. All objects can be
aligned according to the neighboring object or according to the document border.

Horizontal alignment options are:

+ Left: aligns the selected objects with the left edge of the leftmost object or with the left edge of the
first selected object. If a single object is selected, it is placed on the label's left border.

+ Center Horizontally: aligns the selected objects with the horizontal center of the largest selected
object or with the horizontal center of the first selected object. If a single object is selected, it is
placed in the horizontal center of a label.

+ Right: aligns the selected objects with the right edge of the rightmost object or with the right edge of
the first selected object. If a single object is selected, it is placed on the label's right border.

+ Distribute Horizontally: equalizes horizontal spacing between the objects.

Vertical alignment options are:

+ Top: aligns the selected objects with the top edge of the topmost object or with the top edge of the
first selected object. If a single object is selected, it is placed on the label's top border.

+ Center Vertically: aligns the selected objects with the vertical center of the largest selected object
or with the vertical center of the first selected object. If a single object is selected, it is placed in the
vertical center of a label.

+ Bottom: aligns the selected objects with the bottom edge of the lowest object or with the bottom
edge of the first selected object. If a single object is selected, it is placed on the label's bottom border.

+ Distribute Vertically: equalizes vertical spacing between the objects.

TIP

Align to label/form is achieved by holding the <Ctr 1> key and clicking the above listed
align icons.

2.6.8.2.3. PICTURE CONTEXTUAL TAB (FORM SPECIFIC)

Picture tab serves as a contextual tab that defines picture resizing options and object arranging.
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The following groups of settings are available on the Picture tab:

+ Events: lets you define various events that can be run using the selected picture object

+ Resize: defines how the picture source file's dimensions adapt to the size of object when the form is
run.

+ Arrange: positions the object relative to neighboring objects on the form.

2.6.8.3. Document Storage
Document Storage contextual tab allows you to perform document storage actions within Designer.

Document Storage is a functionality of NiceLabel Control Center. It enables the NiceLabel Control Center to
perform as a shared file repository on the server, where users can store their files, retrieve them, and control
their revisions.

Document Storage contextual tab enables you to perform document storage actions straight from
Designer. This makes accessing and opening the file in NiceLabel Control Center unnecessary.

NOTE

This contextual tab requires connection with NiceLabel Control Center. LMS Enterprise
license is mandatory for such configurations.

Revisioning group allows you to perform the available document storage actions:

+ Check Out: checks out the file from NiceLabel Control Center document storage and makes it
available for editing. The checked-out file is marked and locked for editing for any other user. All
other users will see the current revision of the file, while the author (designer) already works on a new
draft.

NOTE

After opening a document from the document storage (File > Open > Document Storage),
the editing commands remain disabled until you check out the document.

+ Check In: checks the file to NiceLabel Control Center document storage after the editing is done.
When you check in the filg, its revision number increments by one. The entered comment is added to
file log.

+ Discard Checkout: discards checkout of the current file and gives other users full access to the file.
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A WARNING

If you click Discard Checkout, you irreversibly lose all changes that any of the users
did after checking out the file. To keep the changes, check in the labels or solutions
first.

+ Document Storage: opens document storage location of the connected NiceLabel Control Center.

2.6.9. Help Tab

Help tab provides direct access to various resources that help you design and use labels and forms quickly
and efficiently.

T
QEE w3 4 Of

Help User Training Knowledge Sample Technical = About Home
Guides Videos Base Files  Support Page

Help Product

Help ribbon group includes buttons with links to the following resources.

+ Help: Designer online help.

+ User Guides: online collection of NiceLabel user guides. The collection includes user guides for the
entire product portfolio.

+ Training Videos: NicelLabel collection of training videos.

+ Knowledge Base: online library of articles that describe many technical solutions, tips, and solved
issues for labels, and printing solutions.

- Sample Files: access to the collection of sample label files. Use them to become familiar with
Designer and to explore software capabilities.

+ Technical Support: connects you with NiceLabel technical support department.

Product ribbon group includes links to:

+ Software About page

+ NiceLabel Home Page: www.nicelabel.com

2.6.10. RFID Tag

The RFID Tag dialog allows you to select the appropriate RFID tag type, to define its content, and to
configure which type of data is going to be encoded on the tag.
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|§ NOTE

RFID functionality is available with installed NiceLabel printer driver.

RFID Tag dialog allows you to configure how the tag content is encoded in a tag:

+ Select the RFID tag type.
« Configure various tag settings related to its structure and programming.
+ Set the RFID security parameters.

+ Insert and configure data fields.

2.6.10.1. Tag

The Tag panel of the RFID Tag dialog allows you to select which tag type is going to carry the encoded data
and how the data should be written to the tag.

Tag group includes the tag type selection.

+ Tag type dropdown list offers the selection of available RFID tag types. The selection of tag types is
automatically defined by the printer driver.

NOTE

Select the printer (and the corresponding driver) for the label with RFID tag in the status bar.

Usage group defines the RFID Tag data sources and how the data is written to the tag.

+ RFID write enabled: Enables or disables data writing to the RFID tag.

TIP

Disabled writing might be useful during the label designing process or during specific
workflow phases.

The encodable RFID data fields are added to the Dynamic Data explorer under RFID Tag.

Example

Data Field Possibilities:

« EPC: Data field with Electronic Product Code

+ User Data: Data field with the content to be encoded on the RFID tag
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+ TID: Data field with unique ID of the RFID tag
+ GID Code: General identifier code for RFID tags

+ CID Code: Card identification number

TIP

Drag the appropriate data field and place it on the label in form of a Text, Text Box, or
Barcode object (defined by the driver).

2.6.10.2. Content

The Content panel of the RFID Tag dialog allows you to define the content of an RFID tag. To encode the
data in an RFID tag, complete the following steps.

Step 1: Select Data Fields

Data Fields group allows you to select the data fields. These fields are going to contain the encoded data of
the RFID tag.

NOTE

The selection of available Data Fields with corresponding settings depends on the selected
Tag type.

Data Field Examples:

+ TID: unique ID of the RFID tag

« EPC: syntax for unique identifiers assigned to objects, unit loads, locations, or other entities that are
included in business operations

+ User Data: payload data to be written in the RFID tag

+ RFID Tag Memory: the only data field available for non-Gen2 RFID tags

Step 2: Select Data Type

Data type defines the method for entering the Data field content. The availability of data types depends on
the selected Data field.

+ Memory block: the table allows you to enter the data into individual RFID tag memory blocks. Each
table row represents a single block of the selected Tag type.
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|§ NOTE

Memory block structure and properties of individual blocks depend on the selected Tag
type.

S NOTE

Data type can be defined for each block individually:

+ Electronic Product Code (EPC): added fields allow you to enter the RFID data according to the EPC
standard.

+ ASCII string: RFID data to be entered as a string of ASCII characters.
+ HEX encoded string: RFID data to be entered as a string of hexadecimal pairs.

+ Numeric: RFID data to be entered as a string of digits.

Encoding type allow you to select the data encoding format that corresponds to your current Data type.
Step 3: Insert Value

Insert the value to be encoded in the RFID tag according to the selected Data type.

2.6.10.3. Security

Security tab of the RFID Tag dialog allows you to configure the RFID tag security settings. These settings
allow or deny access to RFID data writing or editing.

Security settings depend on the selected printer. There are three major configuration types.

2.6.10.3.1. SINGLE MEMORY FIELD WITH MULTIPLE BLOCKS

Locking group includes an overview of the blocks that are included in the RFID tag memory. Each block can
be locked individually.

To protect the block for editing and writing, enable the Block locked option.
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RFID Tag

Tag Locking
Content 4 RFID Tag Memory (W] Lock all blocks
Sz v| Block 1
v| Block 2
Settings Block 3
Block 4
Block 5
Block 6
Block 7
¥| Block 8

Cancel

Lock all blocks option allows you to lock all blocks in the memory field simultaneously or unlock them if
they are already locked.

2.6.10.3.2. MULTIPLE MEMORY FIELDS

Access Protection group sets a password that must be entered before editing or writing the RFID data.
Data type defines the method for entering the Password.

+ ASCII string: Password should be entered as a string of ASCII characters.
+ HEX encoded string: Password should be entered as a string of hexadecimal pairs.

« Numeric: Password should be entered as a string of digits.

Kill code defines the code that disables the RFID tag permanently and irreversibly.

TIP

Once the kill code is activated, the data can neither be retrieved from nor written to the tag.

Data type defines the method for entering the Kill code characters.

+ ASCII string: Kill code should be entered as a string of ASCII characters.
+ HEX encoded string: Kill code should be entered as a string of hexadecimal pairs.

« Numeric: Kill code should be entered as a string of digits.
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RFID Tag

ASCIl string =
Data field content can contain up to 4 characters.

pass > Data source
ASCIl string =

Data field content can contain up to 4 characters.

> Data source

Tag Access Protection
Content Data type:
Security
Password:
Settings
Kill Code
Data type:
Kill code:
Locking
User Data
Access code
Kill code

EHT

Select locking setting: Lock M

Cancel

2.6.10.3.3. MULTIPLE MEMORY FIELDS WITH BLOCK LOCKING

Additional settings from Multiple Memory Fields allow the user to set the locking for individual blocks
within RFID tag memory fields.

Locking group includes an overview of the memory fields that are included in the RFID tag. Each memory
field can be locked individually.

Select locking settings allows you to define how the blocks are locked.

+ Preserve original setting: original locking setting cannot be retrieved, but the default option assumes
that the tag setting should remain unchanged.

+ Lock: block is locked and further changes are prevented.

+ Unlock: block is unlocked and editable.

+ Relock: RFID tag is unlocked for the changes to be applied. When done, the tag is relocked

immediately.

+ Permanent lock, unlock or relock: makes the above described settings permanent. These settings

cannot be undone.

Blocks for locking: defines the individual blocks or range(s) of blocks to be locked.
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TIP

Individually locked blocks are defined with an index and separated by a comma (with or
without inserting the space between). Ranges of blocks are defined with a dash.

RFID Tag
Tag Access Protection
Content Data type: ASCIl string M
Security Data field content can contain up to 4 characters,
Password: pass > Data scurce
Settings
Kill Code
Data type: ASCll string v
Data field content can contain up to 4 characters.
Kill code: 4 Data source
Locking
User Data Select locking setting: Permanent lock at
Access code Blocks for locking: example: 5,6,12-16
Kill code
EPC

Cancel

2.6.10.4. Settings

NOTE

Available settings depend on your selected printer driver. If you do not see your settings
described here, check your Driver User Guide.

Settings tab of the RFID Tag dialog allows you to configure various tag settings related to its structure and
programming.

All available settings are listed in a table under the Settings group:

+ Antenna offset: defines distance between the top of the label and the embedded RFID inlay.

+ Power attenuation: specifies radio output power. Use it to adjust RF emission power from the
antenna.

+ Maximum tags to stop: specifies how many tags are allowed to be programmed incorrectly before
the printing of labels stops. The option can be used as a precautionary measure because it prevents
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endless consumption of erroneous labels. When the programming of the RFID tag fails, usually the
word "VOID" is printed on the label.

« Number of retries: specifies the number of times the printer tries to program the tag if the initial
attempt fails. The parameter is sent to the printer along with the rest of the data.

+ Check for valid tag: before the tag programming begins, printer verifies if a proper RFID tag is
available on the smart label. The printer also verifies if the tag is programmable.

+ Verify data write: once the data has been encoded into the RFID tag, the printer checks if the written
data is equal to the original value.

+ Electronic Article Surveillance (EAS): is an anti-theft system used where an electronically-detectable
tag is attached to the item.

+ Preserve original EAS setting: original EAS setting cannot be retrieved, but the default option
assumes that the tag setting should remain unchanged.

« Enable EAS: enables surveillance in the RFID tag. If this was the original setting, the tag would
remain unchanged.

- Disable EAS: disable surveillance in the RFID tag. If this was the original setting, the tag would
remain unchanged.

+ Permanently lock EAS tag setting: permanently locks the chosen setting for the EAS. This lock
cannot be undone.

NOTE

The selection of available settings depends on the current Tag type.

2.6.10.5. RFID Read and Print

This section describes how to define which data fields from the RFID tag should be read and printed on the
label using the internal printer elements.

To configure the data field properties and to make the RFID encoded data on the label, drag it to design
surface. After adding it to design surface, the data field appears as a normal Text label object with the
following additional properties.

Data format defines the format in which the RFID data field content is written in the label object and printed.

NOTE

Available data formats and number of permitted characters are defined by the printer driver
and selected tag type.

+ HEX encoded string: data field content is a string of hexadecimal pairs.

+ ASCII string: data field content is a string of ASCII characters.
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+ Numeric: data field content is a string of numbers.

NOTE

You must select a printer's native font (those stored internally on the printer) to print. All
other fonts will result in an error.

Preview presents the data field content as it would appear using the selected Data format. Preview field
does not include the actual encoded data. Enter the characters manually. By default, the object contains as
many question marks, as given by the length of the RFID data field.

@ TIP

The role of Preview field is to fill the object with dummy content during the label design
process and to give an impression of its layout on the printed label. The object on the actual
printed label displays the content which was read from the RFID tag.

Data Extraction group defines which part(s) of data field content should be read from the RFID tag and
printed on the label.

TIP

By default, the entire range of encoded data is read from the RFID tag.

+ Select bytes: specifies which bytes of the encoded RFID tag data should appear in the label object.
+ Starting byte: the number of the byte in an encoded string which starts the selection.
+ Length in bytes: number of selected bytes which should be extracted from the encoded data.

+ Select blocks: specifies which blocks of the encoded RFID tag data should appear in the label object.
+ Starting block: the number of the block in an encoded string which starts the selection.

* Number of blocks: number of selected blocks which should be extracted from the encoded
data.

2.7. Design Surface

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Your design surface is a place to create, add, position, and interconnect label and form objects.

95



To help you design labels and forms as simply and efficiently as possible, your design surface uses
usability and functional principles from Microsoft Office.

TIP

Use View tab to customize your design surface.

+ Learn more about design surface elements here.

+ Learn more about design surface editing actions here.

« Learn more about design surface visual aid elements here.

2.7.1. Design Surface Elements

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Design surface consists of the following elements:

+ Ruler: Design surface is equipped with horizontal and vertical ruler. Use it to line up the objects or to
properly position the label and its content. Change the unit measurements displayed on the rulerin
Label properties.

+ Paper: Yellow area of the design surface displays the current size of paper. The information about
supported paper format is acquired from the printer driver, but you also have the option to define
custom format. Manual paper size has to be defined when printing on regular office sheets of paper.
See Paper section for more details.

+ Label: White area represents the area for label designing. Red line displays limit of the currently
printable area.

+ Object Properties Window: Defines the selected label or form object's properties. Double-click an
object to open the dialog.

« Form: White area represents the area which can be used for designing a form.

+ Tabs: Currently active label(s) and form(s) are accessible on separate tabs.

PRODUCT LEVEL INFO:

Tabs appear in PowerForms only.
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2.7.2. Design Surface Editing Actions
Below listed are the most relevant common actions for editing the objects on the design surface:

+ Object arranging: allows the objects to be placed in front of or behind other objects in a group.
Arranging options are described here.

+ Objects aligning: allows the objects to be aligned among each other. Aligning options are described
here.

+ Zooming: enables the entire design surface to be zoomed in or out. Zooming options are described
here.

+ Scrolling: enables sliding the design surface up and down.

+ Selecting: enables the objects on the design surface to be selected for editing individually or in a
group. Group selection allows any actions to be applied to multiple objects simultaneously.

+ Rotating: enables object rotation.

2.7.3. Visual Aid Elements

Listed below are the visual aid elements that enable you to work with Designer.

+ Gridlines serve as a visual aid during the design process. They can be either visible or hidden. Their
density is customizable. Gridline options are available in the Alignment and Gridlines ribbon group.

+ Snaplines are non-visible alignment lines that help the user align the objects during the design
process. Snap options are available in Designer's Align ribbon group.
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+ Ruler shows the available design area for the label (white colored field) and file page (gray colored
field).

+ Resize handles appear on the selected (active) objects. They enable you to resize the object
dimensions. X and Y dimensions can be resized simultaneously or separately.

+ Margins are the amount of fixed space between the edge of an object and the edge of a label.

+ Tabs for Active Documents allow the user to toggle between multiple labels and forms in a solution.
Tabs are also used when designing batches of labels — header, body, and tail labels are placed on
separate tabs.

2.7.4. Object Properties Window

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

When designing a label or form object, double-click an object to set its properties.

Double-click opens the object properties window. Available object properties window options adapt to each
selected object and its properties.

+ Available label objects and their properties are listed and described in detail here.

+ Available form objects and their properties are listed and described in detail here.

Source

Connected data source:

QT picture =
Advanced properties...
Data type: Text =
Allowed characters: All ¥ | more.
Initial value:
[Pasta.category] »
#
Prompting

Prompt at print time

[] value required

After pressing F4, the object properties dialog becomes pinned as object properties editor on the right side
of the design surface.

2.8. Document Properties and Management Dialogs

Designer offers multiple dialogs that help you configure and manage the active document and connected
data sources. Read the following topics for detailed instructions:
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+ Label Properties
+ Form Properties

+ Dynamic Data Manager

2.8.1. Label Properties

Label Properties editor selects the printer, sets label dimensions, and defines the printing paper properties.

The label properties settings are listed below and appear as dialog tabs:

Label Property Description
Printer Selects the preferred printer.
Label Dimensions Defines the Unit of measure and label dimensions.
Paper Defines the printing paper properties.
Stocks Selects the stock type.
Style Defines the label style parameters.
Batch Printing Defines details for grouped printing of labels.
Cutter Enables label roll cutting during or after the printing procedure.
Info Inserts the label description.

Label Properties
Printer Unit
Label Dimensions Unit of measure: mm -

Label Dimensions

Width: 100,00 mm | 5 Height: 70,00 mm
Style Margins
Batch Printing Left: 000mm |3 Top: 000mm |3
- -
Cutter Right: 0,00 mm - Bottom: 0,00 mm -
Radius
Info
Vertical radius: 1,00 mm s Horizontal radius: 1,00 mm :
Labels Across
Horizontal count: 1% Horizontal gap: 0,00 mm ps
Vertical count: 1% Vertical gap: 000mm |3

Processing order: o Horizontally - start at top left
Vaniable label size

[} Enable variable label size

0’( Cancel

@ TIP
To open the Label Properties Editor, double-click the design surface.
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2.8.2. Form Properties

|§ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

Form Properties dialog is used for defining various form properties.

TIP

To open the Form Properties dialog, double-click the design surface.

Form Properties

Basic Settings Basic settings

Title: Form
Show form title bar

Allow closing form

Tab Order Allow resizing form

Allow minimizing form

Additional Settings

Style

F1 Help

[] Minimize to tray
Events

Size

Variable Events Width: 1024 px :
Serial Port Data Height: 768 px e
Info Initial form state

Maximized

®) Default form size
Startup form position

Screen center iz

10 px

4|4

10 px
Scroll bars

["] Show scroll bars and stop resizing form elements

0 px =

0 px

Cancel

The settings are available on the below-listed dialog panels.

Form Property Description
Basic Settings Defines form title, size, initial form state and startup form position.
Additional Settings Selects form scripting language.

Style Defines form background color and picture. It allows picture embedding and
saving as external file.

Tab Order Defines the order of focus Shifting among form objects.

F1 Help Contains form help text which is shown to the user after pressing F1 when the
form is running.
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Form Property Description

Events Defines the events which occur after the form is loaded, closed, and after a
specified time interval completes.

Variable Events Selects the variables that are monitored for changes in their values.
Serial Port Data Adds a variable that stores the data received via serial port.
Info Defines the content which serves as a hint or as a guidance for the form user.

2.8.3. Dynamic Data Manager

PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

Dynamic Data Manager is a dialog that enables the user to manage the dynamic data sources for label and
form objects.

Label and form objects can be connected to multiple variables, functions, and databases.

To open the dialog, click the Dynamic Data Manager button in the Designer ribbon.

Dynamic Data Manager

T e © A S Haegal S % D
> =
¥ cut X & <. = SH = = ! L 2 (i
Variables Functions Inteal  Global  Database Excel Access SOL Text Al Prompt  Import Data Export 4—Ri
I Copy X Delete - ~  Variables~ variable Connections = Server File Databases Order Sources  Variables Ribbon
General Add Step-by-Step Database Wizard Variables  Import and Export

Search.. [ESEEN input rules  Output rules
4 @ Variables

+ Add new variable
 Variable

About
Name: Variable

4 f, Functions Description:
=+ Add new function 4
4 2 Databases

+ Database wizard

Definition

Datatype: Text =
& Internal Variables ata type L
4 & Global Variables Initial value:
=+ Add new global variable
3
& Globalvariable 4
& Globalvariable_1 e
& GlobalVariable_2 P
Auto generated
Prompting
Prompt at print time
Dynamic Data Explorer Prompt text:

[ value required

Dynamic value

[] Remember the last used value (dynamic value) \

Main/Editing Field

oK Cancel

Read more about how to define the data sources in the following sections:
« Work with variables.
+ Work with functions.
+ Use databases as content source.

« Use internal variables as content source.
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+ Use global variables as content source.

2.8.3.1. Dynamic Data Manager Ribbon

PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

Use the Dynamic Data Manager ribbon commands to efficiently manage your data sources. If you want
to delete, copy or cut/paste your data sources, always use the commands in the Dynamic Data Manager
ribbon.

Dynamic Data Manager ribbon consists of the following functional groups:
General group provides access to the following actions:

+ Undo: undos the entire sequence of actions since the last file save. The range of actions is selected
from the dropdown list.

+ Redo: repeats the requested range of actions. The range of actions is selected from the dropdown
list.

+ Copy: copies the selected data source to the clipboard.
+ Cut: cuts the selected data source to the clipboard.
+ Paste: pastes the clipboard data.

+ Delete: deletes the selected data source.

Add group gives access to dynamic data sources:

+ Add New Variable: allows defining multiple types of variables.

+ Internal Variables: adds system and user related variables. Their role is to identify the label or form,
system name, user, or file revision number.

« Add New Function: button opens the selection of available functions. Select the appropriate one to
start editing it.

+ Database Connections: button opens the selection of supported database types. The New Database
Connection Properties dialog opens.

The step-by-step Database Wizard group is the entry point for database wizards:
+ Add Excel database.
+ Add Access database.
+ Add SQL Server database.

« Add Text File database.
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+ All Databases allows adding all types of supported database types.

Variables group gives access to the Prompt Order dialog. This dialog defines the order under which the
variables are prompted at print time.

Import and Export group enables you to import or export the data model used in a NiceLabel 10 document.

+ Import Data Sources: allows you to import data sources from an external label or solution file.

+ Export Variables: allows you to export variables from an existing label or solution file into a .NLVR file.

2.8.3.1.1. IMPORT DATA SOURCES

The data model includes all data sources and their relations that are part of a label or solution file. To
import a data model means that you can import the external data sources into an existing label or solution
file. These imported data sources can be further used as dynamic content for label or form objects.

The ability to import data sources helps you keep the data sources in your labels and solutions uniform

and consistent. If you have a standard range of data sources, you can share these data sources across the
company with your label designers. The label designers import the shared data sources, which ensures that
the label templates are equipped with the relevant variables, functions, and databases.

|§ NOTE

Importing data sources that share the same name with your existing data sources causes
conflicts.

When importing data sources with the same name you, you can:

+ Overwrite existing data source with the imported ones.

+ Merge the data sources. Merges your data sources (of the same type). When merge
is not possible (For example, a text variable and a date variable with the same name),
NiceLabel 10 keeps both data sources and renames the imported ones (For example,
Variable and Variable_1). The definitions of your imported variables, functions, or
databases override the values of your existing variables, functions, or databases.

To import a data model, go to Management ribbon group > Dynamic Data Manager drop-down list and click
Import Data Sources.

Import Options: allows you to import data models using multiple file formats. They can either be a
complete label or solution file, or a separate NiceLabel variable export file (NLVR extension):

+ Solution File (*.nsln) imports data sources from a NiceLabel solution file.
+ Label File (*.nlbl) imports data sources from a NiceLabel label file.
+ Label File (V6) (*.Ibl) imports data sources from a NiceLabel V6 legacy label file.

« XFF Form File (*.xff) imports data sources from a NiceLabel V6 legacy solution file.
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+ Variables export files (*.nlvr) imports data sources from a previously exported NiceLabel 10 variable
export file.

+ Oracle WMS File (*.xml) imports variables from external Oracle WMS files. These are XML files
generated by Oracle Warehouse Management system that include instructions for 3rd party label
printing software.

TIP

Variables export file is described in section Variables Export File Definition.

2.8.3.1.2. EXPORT VARIABLES

Variables from an existing label or solution files can be reused in another document. The Export Variables
option allows you to export all variables into a variable export file (NLVR extension). This makes the
variables reusable in any other NiceLabel 10 document.

TIP

The exported variables can be included in another NiceLabel label or solution using the
Import Data Sources option.

To export variables, go to Dynamic Data Manager > Import and Export ribbon group and click Export
Variables.

|§ NOTE

Only variables without any references to other data sources can be exported. Each export
ends with a report containing a list of exported and non-exported variables from the file.
The reason for potential variable export failure is always included in the report.

The definition of variable export (.NLVR) file is available in the section Variables Export File Definition.

2.8.3.2. Dynamic Data Explorer

The Dynamic Data Explorer performs two roles. It serves as a shortcut for adding new variables, functions,
and data sources and gives an overview of the data sources that are currently in use.

To toggle between the two explorers, click the appropriate tab:

+ Dynamic Data tab activates the Dynamic Data Explorer.
+ Solution Explorer tab activates the Solution Explorer.

+ Add new variable: adds an additional variable to the label or form data sources. There are four default
variable types available. Their values are defined via dialogs described in dedicated sections
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+ Variable: a type of variable that obtains value when a label or form is printed.
+ Current date: displays the current date in the requested format.
+ Current time: displays the current time in the requested format.
+ Counter: displays a counter value.
+ New function: adds a new function that serves as a dynamic data source.
+ Database wizard: starts the wizard that adds a new database in a guided process.
+ Internal Variables: displays the list of available internal variables.

+ RFID Tag: If you are working with an RFID compatible printer, you can directly add the content
encoded in the RFID tag to your label as Text, Text Box, or Barcode objects.

2.9. Object Properties Editor

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

In addition to the object properties available in the Designer ribbon, the property editor opens on the right
side of the design surface.

NOTE

The Object properties toolbar is hidden at the start and only appears after pressing F4 or
clicking Properties on the right-click menu.

Available toolbar options adapt to each selected object and its properties:

+ Available label objects and their properties are described here.

+ Available form objects and their properties are described here.

2.10. Context Menus

In Designer, right-click displays various context menus that contain commonly used commands. The
availability of commands depends on the selected items — design surface or object.

+ Design surface context menu commands are described here.

+ Object context menu commands are described here.
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2.10.1. Design Surface Context Menu

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

When right-clicking the design surface, a context menu appears. The context menu includes commonly
used commands:

+ Document Properties: opens the label properties or form properties dialog.

+ Paste: pastes clipboard contents on the design surface. Multiple reuses of a single clipboard item are
allowed.

+ Cut: removes the selected element(s) from the design surface and adds it to the clipboard to be
pasted elsewhere.

+ Copy: copies the selected object to the clipboard.
+ Select all: selects all objects on the design surface.

+ Alignment and Gridlines: allows you to define how the objects take their positions on the design
surface.

+ Align to objects: makes the object on the design surface align with other objects. When two
objects are aligned, a leading line appears linking the edges of the two aligned objects.

+ Align to grid: makes the object on the design surface align with gridlines. When moving the
object, it always snaps to the gridline.

+ Do not align: allows you to move the objects freely.
+ Display gridline guides: makes the gridlines visible.

+ Objects markers visibility: toggles visibility for the object properties. Markers become visible when
moving the mouse pointer over the object.

+ Object name: marker shows the name of an object.
+ Internal element: marker shows if the selected object belongs to the internal printer elements.
+ Counter: marker shows that the connected variable is Counter.
+ Locked object: marker shows that an object's position is locked.
+ Events: marker shows that the form object runs assigned Action(s).
+ Zoom: defines zooming behavior.
« Zoom to Document: shows the entire label in the Designer window.

+ Zoom to Objects: shows all objects in the Designer window.
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2.10.2. Object Context Menu

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

When right-clicking an object, a context menu appears. The context menu includes the following
commands:

+ Properties: opens object properties dialog.
+ Copy: copies the selected content to the clipboard.

+ Cut: removes the selected element from the design surface and adds it to the clipboard to be pasted
elsewhere.

+ Delete: removes the selected object from the design surface.
+ Lock/Unlock: prevents the selected object from being moved or re-enables moving.
+ Arrange: positions the objects so that they appear either in front of or behind each other.
+ Send Backward: sends the element back for one level.
+ Send to Back: sends the element behind all other elements on the label.
+ Bring Forward: brings the element forward for one level.
+ Bring to Front: sends the element in front of all other elements on the label.

+ Move to layer: allows you to change the layer to which the selected object belongs. You can only
move the object to the unlocked layers.

NOTE

This option is available only if the layer is unlocked. More details are available in
section Layers Panel.

2.10.3. Group Context Menu

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

When right-clicking a group of objects, a context menu appears. The context menu includes the following
commands:

+ Properties: opens common group properties dialog.
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+ Copy: copies the selected content to the clipboard.

+ Cut: removes the selected group from the design surface and adds it to the clipboard to be pasted
elsewhere.

+ Delete: deletes the selected object(s) from the design surface.
+ Lock/Unlock: prevents the selected group from being moved or re-enables moving.
+ Group objects: unites the selected objects and makes them behave as a single object.
+ Ungroup objects: separates previously grouped objects.
+ Arrange group defines how the group position according to other objects or groups.
+ Send Backward: moves the selected group down one level.
+ Send to Back: moves the selected group to the bottom of the object stack.
+ Bring Forward: moves the selected group up one level.
+ Bring to Front: moves the selected group to the top of the object stack.

+ Align group allows setting the alignment and spacing for objects on the design surface. All objects
can be aligned according to the neighboring object or according to the document border.

Horizontal alignment options are:

+ Left: aligns the selected objects with the left edge of the leftmost object or with the left edge of
the first selected object. If a single object is selected, it is placed on the label's left border.

+ Center Horizontally: aligns the selected objects with the horizontal center of the largest
selected object or with the horizontal center of the first selected object. If a single object is
selected, it is placed in the horizontal center of a label.

+ Right: aligns the selected objects with the right edge of the rightmost object or with the right
edge of the first selected object. If a single object is selected, it is placed on the label's right
border.

+ Distribute Horizontally: equalizes horizontal spacing between the objects.

Vertical alignment options are:

+ Top: aligns the selected objects with the top edge of the topmost object or with the top edge of
the first selected object. If a single object is selected, it is placed on the label's top border.

+ Center Vertically: aligns the selected objects with the vertical center of the largest selected
object or with the vertical center of the first selected object. If a single object is selected, it is
placed in the vertical center of a label.

+ Bottom: aligns the selected objects with the bottom edge of the lowest object or with the
bottom edge of the first selected object. If a single object is selected, it is placed on the label's
bottom border.

- Distribute Vertically: equalizes vertical spacing between the objects.
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TIP

Align to label/form is achieved by holding the <Ctr > key and clicking the above
listed align icons.

+ Move to layer: allows you to change the layer to which the selected object belongs. You can only
move the object to the unlocked layers.

NOTE

This option is available only if the layer is unlocked. More details are available in
section Layers Panel.

+ Zoom: defines zooming behavior:
+ Zoom to Document: shows the entire label in the Designer window.

+ Zoom to Objects: shows all objects in the Designer window.
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3. Label

Label works as a template to add label objects and print using any kind of printing media.

Each object adds a different kind of content such as text, line, ellipse, barcode or rectangle to a label. The
content is either fixed (manually entered by the user) or dynamic (defined using values from connected data
sources).

After finishing with your label design, you can print the labels using any of your installed printers.

S PRODUCT LEVEL INFO

Solution building is available in PowerForms.

Designing of a printable label belongs to basic Designer tasks. Designer allows creating and printing of
stand-alone labels and labels that are included in a printing solution.

Read about how to create, design or edit a label here.

3.1. New Label Setup Wizard

Label Setup Wizard guides you through the process of creating a new label. The wizard consists of four
configuration steps and a summary:

+ Step 1: Select the Printer

+ Step 2: Set the Page Size

+ Step 3: Select the Label Layout

+ Step 4: Specify the Label Dimensions

+ Step 5: Summary

After finishing these steps, the label is ready for editing and printing.

NOTE

To quit Label Setup Wizard during any step, press <Escape>. The new label properties are
set to default.

3.1.1. Step 1: Select the Printer

This step selects the printer to be used for printing the newly created label. It also provides direct access to
printer driver properties.
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1. Select the printer from the dropdown list.

2. Use printer properties saved in: This setting allows you to define where does NiceLabel 10 take the
printer settings from while printing. There are two options available:

+ Printer Driver: When printing, NiceLabel 10 takes the printer properties that you define in the
printer driver. This means that all labels that share these settings print equally. E.g., if you
change printing darkness in the printer driver dialog to 10, all labels print with darkness set to
10.

This is the default setting. With this setting selected, the Printer properties button becomes
disabled. Access your printer properties from Windows system dialogs.

+ Label: When printing, NiceLabel 10 takes the printer properties that you save in the label. This
means that the way how this label prints is independent from how you configure the printer
driver. E.g., if you change the darkness for the label to 10, only this label prints with darkness

setto 10.
Label Properties
Printer Printer
Label Dimensions ZEBRA ZD300-203dpi ZPL V2 ,"P int i I ~
| Printer properties apply
Paper ; / :
) [] Always use the default printer A to this label only
Stocks Double-sided printing AR
e -
i Use printer properties saved in: | Label /= | | Printer properties

Batch Printing

Printing

Cutter Printer Driver ~
| Optimize printing of identicalTabes e 'ﬂp int " I ~

Info ! Printer properties a
Use advanced printer driver interface . prop PRl

to all created labels

[] Combine non-printer elements into one graphic when sent to printe,

All non-printer elements

[ Use store/recall printing mode
DRAM

[¥] Allow only printer elements to connect ta variable data sources

[ Pravant font replacament

Cancel

Read more about how to manage printer settings in knowledge base article Defining default
printer setting for all users (including network users).

Example for settings saved printer driver

The ribbon in your printer is ending its life period. As a result, the quality of printed labels

is decreasing. To enhance the quality before you receive a new ribbon, you must temporarily
increase the printing darkness for all labels at once. Configure the darkness level in your
printer driver and all your label print with increased darkness.

Example for settings saved in the label

If you are designing a label on a remote computer that currently does not have access to your
designated label printer, you can still design your label, save the printer properties within your
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label, and take this label to the computer that can access your label printer. The saved printer
settings make your label "portable”.

Use printer settings from the printer driver: select this option if you prefer printing using the printer
driver settings.

|§ NOTE

Specific printer models only allow you to set label dimensions using the printer
driver dialog. Among these models are high resolution ink jet coding and marking
systems. If you select such printer model for your label, Designer automatically
detects it and only allows you to take the label settings from the printer driver. Label
dimension settings in the Label Properties dialog are disabled in this case too.

Use custom printer settings saved in the label: each label may have its own printer settings defined
and saved by the user. Select this option to use the custom settings while printing.

3. Label setup wizard remembers the last selected printer. When creating another new label, the
wizard will automatically select the printer that you selected for your last created label. If this
printer is currently missing, your default printer is selected.

+ Always use the default printer: sets the default system printer to be used for the current print
job.

PRODUCT LEVEL INFO

Double-sided printing option is available in NiceLabel Designer Pro and
PowerForms.

+ Double-sided printing: enables double-sided printing for the new label.

+ Preview field: displays the label layout according to the currently set properties.

|§ NOTE

For additional information on the installed printer drivers and their settings, read https://
help.nicelabel.com/hc/categories/44084741534809.

3.1.2. Step 2: Set the Page Size

This step defines how the page size is selected. When using a thermal printer, it is recommended to set the
size automatically. Manual selection proves to be useful if you know the exact stock code or label format.

NOTE

When changing the printer, the Page Size settings always go to default (automatic).
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1. Select print media.

+ Print on a roll of labels option prints on the installed roll of labels. Page size for thermal
printers is detected automatically.

NOTE

If a thermal printer is selected in the preceding Select the Printer wizard step,
this option is enabled by default.

+ Print on a sheet of paper option prints labels on sheets of paper. It lets you manually define
the label page size to fit the printer.
With this option selected, additional settings appear:

+ Unit of measure: defines the unit of measure to be used while designing the label.

+ Paper: defines the label page Width and Height.

NOTE

If a regular home/office printer is selected in the preceding Select Printer
wizard step, Page size is enabled by default.

2. Select stock.
Load settings from a predefined stock option sets the page to be defined by the selected stock

type.
With this option selected, additional settings appear:

+ Stock: defines which stock type should be used when designing and printing the newly
created label. Stock types are usually associated with printer vendors or stationery suppliers.
Select the exact stock from the dropdown menu.

NOTE
If the selected stock is not compatible with printer, a warning appears. Label
designing and printing is disabled.

+ Stock information: displays the selected stock's properties.

3.1.3. Step 3: Select the Label Layout

This step defines the label orientation and rotation on a printer:

+ Orientation: sets the new label layout as Portrait or Landscape.
+ Rotated: rotates the Printer Layout of a label by 180 degrees, if the selected printer supports it.

+ Preview field: displays the label layout according to the currently set properties.
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3.1.4. Step 4: Specify the Label Dimensions

This step defines the dimensions of the newly created label, its margins, measurement unit, and labels
across positioning settings:

+ Unit of measure: defines the unit to be used while designing the label.
+ Label Dimensions: define the new label's Width and Height.

+ Margins: define the distance between the edge of the printing surface and the edge of the label
(left/right, top/bottom).

+ Labels Across: defines the number of labels to be printed on a single label sheet.
* Horizontal count: number of labels in a row.
+ Vertical count: number of labels in a column.
* Horizontal gap: sets horizontal distance between the labels on a sheet.
+ Vertical gap: sets vertical distance between the labels on a sheet.

+ Processing order: defines the direction in which the labels are printed. Set the starting corner where
the printing starts and define the horizontal and vertical direction of label positioning.

3.1.5. Step 5: Summary

This step summarizes the new label properties as defined using the Label Setup Wizard.
Before clicking Finish to enter the label editing and printing phases, check the displayed settings:

« Printer: selected printer for label printing.
+ Label dimensions: dimensions of the newly created label.

+ Paper dimensions: dimensions of the printable paper.

3.2. Label Properties

Label Properties editor selects the printer, sets label dimensions, and defines the printing paper properties.

The label properties settings are listed below and appear as dialog tabs:

Label Property Description
Printer Selects the preferred printer.
Label Dimensions Defines the Unit of measure and label dimensions.

Paper Defines the printing paper properties.

Stocks Selects the stock type.
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Label Property Description
Style Defines the label style parameters.
Batch Printing Defines details for grouped printing of labels.
Cutter Enables label roll cutting during or after the printing procedure.
Info Inserts the label description.

Label Properties
Printer Unit
Label Dimensions Unit of measure: mm -

Label Dimensions

Width: 10000 mm | 3 Height: 7000mm |5
Style Margins
Batch Printing Left: 0,00 mm v Top: 0,00 mm >
Cutter Right: 0,00 mm - Bottom: 0,00 mm -
Radius
Info
Vertical radius: 1,00 mm e Horizontal radius: | 1,00 mm pos
Labels Across
Horizontal count: 113 Horizontal gap: 0,00 mm :
Vertical count: 113 Vertical gap: 0,00 mm s

Processing order: 3 Horizontally - start at top left
Variable label size

["] Enable variable label size

Cancel

@ TIP

To open the Label Properties Editor, double-click the design surface.

3.2.1. Printer

Printer tab lets you define the printer to print the labels on, and to set printing behavior.

Printer dropdown menu lets you select a printer from the currently available printers.

TIP

To set the printer settings, select a printer and click Printer properties. This button gives
direct access to the selected printer's driver and its settings.
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NOTE

For additional information on the installed printer drivers and their settings, read the
NiceLabel Printer Drivers Installation Guide.

+ Always use the default printer: select the default system printer to be used for the current print job.

+ Double-sided printing: enables double-sided label printing.

+ Use printer properties saved in: This setting allows you to define where NicelLabel 10 takes the printer
settings from while printing. There are two options available:

+ Printer Driver: When printing, NiceLabel 10 takes the printer properties that you define in the
printer driver. This means that all labels that share these settings print equally. E.g., if you
change printing darkness in the printer driver dialog to 10, all labels print with darkness set to

10.

This is the default setting. With this setting selected, the Printer properties button becomes
disabled. Access your printer properties from Windows system dialogs.

+ Label: When printing, NiceLabel 10 takes the printer properties that you save in the label. This
means that the way how this label prints is independent from how you configure the printer
driver. E.g., if you change the darkness for the label to 10, only this label prints with darkness set

to 10.

Printer
Label Dimensions
Paper

Stocks

Style

Batch Printing
Cutter

Info

Label Properties

Printer
ZEBRA ZD500-203dpi ZPL V8

[] Always use the default printer

Double-sided printing ////

Use printer properties saved in:

Printing
Printer Driver

v Optimize printing of identic rm—az—qr‘?;\

Use advanced printer driver interface

[] Combine non-printer elements into one graphic when sent to printe_

All non-printer elements

[ Use store/recall printing mode

DRAM

[¥] Allow only printer elements to cannect ta variable data sources

| Prevent font replacement

-\;"-—r-"_Printer properties apply\‘_

(Printer properties apply |
to this label only
———

Printer properties

to all created labels

Cancel

Read more about how to manage printer settings in knowledge base article Defining default
printer setting for all users (including network users).

Example for settings saved in printer driver

The ribbon in your printer is ending its life period. As a result, the quality of printed labels
is decreasing. To enhance the quality before you receive a new ribbon, you must temporarily
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increase the printing darkness for all labels at once. Configure darkness level in your printer
driver and all your label print with increased darkness.

Example for settings saved in label

If you are designing a label on a remote computer that currently does not have access to your
designated label printer, you can still design your label, save the printer properties within your
label, and take this label to the computer that can access your label printer. The saved printer
settings make your label "portable”.

+ Use printer settings from the printer driver: select this option if you prefer printing using the printer
driver settings.

|§ NOTE

Specific printer models only allow you to set label dimensions using the printer driver
dialog. Among these models are high resolution inkjet coding and marking systems.
If you select such a printer model for your label, Designer automatically detects it
and only allows you to take the label settings from the printer driver. Label dimension
settings in the Label Properties dialog are disabled in this case too.

+ Use custom printer settings saved in the label: each label may have its own printer settings defined
and saved by the user. Select this option to use custom settings while printing.

Printing group of settings optimizes the printing process.

+ Optimize printing of identical labels: if multiple identical labels are printed, the printer does not need
to receive the label file each time. With this option enabled, the printer alone multiplies the print job.

+ Use advanced printer driver interface: speeds up label printing.

TIP

When selected, the optimized printer commands are in use. Deselected option
disables printing optimization. Each label is sent to the printer in form of an image.

+ Combine non-printer elements into one graphic when sent to printer: merges multiple label objects
into a single large graphic and sends it to a printer.

@ TIP

With disabled merging, Designer sends graphic items to a printer separately which
might in rare occasions cause object positioning issues. Merged graphic items ensure
correct rendering of the label. The downside of merging is increased amount of data
which is sent to printer.

Use one of the below listed combination types to merge the graphics in the most suitable way.
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+ Combination type: defines which label objects are merged for printing.

+ All non-printer elements: all label objects are merged into a single graphic item and sent
to printer.

+ All non-printer elements except counters: label objects are merged and sent to printer as
a single item with an exception. Counters are sent separately within the same print stream.

+ Only fixed non-printer elements: only label objects without variable content are merged
into a single graphic file and sent to printer.

@ TIP

Non-printer elements are all items that are sent to printer as graphics.
In opposite, internal printer elements are sent out as internal printer
commands and rendered by the printer.

|§ NOTE

To exclude any label objects from combination, your object name or the name of the
data source connected to your objects must include "DONOTCOMBINE":

= Properties - Picture_1 DONOTCOMBINE [Picture]

Source Style Position R

General

MName:

Picture_1 DONOTCOMEIME

Description:

Status

|:| Met printable
Visible
D Condition:

+ Use store/recall printing mode: optimizes printing performance. With store/recall mode activated,
Designer does not need to resend the complete label data for each printout. Instead, default labels
(templates) are stored in the printer memory and the Designer only sends recall commands to

complete the label content during the printing process. For more information, read Store/Recall
Printing Mode.

+ Store variant: printer memory location to store the label templates.
Printer memory location: printer memory location to store the label templates.

|§ NOTE

To make sure the stored label samples are not lost after power cycling the printer,
store them at non-volatile locations. Read more about non-volatile memory here.

+ Allow only printer elements to connect to variable data sources. If you connect your data
sources to objects that are not marked as internal printer objects, Designer informs you with an

error message and you also cannot print your label. This prevents variable data print errors in
the store/recall printing mode.
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+ Prevent font replacement: In case of missing fonts for textual label objects, NiceLabel applications
automatically find replacement fonts and print the labels using fonts that are similar to the missing
ones.

There are two reasons for missing label fonts:

+ The font is not installed on the system. This may happen if you design labels on one computer,
and print labels on another computer that does not have these fonts installed.

+ Font is not stored in printer memory. This may happen if you design labels for one printer, and
print the labels using another printer that does not store these fonts.

Automatic font replacement can significantly change text layout and, as a consequence, the entire
label design. If you want to prevent the printing of altered labels, enable the Prevent font replacement
option. This option stops label printing if there is a need to replace the missing label fonts.

Prevent font replacement option stops printing if the labels are in print mode. This is when you are no
longer editing labels in NiceLabel, but you are printing the labels using:

+ NicelLabel Print application.

+ Print label action in NiceLabel Automation configurations.
+ Print label action in forms.

+ NiceLabel Web Client.

* NicelLabel .NET API.

When designing and printing labels directly from NiceLabel 10 with Prevent font replacement option
enabled:

+ Printing continues if you print a label that you previously opened in Designer. Upon opening a
label, Designer automatically replaces the missing font.

+ Printing stops if you use printing form to change the current printer to a device that has no
matching fonts installed.

3.2.2. Label Dimensions

Label Dimensions tab specifies label dimensions and defines whether its size should adapt to the changing
size of the objects or not.

Unit of measure defines the unit to be used while designing the label. There are four available units: cm, in,
mm, and dot.

Label Dimensions group defines the label's Width and Height. Label dimension settings become active if
manual label dimensions are enabled.

NOTE

When manually inserting the unit of measure, this also changes the currently defined Unit.
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Margins group sets the distance between the edge of the printing surface and the edge of the label (left/
right, top/bottom).

@ TIP

Most laser and other non-thermal printers cannot print over the entire label surface. There
is usually a non-printable label area of about 5 mm from the border of a page. In Designer,
this area is marked by a red line. Any object on or beyond the red line is not printed entirely.

Radius group enables you to make the label corners rounded.

+ Vertical radius: adjusts corner roundness value in the vertical direction.

+ Horizontal radius: adjusts corner roundness value in the horizontal direction.

Labels Across defines the number of labels to be printed on a single label sheet.

+ Horizontal count: number of labels in a row.

+ Vertical count: number of labels in a column.

+ Horizontal gap: horizontal distance between labels on a sheet.
+ Vertical gap: vertical distance between labels on a sheet.

+ Processing order: defines the direction in which labels are printed. Set the starting corner in which
printing starts, and the horizontal/ vertical directions of label positioning.

Variable Label Size group enables the label size to change in accordance with the size of its objects.

When assigning additional data to label objects, their size increases and occupies more space. Therefore,
the label height must adapt.

+ Offset: distance between the last object on a label and the bottom edge of a label.

3.2.3. Paper

Paper tab sets printing paper properties.
Unit selects the Unit of measure to be used in a label.
Paper Type group defines paper dimensioning type — automatic or manual.

+ Automatically set page size based on the label dimensions (labels on a roll): page size is defined by
the printer driver.

NOTE

If a thermal printer is selected, this option is enabled by default.
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+ Manually set page size (sheets of paper): page size is set manually.

NOTE

If a regular office laser printer is selected in the previous wizard step, this option is
enabled by default.

If the page size is defined manually, additional options appear:

+ Paper: selection of standard paper formats.

+ Width and Height: custom paper dimensions.

Orientation group sets the new label layout as Portrait or Landscape.

+ Rotated: Printer Layout is rotated by 180 degrees.

Preview displays current label screen and print layouts.

3.2.4. Stocks

Label stocks are a time-saving alternative to designing labels from scratch. Use stock templates when
designing labels for a specific printer type and when optimizing the label designing process.

Stocks group defines which stock type should be used when designing and printing a label. Stock types are
usually associated with printer vendors or stationery suppliers.

NOTE

Here defined stock properties override the manually set label properties.

Stock defines the exact stock to be used for label designing and printing. Stocks are sorted by vendors and
media formats. Expand stock provider and select a specific stock type.

@ TIP

Use Search... to easily find the requested stock. A partial search is available — enter

a sequence of characters and all stocks which contain that sequence will be listed. If

the selected stock is not compatible with the selected printer, a warning appears. The
previously selected stock becomes active again (if it was defined) allowing the printing to
continue.
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Label Properties
Printer Stocks

Label Dimensions Stock: (none) 5

Paper Stack information: Search

Stocks (gone}
- 8 arLl
. 8 Avery Ad

Batch Printing B Avery Other
Cutter g Avery US
Info 8 Brady

8 s

Bl Datamax

B Direct 2000

& Direct Quick Print 3000
B HERMA

8 IDENTCO

Q Intermec

8 PolyPro 2000

8 PolyPro Direct 2000
8 Printronix

Cancel

@ NOTE

If the selected stock is not compatible with the selected printer, a warning appears.
Previously selected stock becomes active again (if it was defined) allowing the printing
to continue.

Stock information displays the selected stock's properties:

+ Label dimensions
+ Labels across
+ Description

« Author

3.2.5. Style

Style tab is used for defining label style properties.
Background color: sets the color of label background.
Background picture: sets the label background picture.

+ Picture file name: defines the image file to be used as background picture.
« Embed picture in a document: saves picture into the label file.

+ Save embedded picture to file: the embedded label picture is saved to a separate file.
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+ Remove embedded picture: embedded picture is removed from the label file.
+ Picture position: sets picture position on the label.

+ Center: centers the picture on the label with its original dimensions. A picture larger than the
label will display only the central part leaving the rest out of view.

« Fit: resizes the picture to fill the label while keeping the original aspect ratio.

« Stretch: stretches picture to make it fill the entire label.

NOTE

This option ignores the original aspect ratio of the picture. The picture might
appear distorted on the label.

+ Rotation: allows you to rotate the background picture in steps of 90 degrees.

+ Print background picture: background picture is printed.

3.2.6. Batch Printing

Batch printing allows grouped printing of labels that belong to the same batch.

TIP

A batch is a set of labels printed within a single print job. Each print job can consist of a
single or multiple batches.

The first purpose of batch printing is to automate the execution of a predefined action after the batch has
been printed.

Example

Label roll is automatically cut after a batch of five labels has been printed.

The second purpose of batch printing is to enable header and tail label printing with each batch.
Example

A batch of five labels starts with a header and ends with a tail label. Both of them differ from the main
(body) labels.
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Label Properties

Print; Batch printing
Label Dimensions Enable batch printing

Paper Batch definition:

All labels in the print job -

Style Actions
Action after the last label in the batch:
MNone -
Header / Tail Labels
[] Use header label
Action after header label: None
[] Use tail label
Action after tail label: None

oK Cancel

+ Enable batch printing: activates batch printing mode. Batch definition menu becomes active.
+ Batch definition: specifies what a batch of labels should consist of:
+ All labels in the print job: all labels in the current print job are assigned to the same batch.

+ Batch ends after a specific number of labels: batch is finalized after a specified number of
labels is printed.

+ Batch ends when the data source changes value: changed value of the selected variable is used
as a marker for opening a new batch.

Actions group defines the action that executes after a batch has been printed. The availability of actions
depends on the selected printer's driver. If the driver provides no information on the action availability, the
listis empty.

Example

Commonly used batch actions are Cutter, Pause printer, Batch mark, Batch separator, etc. With a defined
web of labels (label template with labels next to each other), an applicable action also becomes Eject page.
These printer commands can be applied dynamically during the printing process.

Header / Tail Labels group specifies the properties of header and tail labels in a batch.

+ Use header label: header label of a batch.

+ Action after header label: action to be taken after the header label has been printed. The selection of
available actions depends on the selected printer's driver.

NOTE

The selection of available actions depends on the selected printer's driver.
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+ Use tail label: |last label of a batch.

+ Action after tail label: action to be taken after the tail label has been printed.

|§ NOTE

The selection of available actions depends on the selected printer's driver.

TIP

Header, tail, and main (body) labels of a single batch are accessible via tabs that are
located under the design surface (gray field).

3.2.7. Cutter

NOTE

To enable label cutting, your selected printer must be equipped with a cutter.

Cutter enables automated label roll cutting during or after label printing.
Enable cutter activates label cutter and enables you to configure how to cut off labels.
Cutter mode specifies when to cut the label roll.

+ Cut after the last printed label: cuts label roll after finishing print jobs.
+ Cut after a specific number of labels: cuts label roll after printing the selected number of labels.

+ Cut when the data source changes: cuts label roll when the selected data source value changes.

After you select Cut after a specific number of labels or Cut when the data source changes, additional
options open up:

+ Cut if condition is met: allows you to set a condition that tells the printer to cut labels. Use values
from connected data sources to define under what condition do the labels start to print.

« Always cut after last printed label: tells the printer to cut off the roll after the last label in a print job.

NiceLabel 10 synchronizes Cutter settings with the currently selected printer. See section Synchronizing
Cutter Settings with Printer for more details.

3.2.8. Info

Info tab includes a Description that serves as a hint or as a guide for the user that is going to work with the
label.
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Define label Description by entering text into the field.

3.3. Label Objects

After setting the label properties, it's time to start adding content to the label. Label objects are basic
design items that are used for adding and editing various content types. Each object has its own function
as described in the table below.

Label Object
Text

Text box

Rich text box

Barcode

Picture

Rectangle

Line

Ellipse

Icon

T ~

Text

[T] v

Text box

i X

Rich text box

[

Barcode

[aa] v

Picture

Il

Rectangle

e

Line

Q

Ellipse

Description

Container for textual content. It adapts its dimensions to fit the
amount of entered characters. When typing, text object grows
horizontally and/or vertically.

Container for textual content. It can either adapt its height to
the content or make the font increase or decrease to fit into the
object frame.

Container for rich text. It supports formatted text, hyperlinks, line

images, and other rich content created with a word processor.

Object for adding and editing various types of barcodes on a

label.

Object for adding graphic content to a label.

Object for creating rectangular shapes on a label.

Object for creating lines on a label.

Object for creating circular shapes on a label.
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Label Object Icon Description
Inverse Y Object for inverting the color of the underlying object.
Inverse
Report Object for creating reports on a label.
Report
3.3.1. Text

Text object is a container for textual content which adapts its dimensions to fit the amount of inserted
characters. When typing, text object grows horizontally and/or vertically.

TIP

Text Box serves as an alternative when designing a label on which the textual content must
fit into a field with predefined dimensions.

3.3.1.1. Source

Connected data source defines the content source of the selected object.

+ Fixed data: manually entered fixed text.

+ Variables: predefined variable values which are used as object content.
+ Functions: input data transformation tools.

- Databases: database values which are used as object content.

+ Counter: displays counter value on the label.

The content field allows you to type the object content.
Content Mask sets the format of the input data before it is displayed on a label.

Mask character is a character used in the mask that is replaced with actual data on the printed label.

Example

A user needs to format a phone number to be more readable on the label. Data input is not formatted since
it is read from a database.

If the input value read from a database is:
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+38642805090
and the content mask is:
(****) *hkkAhk _ Khkkhkk

the resulting output is:

(+386) 4280 - 5090

If the data contains the asterisk "*" character, change the Mask character. The character should have a
unique value that does not appear anywhere in the data.

3.3.1.2. Style

Font color sets text font and underline color.

Font selects the typeface. Fonts are divided into two groups: OpenType fonts and Printer fonts.

S NOTE

If the currently selected printer is a thermal printer, additional fonts become available.
These are the internal Printer fonts that are installed on the printer. Printer fonts are
identified by the printer icon in front of their names.

The font may appear Bold, Italic, Underlined, or as a Strikethrough text.

Font Scaling sets the font-stretch factor. If the factor is set to 100 %, the font appears in a normal scale. If
the factor is set to 200 %, the font appears twice as wide. If set to 50 %, font width is shrunk to half its size.

Alignment defines the horizontal positioning of the entered content.
+ Left: text aligned with the left object border.
+ Center: text positioned in the center of the object.
+ Right: text aligned with the right object border.

+ Justified: distributes text evenly along both sides.

NOTE

Justified is enabled in Text box only.

Spacing sets the space between text characters and lines.

+ Line spacing: space between each line in a paragraph.

+ Character spacing: space between individual characters.
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3.3.1.3. Effects
Inverse: inverted text and object background colors.
Mirror: mirrored text.

RTL printing: the right to left text printing.

@ TIP
Most thermal printers print right-to-left scripts automatically. This option becomes useful if
the operating system does not provide native RTL support.

@ PRODUCT LEVEL INFO

This segment is applicable to Designer Pro and PowerForms.

Text on ellipse definition enables you to add and display curved text on a label.

+ Text on ellipse: enable this option to set the text on a curve.

+ Text start: sets text starting point on the ellipse. The default position is 9 o'clock. When increasing the
position value, it moves clockwise by degrees.

+ Text length: sets the portion of the ellipse to be used for displaying the text. The maximum value
(default) takes the complete ellipse. Reducing the value in degrees shortens the available portion.

o 5

U %?;(\‘5\6 text Sa”"/%\
\

Source EEGIEE Position  General

Style Effects - -,
| Default text start |

Invers / .
e /4 location (9 o'clock)
Mirrar 'y A |
RTL printing /{;‘/

Text on ellipse definition Y/

Text on ellipse /
Text start: (1]
Text length: 180 : -~ -
Clockwi T 3

ockwise - 180 Text length value: half

™ of the curve used for text
.

3.3.1.4. Position

Position tab defines object positioning and its position-related behavior.
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Position group defines the object's position.

« Xand Y: anchoring point coordinates.

Size group gives information about the object's dimensions.

+ Width and Height: horizontal and vertical object dimensions.

+ Keep aspect ratio: simultaneous changing of object dimensions while scaling.

@ TIP

In the Text object, the size of the text is determined by the font size. Object
dimensions and aspect ratio cannot be changed manually and only serve as
information about its current size.

|§ NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

@ TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider,
or click and drag the T icon on the selected object. The rotation angle and slider rotate the
object around its anchoring point. The T icon rotates the object around its central point.

Anchoring point is the spot where an object is pinned to the design surface. Variable size objects increase
or decrease their size in the direction that is opposite to the chosen anchoring point.

Lock prevents the object from being moved during the design process, select under the Design behavior
group.

3.3.1.5. Relative position

Relative Position options define the position of an object when the label size or positions of neighboring
objects are changing during the label design process.

+ Enable horizontal relative position: activates horizontal relative positioning.

* Relative to label border: the position of the object is defined relative to the reference label
border. Define horizontal offset for the object with regard to this border.

+ Relative to another object: the position of the object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

+ Object: selects the reference object for horizontal relative positioning.
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- Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

+ Offset: horizontal distance from label border or reference object's anchoring point.
+ Enable vertical relative position: activates vertical relative positioning.

+ Relative to label border: the position of the object is defined relative to the reference label
border. Define vertical offset for the object with regard to this border.

+ Relative to another object: the position of the object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.

+ Object: selects the reference object for vertical relative positioning.

+ Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

+ Offset: vertical distance from label border or reference object's anchoring point.

NOTE

Object position changes if the label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.

NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

3.3.1.6. General

General tab identifies the object and sets its status.

Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.

NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.
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+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.

Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

+ Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.

TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button, then select the appropriate sign type.

3.3.2. Text Box

Text box object is a container for textual content on a label. Text box object is very similar to the standard
Designer Text object. The difference between these two is the presentation of textual content with variable
length. Text object is always expanding or shrinking to adapt its size to the amount of entered characters.
In contrast, Text Box can either adapt (expand/shrink) its height to the content or make the font increase or
decrease its size to fit into the object frame.

@ TIP

To ensure that the content fits the predefined box is especially useful when working with
variable data. No matter how long the text value is, it is always placed and displayed on a
label within the pre-designed frame.

3.3.2.1. Source
Connected data source defines the content source of the selected object.
+ Fixed data: manually entered fixed text.
+ Variables: predefined variable values which are used as object content.
+ Functions: input data transformation tools.
- Databases: database values which are used as object content.

+ Counter: displays counter value on the label.
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The content field allows you to type the object content.
Mask group sets the format of the input data before it is displayed on a label.

+ Content mask sets the format of the input data before it is displayed on a label.

« Mask character is a character used in the mask that is replaced with actual data on the printed label.

Example

A user needs to format a phone number to be more readable on the label. Data input is not formatted since
it is read from a database.

If the input value read from a database is:
+38642805090

and the content mask is:

(****) *hkkAh _ Khkkk

the resulting output is:

(+386) 4280 - 5090

If the data contains the asterisk "*" character, change the Mask character. The character should have a
unique value that does not appear anywhere in the data.

3.3.2.2. Style

Font color sets text font and underline color.

Font selects the typeface. Fonts are divided into two groups: OpenType fonts and Printer fonts.

S NOTE

If the currently selected printer is a thermal printer, additional fonts become available.
These are the internal Printer fonts that are installed on the printer. Printer fonts are
identified by the printer icon in front of their names.

The font may appear Bold, Italic, Underlined, or as a Strikethrough text.

Font Scaling sets the font-stretch factor. If the factor is set to 100 %, the font appears in a normal scale. If
the factor is set to 200 %, the font appears twice as wide. If set to 50 %, font width is shrunk to half its size.

Alignment defines the horizontal positioning of the entered content.

+ Left: text aligned with the left object border.

+ Center: text positioned in the center of the object.
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+ Right: text aligned with the right object border.

+ Justified: distributes text evenly along both sides.

NOTE

Justified is enabled in Text box only.

Spacing sets the space between text characters and lines.

+ Line spacing: space between each line in a paragraph.

+ Character spacing: space between individual characters.

3.3.2.3. Text Fit

None makes Text box size and font non-adaptable.

S NOTE

If the content amount exceeds the object size, an error message appears. The label is not
printed. To suppress such error and print the text box, enable Ignore excessive content at
print.

Adjust height to fit content: automatic adaptation of Text box height.

Fit content by adjusting font size: increases or decreases the font size to make it fit inside the Text Box
object.

« Minimum size: minimum permitted font size.

+ Maximum size: maximum permitted font size.

Fit content by scaling font: shrinks or stretches the font to make it fit inside the Text Box object.

+ Minimum font scaling: minimum font stretch factor.

« Maximum font scaling: maximum font stretch factor.

Use the same font size for all Text boxes in a group equalizes font size for all Text box objects in a group.
If one of the Text boxes in a group changes its size, the font size adapts. Font sizes of other Text boxes in a
group are automatically set to the same size.

Same size group defines group name.

TIP

This option can be used if Text Fit is enabled. Both Text Fit options are supported — by
adjusting the font size or by scaling the font.
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3.3.2.4. Effects

Inverse: inverted text and object background colors.
Mirror: mirrored text.

RTL printing: the right to left text printing.

TIP

Most thermal printers print right-to-left scripts automatically. This option becomes useful if
the operating system does not provide native RTL support.

3.3.2.5. Boundaries

Left border group defines the text boundary along the object's left border.

+ Shape: selects a customizable basic shape of text boundary.

+ Width: extends or shrinks the selected basic left boundary horizontally.

+ Height extends or shrinks the selected basic left boundary vertically.

Right border group defines the text boundary along the object's right border.

+ Right shape selects the basic shape of the object's right boundary.

+ Width extends or shrinks the selected basic right boundary horizontally.

+ Height extends or shrinks the selected basic right boundary vertically.

Example

Boundary defines how the text flows inside the object.

Lorem ipsum dolor sit amet, consectetur adipiscing elit.
Proin aliquam id augue sed porttitor. Nunc sit amet dui
justo. Aliquam condimentum mauris arcu, at hendrerit
metus elementum eu. Morbi tristique libero ac turpis
consequat, nec efficitur tortor malesuada.
Sed gravida odio at augue
scelerisque aliquet.
Suspendisse imperdiet eget orci non
bibendum. Aenean mattis nunc vitae pretium porttitor.

Donec facilisis eleifend urna in vehicula.

3.3.2.6. Position

Position tab defines object positioning and its position-related behavior.
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Position group defines the object's position.

+ Xand Y: anchoring point coordinates.

Size group sets the object's dimensions:

+ Width and Height: horizontal and vertical object dimension.

+ Keep aspect ratio: simultaneous changing of object dimensions while scaling.

N

NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

°

TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider
or click and drag the T icon on the selected object. Rotation angle and slider rotates the
object around its anchoring point. The ! icon rotates the object around its central point.

Anchoring point is the spot where an object is pinned to design surface. Variable size objects increase or
decrease their size in the direction that is opposite to the chosen anchoring point.

Lock prevents the object from being moved during the design process.

Relative Position options define the position of an object when label size or positions of neighboring
objects are changing during the label design process.

+ Enable horizontal relative position: activates horizontal relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define horizontal offset for the object with regard to this border.

Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

Object: selects the reference object for horizontal relative positioning.

Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

Offset: horizontal distance from label border or reference object's anchoring point.

- Enable vertical relative position: activates vertical relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define vertical offset for the object with regard to this border.

Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.

136



+ Object: selects the reference object for vertical relative positioning.

- Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

- Offset: vertical distance from label border or reference object's anchoring point.

NOTE

Object position changes if label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.

|§ NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

|§ NOTE

If the measurement unit is changed, the value transforms automatically.

3.3.2.7. General
General tab identifies the object and sets its status.

Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.

NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.

+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.
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Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

+ Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.

TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button, then select the appropriate sign type.

3.3.3. Rich Text Box

Rich text box (RTF) is an object for rich text editing. It encloses textual content with hyperlinks, line images,
and other formatting created using an internal Designer's word processor.

3.3.3.1. Source

Connected data source defines the content source of the selected object.

+ Fixed data: manually entered fixed text.

+ Variables: predefined variable values which are used as object content.
+ Functions: input data transformation tools.

- Databases: database values which are used as object content.

+ Counter: displays counter value on the label.

The content field allows you to type the object content.
Rich Text Box Editor is a full-scale text processor.

Edit content button opens the editor.

Supported actions in Rich Text Box Editor:

+ Text formatting
+ Content find and replace
+ Inserting of images, symbols, tables, and dynamic data sources

+ Content zooming

Show RTF code option displays the RTF code.

138



TIP

Read more about the available Rich Text Box Editor features in a dedicated topic.

3.3.3.2. Style

Rendering group defines the active rendering method for the rich text content. If you experience difficulties
while importing formatted text to the Rich text box object, switch to Alternative rendering. This helps you
achieve correct content formatting on the printed labels.

S NOTE

Alternative rendering adds support for right-to-left scripts.

@ NOTE

If you are editing legacy NiceLabel label files (.Ibl), Alternative rendering is automatically
active.

|§ NOTE

If you are designing labels with custom fonts, Alternative rendering is the preferred option.

3.3.3.3. Text Fit

None makes Text box size and font non-adaptable.

+ None: non-adaptable Rich Text box size and font.

S NOTE

If the content amount exceeds the object size, an error message appears. The label
is not printed. To suppress such error and print the text box, enable Ignore excessive
content.

+ Adjust height to fit content: automatic Rich Text box height adaptation.
+ Fit content by adjusting font size: adaptable font size.
* Minimum size: minimum font size.

« Maximum size: maximum font size.

3.3.3.4. Position

Position tab defines object positioning and its position-related behavior.
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Position group defines the object's position.

« Xand Y: anchoring point coordinates.

Size group sets the object's dimensions:

+ Width and Height: horizontal and vertical object dimension.

+ Keep aspect ratio: simultaneous changing of object dimensions while scaling.

N

NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

°

TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider
or click and drag the T icon on the selected object. Rotation angle and slider rotates the
object around its anchoring point. The T icon rotates the object around its central point.

Anchoring point is the spot where an object is pinned to design surface. Variable size objects increase or
decrease their size in the direction that is opposite to the chosen anchoring point.

Lock prevents the object from being moved during the design process.

3.3.3.5. Relative Position

Relative Position options define the position of an object when label size or positions of neighboring
objects are changing during the label design process.

+ Enable horizontal relative position: activates horizontal relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define horizontal offset for the object with regard to this border.

Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

Object: selects the reference object for horizontal relative positioning.

Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

Offset: horizontal distance from label border or reference object's anchoring point.

+ Enable vertical relative position: activates vertical relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define vertical offset for the object with regard to this border.
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+ Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.

+ Object: selects the reference object for vertical relative positioning.

- Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

- Offset: vertical distance from label border or reference object's anchoring point.

NOTE

Object position changes if label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.

NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

3.3.3.6. General

General tab identifies the object and sets its status.

Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.

NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.

+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.

+ Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.
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TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button select the appropriate sign type.

Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

3.3.3.7. Rich Text Box Editor

Rich Text Box Editor is a fully-featured word processor. It enables you to create, edit, and format the
content of a Rich text box label object.

Sections below describe the editor's tabs and matching ribbon groups with commands that are available
when creating and editing the Rich Text box content.

3.3.3.7.1. HOME TAB

File ribbon group enables the handling of a document.

+ Import: importing of textual content to the editor.

+ Export: exporting of textual content from the editor.

@ TIP

Use file browser window to select the export location. By default, the editor content
is exported as a file with .rtf extension. To specify an alternative file format, select it
from the dropdown list.

Clipboard ribbon group activates the following actions:

+ Paste: pastes clipboard data.
+ Copy: copies current selection to the clipboard.

+ Cut: cuts selection to clipboard.

Undo Redo ribbon group undos or repeats editing actions.

Font ribbon group includes typical font style and formatting related commands. These are font selection,
size, font growing and shrinking, bold, italics, etc.

TIP

For additional font-related settings, open the Font box in dialog form by clicking the ™ icon
in the bottom right corner of the ribbon group.
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Text Box group defines lists and indents, toggles formatting symbols, sets alignment and line spacing, and
enables text shading.

TIP

For additional text related settings, open the Text Box in dialog form by clicking the = icon
in the bottom right corner of the ribbon group.

Editing group includes:

+ Find searches and locates the inserted string within a text.

+ Replace locates and replaces the inserted string with a new text.

3.3.3.7.2. INSERT
Insert group enables adding editable elements to the rich text object.

- Data Source: adds variable, function, or a database field as a dynamic content source.

+ Table: opens the Insert Table dialog. Define Number of columns and Number of rows. After clicking
OK, a table with the defined number of columns and rows is placed in the rich text editor.

+ Picture: inserts a picture into the rich text object.
+ Symbol: opens Insert Symbol dialog for character selection.
+ Search by code: character search by unicode character code.
+ Font name: font selection.
+ Character set: an active set of characters.
+ Filter: character search filter.

Frequently used symbols are displayed at the bottom of the dialog box. Click the symbol to insert it
directly in the rich text object.

3.3.3.7.3. VIEW

Zoom group allows zooming the text in and out.

3.3.4. Barcode

Barcode object is used for adding various types of barcodes with encoded data to your labels.

Details on barcode properties, types, and data encoding methods are available in the dedicated Barcode
section.
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3.3.5. Picture

Use Picture object to add graphic content on a label. The following file formats are supported:

+ Portable Network Graphic (*.png)

- PDF (*.pdf)

+ Adobe Photoshop (*.psd)

+ Scalable Vector graphics (*.svQ)

+ Paintbrush (*.pcx)

+ JPEG bitmaps (*.jpg, *.jpeg, *.jpe)

« TIFF bitmaps (*.tif, *.tiff)

+ Enhanced Windows Metafile (*.emf)
+ Windows Metafile (*.wmf)

+ Windows bitmap (*.bmp)

+ Graphics Interchange Format (*.gif)

3.3.5.1. Source

Connected data source defines the content source of the selected object.

+ Variable keyboard input: type of variable that enables the content of a prompted field to be different
for every print job.

+ Variables: predefined variable values which are used as object content.
+ Functions: input data transformation tools.

- Databases: database values which are used as object content.

Content field is used for entering the object content.
To (re)define the Picture object Content, click Browse and locate the file to be displayed on the label.

Embed picture in a document: stores the picture in the label file. Link to the original picture file is discarded.

TIP

Picture embedding makes the label file more portable as the user does not have to include
the picture file when sharing the label.

Save embedded picture to file: the embedded label picture is saved as a separate file.
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3.3.5.1.1. BASE64 ENCODED GRAPHICS

Base64 is a binary-to-text encoding method that encodes your graphic files into text files. Use Base64-
encoded graphics on your labels or forms when you want to access your graphics directly from your
database, and not with file paths to your hard drive.

Connect your Picture objects to database fields containing Base64 content. Designer automatically
recognizes Base64 text content and displays text content as images on your labels or forms.
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@ NOTE

Your Base64 strings must be longer than 250 characters.

|§ NOTE

For testing your label or solution designs, you can use prompt variables as your data
sources in Picture properties. Manually enter your Base64 text content as your variable
value at printing time.

3.3.5.1.2. BLOB FIELDS SUPPORT

Binary Large Objects (BLOBs) are collections of binary data. BLOBs are typically images, audio, or other
multimedia objects. Databases store BLOBs as single entities. Advanced databases like SQL, MySQL, and
Oracle support BLOB fields.

Use BLOB database fields on your labels or forms to access your graphics directly from your database, and

not as file paths to graphics on your hard drive.
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Connect your Picture objects to your BLOB database field. Designer automatically recognizes BLOB content
and displays the content as images on your labels or forms.

3.3.5.2. Style

Dithering group allows you to select the most appropriate dithering method to print pictures on labels in
black and white.

TIP

When printing pictures in black and white, dithering creates the illusion of multiple colors
and shades by varying the pattern of black dots.

Dithering type selects the dithering method:

+ Printer driver default: no dithering method is selected for the picture object. When printing in black
and white, printer driver uses its own dithering method.

|§ NOTE

If no dithering is set for the picture object, the algorithm can also be selected using

the printer properties dialog. The selected dithering algorithm for an object in Designer
overrides the algorithm selected using printer properties dialog. See Changing dithering
options for more detailed information.

+ Ordered: achieves dithering by applying a threshold map (matrix with cells) on the pixels displayed. If
the value of the pixel (scaled into the 0-9 range) is less than the number in the corresponding cell of
the matrix, the algorithm plots the pixel black, otherwise, it plots it white.

+ Threshold: sets a threshold to which every pixel is compared. If the original pixel value is higher than
the threshold, it renders white. The lower the threshold value, the higher the share of pixels turned to
white.

+ Floyd Steinberg: achieves dithering using error dispersion. This algorithm generates the closest result
to the original, but represents the slowest option.

Color group allows you to customize the color of a graphic object.

+ Force picture color: recolors the graphic object. Use the dropdown Picture color palette to pick the
appropriate color to be used for the object on the printed label.

NOTE

This option can be used with color printers using the advanced printer driver interface
or Windows printing mode.
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3.3.5.3. Position

Position tab defines object positioning and its position-related behavior.

Position group defines the object's position.

« Xand Y: anchoring point coordinates.

Size group sets the object's dimensions:

+ Width and Height: horizontal and vertical object dimension.

+ Keep aspect ratio: simultaneous changing of object dimensions while scaling.

N

NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

°

TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider
or click and drag the T icon on the selected object. Rotation angle and slider rotates the
object around its anchoring point. The ! icon rotates the object around its central point.

Anchoring point is the spot where an object is pinned to design surface. Variable size objects increase or
decrease their size in the direction that is opposite to the chosen anchoring point.

Lock prevents the object from being moved during the design process.

Relative Position options define the position of an object when label size or positions of neighboring
objects are changing during the label design process.

+ Enable horizontal relative position: activates horizontal relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define horizontal offset for the object with regard to this border.

Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

Object: selects the reference object for horizontal relative positioning.

Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

Offset: horizontal distance from label border or reference object's anchoring point.

+ Enable vertical relative position: activates vertical relative positioning.
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+ Relative to label border: the position of object is defined relative to the reference label border.
Define vertical offset for the object with regard to this border.

+ Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.

+ Object: selects the reference object for vertical relative positioning.

- Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

- Offset: vertical distance from label border or reference object's anchoring point.

NOTE

Object position changes if label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.

|§ NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

@ NOTE

If the measurement unit is changed, the value converts automatically.

Graphic Resizing tab is available if the picture object is connected to a variable. These settings define how
the Picture object adapts its size to the source file at print time.

+ Keep original picture size: disabled picture resizing. Picture size remains unchanged.
+ Resize proportionally: proportional picture resizing. Aspect ratio of picture dimension remains fixed.

+ Resize to the designed size: horizontal and vertical picture resizing to make it fit into the bounding
box. This option will most likely make the picture distorted.

Original size displays the picture's Width and Height before resizing. Revert to original picture size cancels
the resizing actions.

3.3.5.4. General

General tab identifies the object and sets its status.
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Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.

NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.

+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.

+ Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.

TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button select the appropriate sign type.

Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

3.3.6. Rectangle

Rectangle object creates a rectangular frame on a label.

Style
Outline group defines line settings:

+ Thickness: object line thickness.
+ Outline style: object line style.
+ Solid: solid line.

+ Dot: dotted line.
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+ Dash: dashed line.
+ Erase: parts of neighboring objects become invisible underneath this object.

+ Outline color: color of the line.
+ Corner radius: makes the rectangle corners round. Higher values make the curve broader.

Fill group defines the object fill settings and color.

« Fill style: object fill properties definition:
+ None: completely transparent object.
+ Erase: makes objects beneath the active one hidden.
+ Solid: fills the object with a solid color.
+ Right Diagonal: fills the object with diagonal lines that ascend toward the right side.
« Left Diagonal: fills the object with diagonal lines that ascend toward the left side.
+ Vertical: fills the object with vertical lines.
+ Horizontal: fills the object with horizontal lines.
+ Cross: fills the object with crossed lines.
+ Cross Diagonal: fills the object with diagonally crossed lines.
+ 25% of color: fill color opacity 25 %.
+ 50% of color: fill color opacity 50 %.
+ 75% of color: fill color opacity 75 %.

+ Background color: object fill color definition.

|§ NOTE

The system does not allow the Outline style and Fill style to be set to None at the same
time.

@ TIP

Shape objects (Rectangle, Line and Ellipse) in NiceLabel 10 remember the last used setting.
Each time you add one of these objects to the label, it has the same outline and fill settings
as the previously added shape object.

3.3.6.1. Position

Position tab defines object positioning and its position-related behavior.
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Position group defines the object's position.

+ Xand Y: anchoring point coordinates.

Size group sets the object's dimensions:

+ Width and Height: horizontal and vertical object dimension.

+ Keep aspect ratio: simultaneous changing of object dimensions while scaling.

N

NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

°

TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider
or click and drag the T icon on the selected object. Rotation angle and slider rotates the
object around its anchoring point. The ! icon rotates the object around its central point.

Anchoring point is the spot where an object is pinned to design surface. Variable size objects increase or
decrease their size in the direction that is opposite to the chosen anchoring point.

Lock prevents the object from being moved during the design process.

Relative Position options define the position of an object when label size or positions of neighboring
objects are changing during the label design process.

+ Enable horizontal relative position: activates horizontal relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define horizontal offset for the object with regard to this border.

Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

Object: selects the reference object for horizontal relative positioning.

Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

Offset: horizontal distance from label border or reference object's anchoring point.

- Enable vertical relative position: activates vertical relative positioning.

Relative to label border: the position of object is defined relative to the reference label border.
Define vertical offset for the object with regard to this border.

Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.
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+ Object: selects the reference object for vertical relative positioning.

+ Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

+ Offset: vertical distance from label border or reference object's anchoring point.

NOTE

Object position changes if label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.

NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

3.3.6.2. General

General tab identifies the object and sets its status.

Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.

NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.

+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.

+ Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.
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TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button select the appropriate sign type.

Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

Printing optimization group allows activating the use of internal printer elements.

@ TIP

If supported by the selected printer model, a share of label element processing is handled
directly by the printer (e.g., internal fonts, shapes, barcodes). This speeds up the printing
process also due to significantly reduced data traffic.

+ Use printer element if supported: prints labels using internal printer elements if the printer allows it. If
a selected printer does not support internal printer elements, the element is sent as a graphic file.

+ Always use printer element: prints labels using printer elements only. If a selected printer does not
support internal printer elements, an error message with an explanation is displayed.

+ Always print as graphics: sends and prints the objects as graphic files.

When connecting your object to a variable, enable the Use printer element if supported or Always use
printer element option. Printing in graphic mode returns a printing error.

NOTE

Enabled advanced printer driver interface combined with the printer driver is required to
print this object as an internal printer element.

3.3.7. Line

Line object creates a line on a label.

Style
Outline group defines line settings:

+ Thickness: object line thickness.
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+ Outline style: object line style.
+ Solid: solid line.
+ Dot: dotted line.
+ Dash: dashed line.
+ Erase: parts of neighboring objects become invisible underneath this object.

+ Outline color: color of the line.

@ TIP

Shape objects (Rectangle, Line and Ellipse) in NiceLabel 10 remember the last used setting.
Each time you add one of these objects to the label, it has the same outline and fill settings
as the previously added shape object.

3.3.7.1. Position
Position tab defines object positioning and its position-related behavior.
Position group defines the object's position.

« Xand Y: anchoring point coordinates.

+ Length: sets the line length.

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

@ TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider,
or click and drag the 1 icon on the selected object. Rotation angle and slider rotates the
object around its anchoring point. The T icon rotates the object around its central point.

Lock prevents the object from being moved during the design process.

3.3.7.2. General

General tab identifies the object and sets its status.

Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.
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NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.

+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.

+ Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.

TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button select the appropriate sign type.

Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

Printing optimization group allows activating the use of internal printer elements.

@ TIP

If supported by the selected printer model, a share of label element processing is handled
directly by the printer (e.g., internal fonts, shapes, barcodes). This speeds up the printing
process also due to significantly reduced data traffic.

+ Use printer element if supported: prints labels using internal printer elements if the printer allows it. If
a selected printer does not support internal printer elements, the element is sent as a graphic file.

+ Always use printer element: prints labels using printer elements only. If a selected printer does not
support internal printer elements, an error message with an explanation is displayed.

+ Always print as graphics: sends and prints the objects as graphic files.

When connecting your object to a variable, enable the Use printer element if supported or Always use
printer element option. Printing in graphic mode returns a printing error.
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NOTE

Enabled advanced printer driver interface combined with the printer driver is required to
print this object as an internal printer element.

3.3.8. Ellipse

Ellipse object creates a circular object on a label.

Style
Outline group defines line settings:

+ Thickness: object line thickness.
+ Outline style: object line style.
+ Solid: solid line.
+ Dot: dotted line.
+ Dash: dashed line.
+ Erase: parts of neighboring objects become invisible underneath this object.

+ Outline color: color of the line.

Fill group defines the object fill settings and color.

« Fill style: object fill properties definition:
+ None: completely transparent object.
+ Erase: makes objects beneath the active one hidden.
+ Solid: fills the object with a solid color.
+ Right Diagonal: fills the object with diagonal lines that ascend toward the right side.
+ Left Diagonal: fills the object with diagonal lines that ascend toward the left side.
« Vertical: fills the object with vertical lines.
+ Horizontal: fills the object with horizontal lines.
+ Cross: fills the object with crossed lines.
+ Cross Diagonal: fills the object with diagonally crossed lines.
+ 25% of color: fill color opacity 25 %.

+ 50% of color: fill color opacity 50 %.
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+ 75% of color: fill color opacity 75 %.

+ Background color: object fill color definition.

@ NOTE

The system does not allow the Outline style and Fill style to be set to None at the same
time.

@ TIP

Shape objects (Rectangle, Line, and Ellipse) in NiceLabel 10 remember the last used
setting. Each time you add one of these objects to the label, it has the same outline and fill
settings as the previously added shape object.

3.3.8.1. Position
Position tab defines object positioning and its position-related behavior.
Position group defines the object's position.

« Xand Y: anchoring point coordinates.

Size group sets the object's dimensions:

+ Width and Height: horizontal and vertical object dimension.

+ Keep aspect ratio: simultaneous changing of object dimensions while scaling.

NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

@ TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider
or click and drag the T icon on the selected object. Rotation angle and slider rotates the
object around its anchoring point. The ! icon rotates the object around its central point.

Anchoring point is the spot where an object is pinned to design surface. Variable size objects increase or
decrease their size in the direction that is opposite to the chosen anchoring point.

Lock prevents the object from being moved during the design process.
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Relative Position options define the position of an object when label size or positions of neighboring
objects are changing during the label design process.

+ Enable horizontal relative position: activates horizontal relative positioning.

+ Relative to label border: the position of object is defined relative to the reference label border.
Define horizontal offset for the object with regard to this border.

+ Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

+ Object: selects the reference object for horizontal relative positioning.

+ Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

+ Offset: horizontal distance from label border or reference object's anchoring point.
- Enable vertical relative position: activates vertical relative positioning.

+ Relative to label border: the position of object is defined relative to the reference label border.
Define vertical offset for the object with regard to this border.

+ Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.

+ Object: selects the reference object for vertical relative positioning.

+ Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

+ Offset: vertical distance from label border or reference object's anchoring point.

NOTE

Object position changes if label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.

|§ NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

@ NOTE

If the measurement unit is changed, the value transforms automatically.

158



3.3.8.2. General

General tab identifies the object and sets its status.

Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.

NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.

+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.

- Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.

TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button select the appropriate sign type.

Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

Printing optimization group allows activating the use of internal printer elements.

@ TIP

If supported by the selected printer model, a share of label element processing is handled
directly by the printer (e.g., internal fonts, shapes, barcodes). This speeds up the printing
process also due to significantly reduced data traffic.

+ Use printer element if supported: prints labels using internal printer elements if the printer allows it. If
a selected printer does not support internal printer elements, the element is sent as a graphic file.
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+ Always use printer element: prints labels using printer elements only. If a selected printer does not
support internal printer elements, an error message with an explanation is displayed.

+ Always print as graphics: sends and prints the objects as graphic files.

When connecting your object to a variable, enable the Use printer element if supported or Always use
printer element option. Printing in graphic mode returns a printing error.

NOTE

Enabled advanced printer driver interface combined with the printer driver is required to
print this object as an internal printer element.

3.3.9. Inverse

3.3.9.1. About

Inverse object inverts the underlying object's color.

23456789012

“>JInverted color
7 field

3.3.9.2. Position
Position tab defines object positioning and its position-related behavior.
Position group defines the object's position.

« Xand Y: anchoring point coordinates.

Size group sets the object's dimensions:

+ Width and Height: horizontal and vertical object dimension.

+ Keep aspect ratio: simultaneous changing of object dimensions while scaling.
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|§ NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

@ TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider
or click and drag the T icon on the selected object. Rotation angle and slider rotates the
object around its anchoring point. The ' icon rotates the object around its central point.

Anchoring point is the spot where an object is pinned to design surface. Variable size objects increase or
decrease their size in the direction that is opposite to the chosen anchoring point.

Lock prevents the object from being moved during the design process.

Relative Position options define the position of an object when label size or positions of neighboring
objects are changing during the label design process.

+ Enable horizontal relative position: activates horizontal relative positioning.

+ Relative to label border: the position of object is defined relative to the reference label border.
Define horizontal offset for the object with regard to this border.

+ Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

+ Object: selects the reference object for horizontal relative positioning.

+ Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

+ Offset: horizontal distance from label border or reference object's anchoring point.
+ Enable vertical relative position: activates vertical relative positioning.

+ Relative to label border: the position of object is defined relative to the reference label border.
Define vertical offset for the object with regard to this border.

+ Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.

+ Object: selects the reference object for vertical relative positioning.

+ Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

- Offset: vertical distance from label border or reference object's anchoring point.
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NOTE

Object position changes if label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.

|§ NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

S NOTE

If the measurement unit is changed, the value transforms automatically.

3.3.9.3. General

General tab identifies the object and sets its status.

Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.

NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.

+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.

+ Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.

TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button select the appropriate sign type.
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Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

Printing optimization group allows activating the use of internal printer elements.

@ TIP

If supported by the selected printer model, a share of label element processing is handled
directly by the printer (e.g., internal fonts, shapes, barcodes). This speeds up the printing
process also due to significantly reduced data traffic.

+ Use printer element if supported: prints labels using internal printer elements if the printer allows it. If
a selected printer does not support internal printer elements, the element is sent as a graphic file.

+ Always use printer element: prints labels using printer elements only. If a selected printer does not
support internal printer elements, an error message with the explanation is displayed.

+ Always print as graphics: sends and prints the objects as graphic files.

|§ NOTE

Inverse object can only be printed as graphics if the advanced printer driver interface is
disabled. Make sure Windows printing mode is on before printing. Double-click the design
surface to open Label Properties dialog and go to Printer panel > Printing > disable option
Use advanced printer driver interface.

3.3.10. Reports

Printing reports with Designer completes your labeling and shipping cycle, helping you go from product
labeling to shipment with the same software. You can print reports from within Designer without the need
for third party applications. Report printing avoids the cost of having to learn, develop, and maintain third
party applications just to print your reports.

Reports are labels that display database data as custom tables. Report printing organizes your data into
rows. You can add headers and footers to explain more information about your data.

For example, you can create packing lists that accompany shipments from your warehouse:
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Designing custom reports in Designer helps you make shipments faster with fewer mistakes.

3.3.10.1. Report elements
Most reports have similar structures. You can include:

+ Repeating data from your database. Repeating data appears on every page of your report.

+ Headers and footers to explain the repeating data or give more information. Headers and footers can
repeat on some or all pages.

Report objects in Designer include 3 default elements:

164



= Properties - Report [Report]

S+l Position General

Report

© e

Table:

(none) =

Structure
- Add Header < Add Footer

D Header

E Repeater Definition

D Footer

O

1. Header

2. Repeater Definition (template for all repeating data). Changes the look and behavior of all repeating
data in every row of your report.

3. Footer

Add additional headers and footers to Report objects to build custom reports. For example, this packing list
contains multiple elements:
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page:? pPage:

1. Header for report name and date.
2. Header for logo and contact information. This header appears on the first page of your report.

3. Header for column descriptions for your data. Column descriptions repeat on every page so your
data is readable.

4. Repeater Definition for repeating data. This is your report data that can repeat on multiple pages.
5. Footer for report totals. This footer appears on the last page of your report.

6. Footer for signatures. This footer is pinned to the bottom of the last page of your report.

3.3.10.2. Creating new reports

1. Make a new label (Usually A4 or Letter size so your reports can print on office printers).
NOTE
If you are using Header or Tail labels, you can create your report only on your main

label. Header and Tail labels do not support Report objects.

2. Click and drag a Report object to your design surface.
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3. Resize your Report object until it fills most of your design surface. Report objects can be any size
smaller than your design surface.

TIP

Leave room for objects like page numbers which you must place outside Report
objects on your design surface.

4. Connect your database. Reports require database connections to function properly.

a. Open your Report object Properties (Right click > Properties or press F4) and click Report.

(RPN NN L N — Properties - Report [Report]

Position  General

b.

|

= Properties  F4

0y Copy

£ Move to layer

Go to Table and use the drop-down list to add your existing database, or use the Database

wizard.

Report
Table:
(none)

Structure

167

% Cut

X Delete  Add Header + Add Footer
[ Header

& Lock [ Repeater Definition
[ Footer

Uiy Amange »

& Align »




= Properties - Report [Report]

(=l Position  General

Report

Table:
(none) —
g Search..
(none)

=]
4 = Databases

# Database wizard

4 B Pasta.accdb

c. Your database is connected.

Your new report is ready to design.

3.3.10.3. Adding objects to reports

Drag and drop objects where you need them in your Report headers, Repeater Definitions, and footers.

Click and drag new objects into your elements:

A 05 ER (F () I I (R () () (1 (S [ [ | 1 1 [ |

Picture | —

E

i}

| O

Rectangle Line Ellipse Inverse

§ Data

Moving new objects into report elements.

Click and drag existing objects to move them between elements:

| FRESH PASTA (757} |
L COMPANY &

IR

021228310001 ]

tategor’y an Codei

|

Product iD_ Product name

PASSO1 RO PG, i, cybriical posta o o =
! ¢ Italian origin. Spaghetti is made of
semolina or flour and water.

Moving objects between elements. Blue backgrounds appear to help you place objects.
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TIP

Keep your Objects panel open (on your left) so you can always see which of your objects

are in which elements:

Data %{'}4 Layers

@ Objects

Search by name or data source.,

4 Layer
T Page number (Counter)
T Page
4 Report

» D Header column names

4 D Header report details
[&&] Picture
T Company phone Text
T Company adress: Country Text
T Company adress: Street Text
T Company adress: Name Text

4 D Header company details
T Report date (CurrentDate)
T Report name

4 E Repeater Row
Pasta category Text Box (category)
/" Row devider line
Product name text (ProductiName)
Il Barcode (CodeEAM)
Description Text Box (Description)
T Product ID Text (ProductiD)

3.3.10.4. Configuring Repeater Definitions

Your Repeater Definition works with the database you connect to your report as a template for how your

data displays. Reports create new lines for each record in your database. Connect objects in your Repeater

Definition to database fields connected to your report. Repeater Definition formatting applies to every

repeating line in your report.

Pasta sample report

Fresh Pasta Company
123 Pasta Plaza

9/17/2020

FRESH PASTA
COMPANY

Milano 1-555-PASTA
Configuring your Repeater Definition. ProductiD _ Product name Description Category Ean Code.
fPassot EIGOU 250G A long, thin, cylindrical pasta of Long pasta ™\

PASS02G!

PASSD3GI

PASSD4

PASS0S

PASSDEGI

\

TAGUATELLE 250G

TAGLIOUNI 250G

CAPELLI D'ANGELD

PAPPARDELLE 250G

SFOG LASAGNE 250G

halian origin. Spaghetti is made of
semolina or flour and water

Ribbon style pasta are often rolled
flat and then cut, This can be done
by hand or mechanically.

Ribbon style pasta are often rolled
flat and then cut. This can be done
by hand or mechanically.

A long, thin, cylindrical pasta of
Italian origin. Spaghetti is made of
semolina or flour and water

Ribbon style pasta are often rolled
flat and then cut. This con be done
by hand or mechanically.

Ribbon style pasta are often rolk
flat and then cut. This can be d
by hand or mechanically.

Ribbon-cut pasta

Ribbon-cut pasta

Long pasta

Ribbon-cut pasta

Ribbon-cut pasta

|
sln
|
SIO
I
8|0
|
sla
|
BIﬂ

Repeater Definitions affect every repeating line of printed reports.
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3.3.10.5. Adding headers and footers

Make multiple headers or footers to add more information to your reports. You can configure your headers
and footers to repeat on the first, last, or every page of your reports.

To add headers or footers:

1. Open Report Properties (right click > Properties or press F4).

2. Go to Structure and click Add Header or Add Footer. Your new element appears in your Structure.

(Ssllel Position  General

Table:
{none) =
Structure
== Add Header == Add Footer

D Header

D Header_1

E Repeater Definition

| D Footer
X
A

Footer settings

Marne: e

Footer
Repeat

Pages in between

First page

Last page
Repeat

|:| Pin Section to Bottom

Height: 2475 mm >

Close Apply

1. Add headers and footers to Structure.

2. Name your headers and footers. Naming your headers and footers make them easy to organize in
your Objects panel.

3. Choose repeat options to control where headers and footers appear in your reports.
4. Set header and footer height.

+ Pin Section to Bottom (Footers only). Enable to always have your footer appear at the bottom
of pages where it repeats. Useful for footers that contain text objects like signatures.
For example, if your repeating data ends in the middle of your last page, you can pin your
signature footer to the bottom of your last page and leave the remaining half page blank.
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Unchecked, your signature footer prints immediately after your repeating data ends on your
page.

3.3.10.6. Adding dynamic objects to headers and footers

You can add objects containing dynamic data (like variables and functions) to your report headers and
footers. Variables and repeaters in headers, footers, or outside your Report objects iterate once per label/
page. Your Repeater Definition iterates once per row.

To add dynamic data from databases to headers and footers, you cannot use the same database table you
use in your Repeater Definition. Create a new database table (or new database connection) for your header
and footer objects and make sure you enable Use the same record for entire print job in your second
database table configuration.

For example, you can add an object showing your total report records from your second database table
(Custom SQL here):

Pasta - Number of recerds

Table Configuration
L

Table name: [ auery

Table alias: | Pasta - Number of recards

SOL | Fields | DataRetrieving | Data

Data selection at print time initialization
Show recard selection at print time

Number of copies per record

copcernert [ 112]7] patssource

Murnber of copies can be changed at print time
Advanced options

[ ] Collect recards
Use the same record for entire print job

1. Add a dynamic Text object to your footer showing your total number of report records.
2. Connect your Text object to a database.

3. Enable Use the same record for the entire print job to configure your database table. Required.
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3.3.10.7. Adding page numbers

(]

Text Text Richtet  Barcode  Picture

b b E
SO
Line Inverse N

Elipse

a Advanced properties...

17

1%
1 >
Preview 1,2.3,4567,8,910,1,12,13,14,
15,

)= Prompting
] Promptat print time

Adding page numbers with counters on reports.

A WARNING

Page numbering with counters only includes your current page. For example, Page 1.

You cannot include total page counts. For example, Page 1 of 5 is not supported.

Most reports use page numbers. To add page numbers to your reports:
1. Create a Text object with a Counter variable.

2. Place your Counter outside your report object on your design surface. Adding counters in headers
and footers disrupts your total page count.

3.4. Working with Objects

This section describes how to work with objects and blend them with the design of a label or form.

Object is a basic building block of any label or solution. Each object is dedicated to a specific type of
content. See the related topics for style and content related object properties.

These are the common actions for multiple object types:

+ Adding an object: adds an object to the design surface.

+ Adding an object with connected data source: click the down arrow next to the object button and
select an existing or new data source to make the newly added object instantly connected to a
dynamic data source.

+ Grouping: makes multiple object behave as a single object.
+ Rotating: changes the angle of a selected object.
+ Resizing: sets the size of an object.

+ Aligning: make the object positions.
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3.4.1. Adding Objects

There are multiple methods to add an object to a label or form. Use the most convenient one:

+ Click and Click: click the object in the object toolbox. Mouse cursor transforms. Click on the design
surface - the selected object appears where clicked.

+ Click and Drag: click the object in object toolbox. Mouse cursor transforms. Click on the design
surface and drag to define the size of the added object.

NOTE

Text object's size cannot be defined using this method - its size is defined dynamically.

- Drag and Drop: click the object in the object toolbox and drag it to the design surface. The selected
object appears where the mouse button is released.

+ Copy and Paste: graphical and textual content can be pasted directly to the design surface. The
following rules apply when copying items and pasting them directly to a label or a form:

+ Graphical content from clipboard is pasted as embedded Picture object.

+ Rich textual content originating from web pages or word processors is pasted as Rich text
object. When designing a form, rich text is pasted as Text object.

+ Single line text is pasted as Text object.

+ Multiple line text is pasted as Text box object.

3.4.2. Adding Objects with Connected Data Source

Designer allows you to add an object with the instantly connected dynamic data source (variable, function,
or database) to the design surface.

There are multiple methods to add an object to a label or form. Use the most convenient one:

+ Click the object button down arrow. This opens the dynamic data connection menu. Select from the
existing data sources or add a new one. The newly added object is instantly connected to it when
placed on the design surface.

RTF

-
o
4 @ Variabn - L

s
W

il + addnew e[ Click arrow to add
e 2 c°""t:\ object with data source
CurrentDate .

e P CurrentTime connection

Line | 4 f, Functions \
+ Add new function

4 = Databases

=+ Database wizard
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+ Click and drag from dynamic data explorer. if you click and drag the data source from Dynamic Data

explorer to the design surface, a Text object appears. This object's content source is the dragged data
source from the explorer.

Solution Manager Dynamic Data

Search..

4 [ Variables
=+ Add new variable

,a Counter g : k
T CurrentDate \“x Click and dl'ag to add

3] .
& CurrentTime ’ . .
4 £, Fanctions . object with data source

+ Add new function connection
4 =2 Databases L
4 Database wizard

3.4.3. Grouping

To make multiple objects on a label behave as a single object, add them to a group. To group objects:

+ Surround the objects you wish to group using a mouse. A rectangle appears marking the selected
objects. Right-click and select Group objects to create a group of objects.

+ Hold <Shift> key and click the objects you wish to group. This selects multiple objects - right-click
and select Group objects to create a group of objects.

a
&

Text Box

]

0 Properties F4

0 Copy
3 Cut
X Delete

B Lock
l Group objects

I'—‘I'D Arrange 4

& Align ’

3.4.4. Rotating

There are two ways to set the angle of an object:

+ Enter the angle manually in degrees or drag the slider. The object rotates around its anchoring point.
Rotation commands are accessible in two ways:
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+ Click Position in the Positioning group of the Design tab.
+ Go to Object properties > Position > Rotation angle.

+ Click and drag the ' icon next to the selected object. The T icon rotates the object around its central
point.

Anchoring point is the spot where an object is pinned to the design surface. Variable size objects increase
or decrease their size in the direction that is opposite to the chosen anchoring point.

3.4.5. Object Resizing

To instantly resize an object, do the following:

1. Select it on the design surface.
2. The selected object becomes framed with a rectangle.
3. Click and drag one of the object holders.

4. The object will resize along with the moving cursor.

Read the below sections to learn about the automatic object resizing option and resizing specifics.

NOTE

When working with internal printer elements (barcodes, shapes, fonts), object resizing
follows the printer driver-defined values.

3.4.5.1. Graphic Object resizing

Graphic resizing is applicable to the picture object on labels and forms.

3.4.5.2. Automatic Resizing with Form

|§ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

When placed on a form, two options for automatic object resizing become available. Horizontally resize
with form and Vertically resize with form: object size automatically adapts to the changing size of the
form.

+ Horizontally resize with form: object width adapts to the resized form.

+ Vertically resize with form: object height adapts to the resized form.

If both options are enabled, object width and height adapt to the resized form simultaneously.
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3.4.5.3. Table Column Resizing

@ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

Data initialization form object allows auto-sizing the table column width. Open the object properties dialog
and go to Settings tab.

Columns group sets the width of data initialization table and its Prompt, Value, and Formatted value
columns.

+ Auto-size: automatic column resizing.

+ Show fomatted value: visible Formatted value column.

3.5. Label Saving

Make sure your work is always saved during the label design process. To save a label, do the following:

1. Go to File tab (background).
2. Click Save As.
3. Click Browse to select the location at which the label file should be stored.

4. After the Save dialog opens, enter the label name. Label name becomes visible in the application
title bar.

3.5.1. Label Files vs. Solution Files

When working with Designer Express and NicelLabel Designer Pro product levels, the label is saved in .nibl
format. A single .nlbl file includes a single label or a batch of labels (available in NiceLabel Designer Pro).

When working with PowerForms, the label or form is saved as a .nsIn solution file. Such files may include
multiple labels (single documents or batches) and/or forms.

3.5.2. Label Storage

You can define the folders where files for labels, graphics, stocks, and databases are stored. Default
locations are set in File > Options > Folders. The exact location on the hard disk varies depending on your
Windows operating system, since not every version of Windows uses the same absolute paths.

Designer uses the selected folders as the default location to search for the files and to store them.

Any other folder is permitted to be used as a label storage folder. Click Browse to select one.
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4. Barcode

Designer supports a wide variety of 1D and 2D barcode types to be printed on labels. Each barcode type is
configurable according to specific standards.

TIP

When encoding the barcode content, make sure the used characters, length, and identifiers
comply with the barcode standard guidelines.

The following barcode types are available in Designer:

+ 1D and 2D Barcodes
+ GS1 DataBar Barcode Subtypes
In Designer, barcodes are added to a label using the barcode object. To properly encode the data and to set

the barcode object properties, read the sections below. Each of these sections describes barcode object
properties. To start editing them, double-click the object to open the Object Properties Window.

4.1. Barcode

Barcode Type defines the specific barcode type which should be used to encode the data.

TIP

Code128 barcode type is selected by default. For more details about the available barcode
types, see the section Barcode Types and Available Settings.

+ X dimension: width of the narrowest bar in the barcode.
+ Height: barcode's vertical dimension.

+ Ratio defines the ratio between the barcode's narrow and wide bar widths.

Each barcode type's range of permitted ratios is limited by the standard. Designer only allows you to
use valid ratios. By default, the ratio is set to 3. This means that the wide bar is 3 times the width of a
narrow bar.

NOTE

The available ratios depend on the selected X dimension. If you are changing the X
dimension, this also affects the selection of available ratios.
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+ Row height defines the height of a single data row in 2D barcodes. Row height is specified as a
multiple over the X dimension. For example, "3x" means that the row is 3 times the X dimension.

Actual properties based on the selected printer displays the X dimension as it would appear printed on a
label using the currently selected printer.

Color defines the color of the barcode.

4.2. Check Digit

Check digit is used by any scanning system to verify that the number scanned from a barcode is read
correctly.

TIP

Check digit is derived from the preceding barcode digits and is placed as the final digit of a
barcode.

Include check digit determines if the check digit is included in a barcode or not.

+ Auto-generate check digit: automatic check digit calculation.

NOTE

If the data already includes invalid check digit, Designer replaces it with a proper
value.

+ Verify the provided check digit: verification of the manually provided check digit. An error message
appears if the check digits are incorrect.

+ Display check digit in human readable: check digit included in the human readable barcode text.

4.3. Human Readable

Human Readable text displays readable barcode data content located below or above the barcode. Its role
is to provide backup in case the barcode is damaged or of poor quality.

NOTE

Human Readable tab is visible with supported barcode types.

* No human readable: barcode is rendered without human readable text.

« Above barcode: human readable text is located above the barcode.
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+ Below barcode: human readable text is located below the barcode.

Style group allows you to set custom properties for human-readable text.

NOTE

If you decide to customize human readable text, the barcode can no longer be used as an
internal printer element. It is sent to the printer and printed as a graphic element.

+ Custom Font: enables font and font size selection. Internal printer fonts cannot be used as custom
human readable font.

+ Auto font scaling: If enabled (default setting), human readable text grows or shrinks proportionally
along with the changing size of the barcode. To set a custom size for human readable text, disable
this option and select the appropriate font size.

+ Bold: makes human readable text appear bold.

+ Italic: makes human readable text appear italic.

Mask group sets the format of the input data before it is displayed on a label.

+ Content mask sets the format of the input data before it is displayed on a label.

« Mask character is a character used in the mask that is replaced with actual data on the printed label.

Example

A user needs to format a phone number to be more readable on the label. Data input is not formatted since
it is read from a database.

If the input value read from a database is:

+38642805090

and the content mask is:

the resulting output is:

(+386) 4280 - 5090

If the data contains the asterisk "*" character, change the Mask character. The character should have a
unique value that does not appear anywhere in the data.
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4.4. Bearer Bar

Bearer bar is a border that surrounds the barcode. Its purpose is to protect the barcode image and to
enhance reading reliability.

+ Fixed thickness: automatically defined bearer bar width.
+ Variable thickness: user-defined bearer bar width.
+ Thickness multiplier: bearer bar width factor.

+ Show vertical bar: vertical bearer bars displayed or hidden.

4.5. Details

Details differ according to the barcode standards. Define the options that are given with regard to the
currently selected barcode type. Details for 1D and 2D barcodes are described in dedicated sections:

« 1D barcode details

« 2D barcode details

4.6. Position

Position tab defines object positioning and its position-related behavior.
Position group defines the object's position.

« Xand Y: anchoring point coordinates.

Size group sets the object's dimensions:

+ Width and Height: horizontal and vertical object dimension.

+ Keep aspect ratio: simultaneous changing of object dimensions while scaling.

|§ NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

Rotation angle is the object angle according to the design surface.

@ TIP

There are multiple ways to set the object's angle: enter the angle manually, drag the slider
or click and drag the T icon on the selected object. Rotation angle and slider rotates the
object around its anchoring point. The ! icon rotates the object around its central point.
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Anchoring point is the spot where an object is pinned to design surface. Variable size objects increase or
decrease their size in the direction that is opposite to the chosen anchoring point.

Lock prevents the object from being moved during the design process.

4.7. Relative Position

Relative Position options define the position of an object when label size or positions of neighboring
objects are changing during the label design process.

- Enable horizontal relative position: activates horizontal relative positioning.

+ Relative to label border: the position of object is defined relative to the reference label border.
Define horizontal offset for the object with regard to this border.

+ Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define horizontal offset for the object with regard to this object.

+ Object: selects the reference object for horizontal relative positioning.

+ Border: neighboring object's reference border or label border (if there are no other objects on the
label) for horizontal relative positioning.

+ Offset: horizontal distance from label border or reference object's anchoring point.
+ Enable vertical relative position: activates vertical relative positioning.

+ Relative to label border: the position of object is defined relative to the reference label border.
Define vertical offset for the object with regard to this border.

+ Relative to another object: the position of object is defined relative to the border of a
neighboring object. Define vertical offset for the object with regard to this object.

+ Object: selects the reference object for vertical relative positioning.

+ Border: neighboring object's reference border or label border (if there are no other objects on the
label) for vertical relative positioning.

- Offset: vertical distance from label border or reference object's anchoring point.

NOTE

Object position changes if label size or position of the related object change.

When designing double-sided labels, you can also take objects on the opposite side of the label as
reference objects for relative positioning. In this case, objects on opposite sides move together if you
change their positions.
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|§ NOTE

Label sides of reference objects are clearly identified on the Object selection list with (Front
Side) and (Back Side).

|§ NOTE

If the measurement unit is changed in label properties, the value transforms automatically.

4.8. General

General tab identifies the object and sets its status.

Name sets a unique object ID. It is used for object referencing when defining functions, variables, scripts,
etc.

NOTE

Avoid using spaces or special characters in object names.

Description allows adding notes and annotations for an object. It provides help during the label design
process.

Status group defines object visibility on print preview and on printed labels.

+ Not printable: prevents the object from being printed. The object still remains visible on the print
preview and affects other objects in relative positioning. This option is useful when printing on
predesigned or stock-specific labels.

+ Visible: if the checkbox is not selected, the object neither appears on the print preview nor on the
printed label. The object is treated as if it does not exist.

+ Condition: makes an object enabled (editable) if the result of the given condition is "True". This setting
defines object visibility on form startup and when the connected variable's value changes.

TIP

Equals (=) and slashed equals (#) signs are allowed to be used in object visibility
condition. Click the Equal/Not equal button select the appropriate sign type.

Option Print Preview Printout Relative positioning
Not printable (selected) YES NO YES
Visible (cleared) NO NO NO

182



4.9. Available Barcodes and Their Settings

12345

encoding, ASCII character
set supported.

Barcode Example Info Available Settings
Anker Variation of Plessey Code. Basic Barcode
JUARIEIN | s erpomeorsa ™ | S
''''''''' systems prior to the advent
of EAN code. Human Readable
Details tab:
Include quiet zones
Space correction
Bookland Type of EAN barcode used Basic Barcode
exclusively for books. Settings
Human Readable
12345 Details tab:
Include quiet zones
Space correction
Codabar A self-checking and Basic Barcode
binary level linear barcode Settings
symbology with no check
sum digit appended. Widely Human Readable
used in libraries and Details tab:
package delivery systems.
Include quiet zones
Code93 43 characters allowed. Basic Barcode
supported by using
12345
combinations of 2 Human Readable
characters. Details tab:
Include quiet zones
Space correction
Code128 Double density data Basic Barcode

Settings

Human Readable

Details tab:
Include quiet zones

Space correction
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Barcode Example Info Available Settings
Code128-A ASCII characters 00 to Basic Barcode
95 (0-9, A-Z, and control Settings
12345 codes), special characters,
and FNC 1-4 supported. Human Readable
Details tab:
Include quiet zones
Space correction
Code128-B ASCII characters 32 to Basic Barcode
127 (0-9, A-Z, a-z), special Settings
12345 characters, and FNC 1-4
supported. Human Readable
Details tab:
Include quiet zones
Space correction
Code128C 00-99 (encodes each two Basic Barcode
digits with one code) and Settings
FNC1.
123456 Human Readable
Details tab:
Include quiet zones
Space correction
Code-32 Code-32 has to be Basic Barcode

1234567788

used all over Italy
for the encoding of
pharmaceutical products.

Settings

Human Readable

Details tab:
Include quiet zones
Inter character gap

Space correction
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Barcode

Example

Info

Available Settings

Code-39

2345*

*1

Fully alphanumeric barcode
for use with data-entry

systems.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Inter character gap

Space correction

Code-39 full
ASCII

*12345*

28 ASCII character

set including asterisks

supported.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Inter character gap

Space correction

Code-39 Tri
Optic

$12345$

Computer tape cartridge

marking.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Inter character gap

Space correction

185




Barcode

Example

Info

Available Settings

Dun-14

(01)12345678901231

)i

Numbering system for
shipping containers that
uses other barcode types.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Inter character gap

Space correction

Ean-13

1”23456

890128“

7

European Article Number,
used for global retail.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Descender bar

Include EAN white
space

Space correction

Ean-13 +2

45

4567

890128

23

1

Often used on newspapers
and magazines.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Descender bar

Include EAN white
space
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Barcode Example Info Available Settings
Ean-13+5 mlm m I‘"" Il" |““”5” For books in English Basic Barcode
2345651022514 language: the first digit Settings
of the EAN-5 is the
currency indicator. The four Check Digit
following digits represent Human Readable
the price multiplied by 100.
Details tab:
Include quiet zones
Descender bar
Include EAN white
space
LT
(01)12345678901231 Settin gs
Check Digit
Human Readable
Details tab:
Include quiet zones
Space correction
Ean-8 Small package marking Basic Barcode

- —

2

o I
h_
O —

© IE——

67

where an EAN-13 barcode
would be too large.

Settings
Check Digit

Human Readable

Details tab:
Include quiet zones
Descender bar

Include EAN white
space

Space correction
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Barcode

Example

Info

Available Settings

Ean-8 + 2

90

23475670

1 ||

Only used if the article is
too small for an EAN-13
code.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Descender bar

Include EAN white
space

Ean-8 + 5

89012

1234

5670

Only used if the article is
too small for an EAN-13
code.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Descender bar

Include EAN white
space

GS1-128

‘ (13)1

21212(15)121217

A variant of Code 128 -
it automatically inserts a
FNC1 character after the
initial character.

Basic Barcode
Settings

Human Readable

Details tab:
Include quiet zones

Space correction
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Barcode

Example

Info

Available Settings

Interleaved 2 of
5

12345670

Used on 135 film, for
ITF-14 barcodes, and on
packaging.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones

Space correction

ITF14

123 45678 90123 1

Higher level packaging.
GTIN included.

Basic Barcode
Settings

Check Digit
Human Readable

Bearer Bar

Details tab:

Space correction

ITF 16

12345 67890 12345 2

Higher level packaging.
GTIN included.

Basic Barcode
Settings

Check Digit
Human Readable

Bearer Bar

Details tab:

Space correction

MSI

123456789012

Used primarily for inventory
control, marking storage
containers and shelves in
warehouse environments.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones

Space correction

189




Barcode

Example

Info

Available Settings

SSCC Identification in logistics. Basic Barcode
The code includes an Settings
extension digit, a GS1
company prefix, a serial Human Readable
reference, and a check Details tab:
digit.
Include quiet zones
Space correction
Plessey One of the first barcode Basic Barcode
libraries and for shelf tags
in retail stores. Check Digit
Human Readable
Details tab:
Include quiet zones
Space correction
SSCC-18 Identification in logistics. Basic Barcode

(00)1234! 45675

1567890123

The code includes an
extension digit, a GS1
company prefix, a serial
reference, and a check
digit.

Settings
Check Digit

Human Readable

Details tab:
Include quiet zones

Space correction

Upc Case Code

(01)12345678901231

Used for cartons, cases,
or pallets that contain
products with UPC or

EAN product identification
number.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones

Space correction
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Barcode

Example

Info

Available Settings

Upc-A

1H|

23 78901||”2

456

Product identifying at retail
checkout. GTIN included.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones
Descender bar

Space correction

Upc-A+2

3 4

23456

1 |

78901||

2

Product identifying at retail
checkout. GTIN included.
Used with magazines and
periodicals.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones

Descender bar

Upc-A+5

23456

23456

75901||

1 2

Product identifying at retail
checkout. GTIN included.
Used for book pricing.

Basic Barcode
Settings

Check Digit

Human Readable

Details tab:
Include quiet zones

Descender bar
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Barcode Example Info Available Settings
Upc-E Product identifying at Basic Barcode
retail checkout. GTIN Settings
(compressed) included.
o"123456ls | Adapted for smaller Check Digit
k .
packages Human Readable
Details tab:
Include quiet zones
Descender bar
Space correction
Symbology
Upc-E + 2 67 Product identifying at Basic Barcode
H retail checkout. GTIN Settings
1234565 (compressed) included.
Adapted for smaller Check Digit
ackages.
P g Human Readable
Details tab:
Include quiet zones
Descender bar
UpcE+5 678090 Product identifying at Basic Barcode

2

4

12345

0 675

retail checkout. GTIN
(compressed) included.
Adapted for smaller
packages.

Settings
Check Digit

Human Readable

Details tab:
Include quiet zones

Descender bar

USPS Intelligent
Mail Barcode

Tracking and sorting of
letters and flat packages in
the United States.

USPS Intelligent Mail
Barcode Content

Details tab:

Include quiet zones
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4.9.1. 2D Barcodes

small packages.

Barcode Info Available Settings
Aztec High capacity, symbol Basic Barcode
size adjusts automatically Settings
dependlng on the amount Details tab:
of input data.
Code page
Data layer
Error correction level
Data Matrix High capacity, optimal for Basic Barcode

Settings
Details tab:

Format
Encoding
Code page
ECI encoding

DIN SPEC 91406

GS1 DataBar

Marking products that
cross POS applications.
GS1 identification (Als)
included.

Available settings change
according to the selected
GS1 DataBar type.

GS1 Datamatrix

Added GS1 Application
Identifiers and ASC MH10
Data Identifiers and
maintenance.

DIN SPEC 91406
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Barcode

Example

Info

Available Settings

GS1 QR Code EJ Added GS1 Application Basic Barcode
Identifiers and ASC MH10 Settings
Data Identifiers and Details tab:
maintenance.
Symbol version
Error correction level
Encoding
Code page
ECI encoding
DIN SPEC 91406
MaxiCode rrrrrrrrrersra | Used by UPS on shipping MaxiCode Content
AAAAARAARARY labels for world-wide . _
addressing and package Basic Barcode Settings
sortation.
H
Micro QR | Reduced size and capacity Basic Barcode
of a normal QR code. Settings
Optimal when the barcode Details tab:
size needs to be
minimized. Symbol version
Error correction level
Encoding
Code page
MicroPDF - Compact version of Basic Barcode
PDF-417. Settings
Details tab:
Code page

Compaction mode

Version
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Barcode

Example Info

Available Settings

by QR scanners and
smartphones. Adaptable
size to the amount of
encoded data.

PDF-417 ||||E@F§*E%l| ||| Commonly used in Basic Barcode
SRR, transport, inventory Settings
management, etc. The Details tab:
code is both self-checking
and bi-directionally Code page
decodable.
Compaction mode
Error correction level
Columns
Rows
Truncated
QR A matrix barcode readable Basic Barcode

Settings
Details tab:

Symbol version
Error correction level
Encoding

Code page

ECI encoding

DIN SPEC 91406

4.9.2. GS1 DataBar Subtypes

4.9.2.1. Linear Symbol Types

GS1 DataBar Subtype

Example

Info

Omnidirectional

encodable values.

Omnidirectional scanning, up to 20 trillion

Stacked

Illlllli_iiﬁw;l

Stacked truncated symbol for omnidirectional
scanning with reduced symbol length.
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GS1 DataBar Subtype

Example

Info

Stacked Omnidirectional

Full height symbol stacked in two rows
separated by a delimiter.

Truncated (I [HWIM W | Height reduced to 13 times the X dimension. For
handheld scanners.
Expanded Omnidirectional scanning, variable content

length.

Expanded Stacked

Omnidirectional scanning, variable content
length, reduced length due to stacking (2 to 11
rows). See section GS1 DataBar Properties.

Limited

Limited range of values. For handheld scanners.

4.9.2.2. Composite Symbol Types

GS1 DataBar Subtype

Example

Info

Omnidirectional

L

A linear symbology that supports
omnidirectional scanning of packages. It
encodes 14 digits of numerical data used to
identify GTIN for scanning in the supply chain.

LU

Stacked ||I|IH_=H|I|| Stacked truncated symbol for omnidirectional
| Il scanning with reduced symbol length.
Truncated IIWWlll Intended for very small items in healthcare, not
intended for POS scanners.
Expanded Omnidirectional scanning, variable content

length. Used for variable-measure food,
coupons.

Expanded Stacked

Omnidirectional scanning, variable content
length, reduced length due to stacking (2 to 11
rows). See section GS1 DataBar Properties
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GS1 DataBar Subtype

Example

Info

Limited mmw Limited range of values. For handheld scanners.
I I
EAN-8 A smaller and shortened version of the EAN
code.
EAN-13 EAN codes require 13 digits (12 if the check digit

is calculated automatically).

EAN.UCC 128 & CC-A

GS1-128 linear barcode linked to a 2D barcode
called CC-A.

EAN.UCC 128 & CC-C

GS1-128 linear barcode linked to a 2D barcode
called CC-C.

UPC-A

The linear component encodes the item'’s
primary identification. The adjacent 2D
Composite Component encodes supplementary
data, such as a batch number and expiration
date.

UPC-E

PC-E compresses a normal UPC-A code into

a six digit code by “suppressing” the number
system digit, trailing zeros in the manufacturers
code and leading zeros in the product number.

4.10. 1D Barcode Details

Details tab settings may vary depending on specific barcode standards.

= Properties - Barcode [Barcode]

Source

Barcode Check Digit

Position

General

Human Readable

Details
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TIP

Keep in mind the currently selected barcode type as you define the available barcode
settings.

Designer allows setting the following 1D barcode details:

+ Include quiet zones: blank space around the printed barcode. Quiet zone ensures the highest level of
scanning reliability.

NOTE

This option ensures optimum readability in case a neighboring object on a label is
located right next to the barcode.

« Inter character gap: the distance between the last bar of a character and the first bar of the next
character in a barcode.

+ Descender bars: makes the bars at the beginning, in the middle, and at the end of certain barcode
types (EAN and UPC) longer.

- Include EAN white space: inserts a special character (< or >) to indicate the EAN barcode width.
+ Space correction: adds white pixels to increase the gap width between the bars.

+ Pixel shaving: or Bar width reduction (BWR) reduces the number of pixels for each individual bar in
your barcode. Use Pixel shaving to adapt your bar width in case of press gain (ink spread) at print
time. Press gain can affect your barcode readability.

Pixel shaving doesn't change the overall width of your barcode.
USPS Intelligent Mail Barcode doesn't support pixel shaving.

+ Symbology:
+ Number system digit (UPC-E barcode):
+ 0 - the default number system encoding mode.
+ 1-supported when your barcode content begins with 7 instead of 0.

+ Use asterisk: adds a start and a stop character to your Code 39 Barcodes. When checked, Designer
inserts asterisks as a prefix and a suffix to your human-readable text.

4.11. 2D Barcode Details

2D barcodes enable multiple type-specific settings under the Details tab. When defining these settings
manually, the dropdown lists offer specific standard-compliant options.
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TIP

Designer defines the Details tab settings automatically if the user chooses not to manually
define them.

Code Page

Code page defines how the mapping of code characters with scanned characters is done. To display the
scanned data accurately, the correct code page must be selected. If none of the code pages is selected by
the user, Designer uses system character encoding.

Columns

Columns are basic vertical elements of a PDF 417 barcode. A maximum of 30 columns may be included in
a single PDF 417 symbol.

Compaction Mode

Compaction mode compacts a number of data characters into codewords. The decoding algorithm uses
the individual codewords to place them into a meaningful matrix.

+ Binary: all 256 ASCII values (up to 1100 bytes) are allowed.

+ Text: all printable ASCII characters 32-126 and ASCII 9, 10 and 13 (up to 1800 characters) are
allowed.

+ Numeric: encoding of numeric data (up to 2700 digits).

Data Layer

Data layer defines the number of data layers that encode data in an Aztec barcode. The number of data
layers correlates directly with the barcode data capacity. If the value exceeds the data capacity provided by
the selected Data layer, an error returns. One to four data layers are allowed.

Encoding

Encoding defines the character encoding scheme for the selected barcode.

@ NOTE

If you select the GS1 Datamatrix barcode, NiceLabel 10 automatically sets the encoding
scheme to ASCII. This makes sure the GS1 Datamatrix barcodes on your labels are GS1-
compliant.

199



Error Correction Level

Error correction level defines the symbol security level. It adds a series of error correction codewords to
the encoded data. These codewords enable the printed symbol to withstand damage without data loss. The
higher the security level, the greater the number of data layers required to contain the symbol — and hence,
its overall size. If none of the Error correction levels is selected, Designer defines it automatically.

Format
Format defines the symbol size and its capacity using the number of column and row elements.

If using Data Matrix barcode on your labels, DMRE (Data Matrix Rectangular Extension) allows you to use
multiple rectangular formats. These additional rectangular sizes increase the data encoding capacity of the
barcode.

NOTE

For printers without internal DMRE support, enable Always print as graphics under General
properties to print the Data Matrix barcode successfully.

Rows

Rows — PDF-417 barcode symbol is made of stacks of vertically aligned rows. Such barcode adapts its size
to the amount of the encoded data and may contain from 3 to 90 rows.

Symbol Version

Symbol version defines the symbol data capacity. As the amount of data increases, additional modules are
required to build a QR code. This makes the symbol larger on the printed label.

Truncated

Truncated reduces the PDF-417 barcode size by removing a single codeword and a stop bar from each
symbol row.

Version

Version defines the symbol size based on the number of columns. One-, two-, three-, and four-column
versions of Micro PDF417 barcode are available.
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Pixel shaving

Pixel shaving or Bar width reduction (BWR) reduces the number of pixels for each individual dot in your
barcode. Use Pixel shaving to adjust the graphics design file of your barcode to compensate for press gain
(ink spread) at print time. Press gain can affect your barcode readability.

Pixel shaving doesn't change the overall size of your barcode.

Maxicode doesn't support Pixel Shaving.

4.12. DIN SPEC 91406

Some products may contain multiple 2D barcodes with different data. To make sure your operators scan
the correct barcode (containing standardized product data), enable DIN SPEC 91406 in your barcode
Properties > Barcode > Details.

= Properties - Barcode [Barcode]

Source EEEGGLEN Position  General

Barcode Details

Symbol version: (automatic) A
Error correction level: | Q (25% recovery) =
Encoding: (automatic) A

932; Japanese (SHIFT-JIS) -

DIN SPEC 91406

DIN SPEC 91406 setting adds a quiet zone and border around QR and Data Matrix barcodes. This border
also contains a black triangle in the lower right corner. The border does not affect your barcode readout.
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|§ NOTE

For sufficient error correction use at least Q (25% recovery) in your Error correction level
settings.

= Properties - Barcode [Barcode]

Source WEENGLEN Position  General

Barcode Details

Symbol version: (automatic) b

Error correction level: | Qi (25% recovery) =

ncoding: Tautomatic] =

932; Japanese (SHIFT-JIS)
ECI Encoding
DIN SPEC 91406

4.13. GS1 DataBar Specifics

In addition to the common barcode properties, the specifics described below are available for GS1 DataBar.

4.13.1. GS1 DataBar Source

General group specifies how the databar content is going to be formatted before encoding.

+ Structured data sets the standard GS1 system data structure as a model for inserting the barcode
data. Use GS1 function to encode the data correctly (for more on GS1 and other functions, see topic
Functions). Composite GS1 barcodes represent structured data in the composite part of the code.

+ Unstructured data allows inserting the data without a model — only character type and number must
comply with the selected barcode type.

Data

+ Linear data is the part of the data that is encoded in the linear part of the barcode. The data is either
manually inserted or defined by a predefined Data source.

« Composite data is the part of the data that is encoded in the composite part of the barcode. This part
of data is always structured and follows one of the standard system data structures as defined by the
GS1. The data is either manually inserted or defined by a predefined Data source.

4.13.2. GS1 DataBar Properties

GS1 DataBar Expanded Stacked subtype encodes the data in the form of symbol segments sequence.
Symbol width is defined by the number of symbol segments in each stacked row. Symbol height is defined
by the number of stacked rows and their height.
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+ Segments per Row defines the number of segments for each row of a symbol. Up to 22 segments are
allowed per symbol.

4.14. ECI Encoding

Extended Channel Interpretation (ECI) encodes information about used code pages (e.g. UTF8,
Windows-1251) into your Data Matrix and QR barcodes so your scanner knows how to represent the data.
ECI encoding tells barcode readers which "code page" to use to correctly display your barcode content
automatically. Without ECI encoding, barcode scanners require manual configuration to display the content
correctly. Include ECI encoding you need on your labels, usually for non-western script languages (ex:
Arabic, Thai, or Chinese). You can see which code pages support ECI encoding here.

Example:

Without ECI encoding, you create a barcode with a Cyrillic Code page. To display the Cyrillic characters
correctly, an operator in another country who scans your barcode must manually set the correct code page
in his barcode scanner.

With ECI encoding, you create a barcode with a Cyrillic Code page. The operator can see correct Cyrillic
characters without manually configuring his barcode scanner.

NOTE

Some smartphone barcode scanning applications do not recognize ECI Encoding.

+ To enable ECI Encoding, go to Barcode Properties > Barcode > Details.

+ ECl encoding is based on the selected code page.
You can configure Numeric, Alphanumeric, or Binary ECI Encoding (depending on your setup).

= Properties - Barcode [Barcode]

Source QEENGLEN Position  General

Barcode Details

Symbol version: (automatic) A

Error correction level: | L (7% recovery)

Encoding: Numeric =

Code page: 1251; Cyrillic (Windows) =
ECI Encoding

Enabling ECI encoding in Barcode Properties.

With ECI encoding enabled, barcode scanners can automatically detect which code page is used on your
QR and Data Matrix barcodes.
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4.15. Maxicode Barcode Content

Symbology Definition defines the barcode mode of operation (data structuring type).
Designer supports the following modes:

+ Mode 2: US carriers with postal codes up to 9 digits in length.
+ Postal Code: US Zip Codes use a single field with 5 or 9 digits or two fields with 4 or 5 digits.

+ Mode 3: international carrier with alpha-numeric postal codes with up to 6 digits.

There are two additional options under Symbology Definition:

+ Structured data: automatically selected Mode 2 or Mode 3 modes based on the entered data.

+ Unstructured data: barcode mode of operation is set to Mode 4.

TIP

This mode encodes general data for purposes other than shipping industry (e.g.,
purchase order number, customer reference, invoice number).

Data Contents

Field Description

SHIP TO Postal Code Mandatory. 5 or 9 alphanumeric characters. Alpha characters
must be uppercase.

4 Digit Extension (enabled with Mandatory. 4 numeric digits defining micro location.

Postal code field: Two Fields (5

and 4 digits) type).

SHIP TO ISO Country Code Mandatory. 3 numeric digits.

(Mode 3 only)

Class of Service Mandatory. 3 numeric digits, a comma must be included to mark

the end of field.

Transportation Data Mandatory. The 5 characters, including the GS code.

Tracking number Mandatory. 10 or 11 alphanumeric characters. Alpha characters
must be upper case.

UPS SCAC Mandatory. 4 characters followed by the GS code.

Julian Day of Puckup Mandatory. 3 numeric digits.

Shipment ID Number Optional. 0-30 alphanumeric characters. Alpha characters must
be upper case. GS code must always be sent even if no data is
specified.
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Package in Shipment Mandatory. 1-3 numeric digits for package number. 1-3 numeric
digits for number of shipped items. Forward slash must separate
these two numbers.

Package in Weight Mandatory. 1-3 numeric digits.
Address Validation Mandatory. Single character “Y” or “N”. Upper case characters.
SHIP TO Address Optional. 0-35 alphanumeric characters. Alpha characters in upper

case. GS code must always be sent even if no data is specified.

SHIP TO City Mandatory. 1-20 alphanumeric characters. Alpha characters must
be upper case.

SHIP TO State Mandatory. 2 alpha characters. Both characters must be upper
case. RS code marks the end of this field and the end of the
secondary message data.

4.16. USPS Intelligent Mail Barcode Content

Data Contents group defines the input mode for the encoded data.
Input mode defines the structure of the encoded data.

+ Structured data: to ensure proper intelligent mail tracking, a string of numbers must be obtained. This
string is referred to as the DataToEncode. The DataToEncode consists of the Intelligent Mail Data
Fields.

+ Unstructured data: encoded data follows no predefined structure.

Intelligent Mail Data Fields group allows you to encode the barcode data in accordance with the standard.

Field Description
Barcode Identifier Specific two-digit identifier assigned by the Postal Service.
Service Type ldentifier Three-digit identifier defines the mail piece as full-service or basic

(Non-automation) and is also used to determine the disposition
of undeliverable-as-addressed (UAA) mail and the form of address
correction that a mailer desires.

Mailer Identifier Unique 6-or 9-digit number that identifies a business entity or
customer.
Serial Number A serial or sequence number which enables unique identification and

tracking. Depending on the specific barcode construct, this field can
vary in length from 5-10 digits.

Delivery Point ZIP Code Routes the mail to its final delivery point (length variations: none, 5, 9,
or 11 digits).
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5. Printing

When a label is ready to be printed, Designer helps you print it using a print dialog. It allows you to:
+ Preview the label during the design process.
+ Insert values for prompted variables.
« Filter and select which records should be printed.
+ Define printer settings.
+ Control print quantity.

+ Define additional quantity settings.

|§ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

The Designer print dialog serves as a customizable printing form. It consists of predefined form objects
that can be configured, moved, added or removed. More details on how to use the printing form are
available here.

To open the print dialog, click the Print button in the Action group of the Home tab ribbon or press Ctri+P.

Step-by-step printing procedure is described here.

TIP

NicelLabel 10 also allows you to print without opening the Designer application. If no label
editing is required, use NiceLabel Print to open and print label files directly.

5.1. Print Pane (Default Printing Form)

File (background) tab opens the default printing form. In Designer, it serves as the primary print dialog.
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Print button starts the printing procedure. It sends the print job to the selected printer.
Printer group of settings includes:
+ Print button: starts the print label action.

+ Printer selection combo box: lists the installed printers.

+ Printer settings combo boxes: define printing speed and darkness. The selectable values are provided
by the selected printer driver.

+ Speed: speed of printing. Available options are defined by the active printer driver.
+ Darkness: sets the intensity of printing. Available options are defined by the active printer driver.
+ Print to file checkbox: redirects the printing to a file.

+ Printer Settings button: opens properties printer driver dialog for the currently selected printer.

Quantity group of settings includes:
+ Print quantity object: defines the number of labels to be printed.
+ Number of labels: number of printed labels.

+ Number of pages: number of printed pages with labels.

|§ NOTE

Number of pages option becomes active if more than 1 label per page is set
under label properties > label dimensions.

+ Print all labels (unlimited): prints all labels as defined by the label design. More details about
this option are available here.

more... link opens the Additional Quantity Settings window.
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+ Number of labels skipped on first page: defines how many labels should be left unprinted on the first
page.

Example

A single page includes five labels. Number of labels skipped on first page is set to three. Two labels
are printed on the first page.

BAMPLE: Gonneation fo Assscs s

6
501

E\GOLI 250!3
Glll‘!ll | |||l|ﬂ|l ‘||

Label aurllr
BAMPLE: Gannsatian fo Assees

)

5

‘I'AGLIATELLE 2506
Lalul caunter
LB
+ ldentical copies per label: number of identical label copies to be printed.
Example

A single page includes five labels. Identical copies per label is set to three. There are three copies of
each label printed.
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+ Number of label sets: defines the number of print jobs to be sent to the printer.

Example

A set of printed labels contains three labels: A, B and C.
Number of labels:

Identical copies per label: 2

Number of label sets: 3.

Print result: [A, A; B, B; C, C] [A, A; B, B; C, C] [A, A; B, B; C, C]

Load... allows you to locate and load the predefined variable values for your printed labels. You can include
these predefined values in dedicated files with ".defaults" or ".values" extensions and store them on your
computer or an accessible network location.

The two supported formats for ".defaults" or ".values" are:
« XML:

<vari abl es>
<vari abl e name="varl'>variablel</vari abl e>
<vari abl e name="var2">variable2</vari abl e>
</vari abl es>

+ name-value:
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varl=variablel
var2=variable2

Data Initialization Variable keyboard input field (data entry table) allows inserting prompted variable values
at print time.

Print preview field displays the current label design and content.

5.2. Edit Printing Form

In Designer, the default printing form serves as the basic printing interface for stand-alone and solution
labels.

To start customizing the default printing form, go to Home tab > Action group and click Customize Print.
Available print customization options are described here.

Editing or adding a new printing form automatically creates a group of dedicated Printing form variables.
These variables are connected with the object on the selected printing form. All of these

Details about the printing form variables are available here.

The variables that define the content of default print form objects become visible and editable in the
Solution Explorer. Open the Dynamic Data Manager to manage these variables.

If you want to discard the printing form customization actions, click Recreate Printing Form. The default
printing form is recreated.

NOTE

Recreate Printing Form discards all editing actions on the default printing form.

5.3. Printing Procedure

PRODUCT LEVEL INFO

Solution building is available in PowerForms.

Use the following steps to successfully print a label using the Designer.
Step 1: Create
Create a new or edit an existing stand-alone label or label in a solution.

Step 2: Preview
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Label preview field is a part of the default Designer Print dialog. To make the print form appear on the
screen, go to Home tab > Action group and click Print or press <Ctrl+P>.

Label preview field displays the current label design. If you decide to customize the default print form or to
make a new one, make sure you add the Label Preview object to the form. The print form will offer label
preview only if the Label Preview object is present.

|§ PRODUCT LEVEL INFO

This segment is applicable to Designer Pro and PowerForms.

@ TIP

The default printing form is customizable. To adapt it and to create a custom print dialog,
go to Home tab > Action group and click Customize Printing Form. Read more about
printing form customization here.

Step 3: Select printer

Choose the preferred printer from the Printer tab dropdown menu. All currently available printers are listed.
More details on defining the printer are available here.

During this step, printing speed and darkness can be set as well. These two parameters depend on the
selected printer's driver.

Step 4: Set print quantity
Number of labels sets the number of printed labels.

Number of pages sets the number of printed pages. This option becomes active if the labels are positioned
across at least two pages.

Print all labels (unlimited) prints all labels as defined by the label design. More details about this option are
available in "Printing of Unlimited Data".

Click more... to open the Additional Quantity Settings dialog.

+ lIdentical copies per label defines the number of identical label copies in a print job.

+ Number of label sets defines how many times the entire label printing process should repeat.

Step 5. Start Printing

Click the Print button.
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5.4. Store/Recall Printing Mode

Store/Recall printing mode is a method for speeding up the printing process. It increases printer response
by reducing the amount of data that needs to be sent during repetitive printing tasks.

NOTE

Store option becomes visible in File tab if enabled in the label properties printer panel and
supported by the currently selected printer.

With store/recall mode activated, does not need to resend the complete label data for each printout.
Instead, default labels (templates) and internal printer elements (graphics, fonts) are stored in the printer
memory, and only sends recall commands which render the stored label content during the printing
process. Typically, a few bytes of data are sent to the printer as compared to a few kilobytes in the case of
normal printing.

The action consists of two processes:

+ Store label. During this process, creates a description of the label template formatted in the selected
printer's command language. When done, sends the created command file to the printer memory and
stores it.

+ Recall label. A label stored in the printer's memory is printed out immediately. Using the recall
process, creates another command file to instruct the printer which label from its memory should
be printed. The recall label command occupies a few bytes of data only. The actual amount of
data depends on the current situation. For fixed labels without any variable contents, the recall
command file only contains the recall label command. For variable labels that contain variable fields,
the command file includes the values for these variables and the recall label command.

NOTE

Before activating this mode, make sure the appropriate printer driver is selected for the
label printer. Not all label printers have the ability to use the store/recall printing mode.

Follow these steps to activate the Store/Recall printing mode:

1. Double-click the label design surface. Label Properties dialog appears.
2. To enable the mode, select Use store/recall printing mode on Printer tab. Click OK.

3. Define label template(s). All label objects with variable content must be formatted as internal
printer elements:

+ Text object content must only use internal printer fonts (not Truetype!).
+ Use internal printer barcodes in barcode objects.

+ If using variable objects with Truetype fonts, variable pictures or database fields, the default
values are sent to the printer during the label store process.
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4. Click File > Store. Make sure the Store variant points to the correct memory location in the printer.
Click File > Store. Make sure the Printer memory location points to the correct memory location in
the printer.

5. Insert or select values for variable objects that are not formatted as internal printer objects. These
variables will be given the same value on each label. They will behave as objects with fixed values.

6. Click Store to printer to create the command file with label template description and to send it to
the printer.

7. Insert values for prompted label variables. These variables are linked with internal printer objects on
the label. For this reason, their values can be changed during each printing.

8. Click Print to send variable values and recall label command to the selected label printer.

5.5. Optimize Printing Speed

There are many factors that affect the speed of label printing in Designer. Follow the guidelines below to
dramatically increase the speed of printing.

|§ NOTE

When implementing the following guidelines, ensure they are supported by the selected
printer.

+ If the selected printer supports parallel and serial port, use the parallel port. When the computer sends
the data to printer over parallel port, it is much faster than over serial port.

+ When designing a label, use internal printer fonts instead of Windows true-type fonts. True-type fonts
are sent to the printer as graphics. This vastly increases the size of data sent to printer (couple of
kilobytes). With internal printer fonts, only the text is sent to printer (couple of bytes).

+ Avoid using graphics on labels.

+ When using barcodes, ensure the barcodes are used as internal printer elements.

+ When using counters, the printer internally increments the numbers if the internal printer fonts are
used. This means, that the printer only needs to receive the first object number. The printer later
increments this number while printing additional labels. This option also reduces the amount of data
transferred between computer and printer.

TIP

With internal printer counter, the printing speed difference becomes noticeable with
high quantity of labels.

+ Set the printing speed to a higher value. Increasing the printing speed usually affects the quality of
printing. The higher the speed, the lower the quality. Find an acceptable compromise.
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+ Don't print excessive amount of data on labels. If the speed of printing is an important factor, consider
using preprinted labels, and only print the data, that changes with each label.

5.6. Printing from Databases

This section describes how to print the content of database records individually or in groups.

After completing the database wizard, by default, all database records are printed. Each record is printed

once per label.

If you do not want to print the entire database, select which records should be printed. Prior to printing, the
print dialog shows all database records. Use the data initialization field to select the records to be printed.
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If you would like to print several copies of a label with record data, define this using:

+ Additional Quantity Settings dialog: Use Identical copies per label to set the desired quantity for the
entire range of database records.

+ Increase or decrease the value in Copies field of the data initialization field to set the number of

printed labels per record individually.

+ Use Label copies per record step of database wizard to dynamically define the number of printed
labels per record.

You have a database containing records of your products. It contains a field with a numeric value. This
value stores the required number of label copies is stored. Select this field and let the application print the

quantity of labels as specified in this field.
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5.7. Changing Common Printer Settings

When designing a label, you also define which printer should be used for printing it. Each label file stores its
own printer settings for the selected printer driver.

Changes made in the printer settings dialog box are saved to the label and will be used in future print
actions.

NOTE

Ensure that Use custom printer settings saved in the label option are enabled in Label
properties > Printer. If not, default printer settings are going to be used.

Complete the following steps to change and save common printer settings for a label:
1. Open the label properties dialog.
2. Click Printer properties button on Printer tab. The dialog window with printer driver settings opens.
3. Open the Printer Options tab.

4. Adjust the Speed and Darkness settings.

Speed: 102 mm/s vi@
Darkness: 3 viE
N/A 4]

|§ NOTE

These settings depend on the selected printer.

5. Click OK.

6. Save the label.

NOTE
Any changes in the printer settings dialog box will be saved to the label and applied to
future print actions.

Changes in label printing speed and darkness can also be done at print time. These settings are only
valid while the file remains open. After reopening the file, the settings are reset to those defined in Printer

properties dialog.
Complete the following steps:

1. Open Print dialog.
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2. Click Print.

3. Adjust Speed and Darkness values under Printer group.

Printer
| - =]

Speed (inchfs): | 1 -

Darkness 1 -
Print to file

[ Printer Settings

4. Save the label.

NOTE

Changes to the settings in the Printer tab will not be saved in the label but used only at print
time.

5.8. Changing Dithering Options

NOTE

This option is applicable only if a NiceLabel printer driver is used for label printing.

Dithering is a process of converting color or gray scale pictures to black and white pictures that can be
printed on thermal printers. Thermal printers normally cannot print color images and can either print a dot
on the label or leave the area blank. There are no intermediate shades of gray.

During the dithering process, all colors and shades of gray in the picture are converted to black and white
dots, creating an illusion of new colors and shades by varying the pattern of dots. Different shades of gray
are produced by varying the patterns of black and white dots. There are no gray dots at all. In printing,
dithering is usually called half-toning, and shades of gray are called halftones.

To change the dithering settings, do the following:

1. Open label properties dialog.
2. Click Printer properties button on Printer tab. The dialog window with printer driver settings opens.

3. Open Graphic Options tab and use Photo slider to select the preferred dithering type.
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@ NOTE

These settings depend on the selected printer.

4. Change the dithering type option to suit your needs. Look at the preview on the right side how you
can expect the selected type to be applied on the label.

5. Click OK.

6. Save the label.

5.9. Double-sided Printing

Designer supports double-sided printing for office and thermal printers.

To enable double-sided printing, open Label properties dialog, and enable Double-sided printing option on

the Printing tab.

NOTE

The option is available only when the used selected printer driver supports double-sided

printing.

As soon as you enable this option, label sides become visible by clicking the tabs under the design surface.

L%

8 4
Front Side | Back Side
Label Design
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When printing to an office printer, these two pages are always printed one after another. They are sent to
the printer in the same order.

TIP

Make sure you enable duplex functionality in the printer driver settings.

When printing with a thermal printer, NiceLabel printer driver takes care of proper label processing and
printing. Use an appropriate NiceLabel printer driver to enable double-sided printing functionality.

5.10. Defining Unprintable Area

Unprintable area is the part of the label where the printer cannot print. Enabling the unprintable area option
in the printer driver allows you to virtually increase the label size.

Thermal printers can only print labels that are placed below the printhead. If you have wider labels and if
the printhead does not completely cover the label, the label part which juts out of the printhead cannot be
printed.

TIP

Unprintable area is usually the label area left and right of the printer head.

By setting an unprintable area, you inform the Designer that there is an unusually wide label inserted into
the printer. The software will draw vertical red lines identifying the unprintable area.

NOTE

Do not confuse the unprintable area with label margins! Unprintable area does not Shift the
label objects on the design surface.

To define the unprintable area:
1. Open the label properties dialog.
2. Click Printer properties button on Printer tab. The dialog window with printer driver settings opens.
3. Go to Printer options tab.

4. Enter the values for Unprintable Area.

Example

You have a printer with 10 cm (4") printer head and a 12 cm wide label. Insert the label centrally in the
printer, so it sticks out of the printhead evenly on both sides. Define a new label in the labeling software
with 12 cm width. By setting the unprintable area to 1 cm on the left and 1 cm on the right side, the labeling
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software knows that the actual label width is 10 cm. There will be two vertical red lines on the design
surface identifying the unprintable area.

°

TIP

Vertical red lines are also visible when you switch to another printer for the same label.
The original printer may have a wider printhead than the new printer. Maximum widths of
the labels are not the same for both printers. Designer will try to preserve the original label
dimension and automatically define the unprintable area for the new printer.
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6. Dynamic Data Sources

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

Dynamic data sources form an essential part of working with the Designer. They enable the use of label and
form objects that dynamically change their content with each printed label, if necessary.

Example

Typical dynamic content that are automatically updated are counters, serial numbers, date, time, weight,
and article images.

To display and print the dynamic object content properly, Designer uses the following dynamic data types:

+ Variables: display and store dynamic data source values which are defined at print time.

+ Functions: transform the dynamic data source values. Functions define the output format to adapt the
input—output conversion to specific requirements.

+ Databases: retrieve and display the database record.

+ Internal Variables: display the values that are automatically retrieved from a running application and
system environment.

+ Global Variables: a type of variable that can be shared among multiple labels.

TIP

Read about how to navigate and manage dynamic data sources in topic Dynamic Data
Manager.

6.1. Variables

Variables act as containers for storing and passing data between objects, scripts, external applications,
printers, and user inputs. Use variables to print labels where data changes on each label (e.g., counters,
serial numbers, date, time, weight, and product images).

To create labels with changing data, use Designer to easily format your labels using variable data.
Designer includes multiple types of variables:

+ Variable: changes value at print time or according to conditions you define.
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+ Current Date: displays current date as a variable value.
+ Current Time: displays current time as a variable value.

+ Counter: changes value incrementally or decrementally with each label you print.

fo @D & E
Uariables| Functions Internal  Global  Database
- - Variables~ variable Connections~

| Q"|‘ Variable Add

; Current Date | General m

| ®& Current Time

L)

d ' Counter About

TIP

Manage all your label and solution variables in Dynamic Data Explorer.

6.1.1. Variable

Variable (also known as prompt variable) is a type of variable that obtains its value at print time.

6.1.1.1. General
About group of settings identifies the variable and sets its definition.

+ Name: unique variable name. This name is used as the variable reference during its use.

S NOTE

Avoid using non-alphanumerical characters when defining the variable name.

@ TIP
Enter the name to make the variable easy to find when listed among other variables in
the Dynamic Data Explorer.

+ Description: is a field that allows adding additional information and suggestions.

Definition group of settings defines which input data types are valid for a variable.

« Data type defines what type of data is stored in a variable.
+ Text: variables that contain text.

« Date: variables that contain date values.
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+ Time: variables that contain time values.
+ Floating point: representation of real numbers in a variable.

+ Currency: variables that contain monetary values.
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+ Initial value: starting value that is assigned to a variable when created. It is defined using one of the
following methods:

+ Manually entering a fixed value. Characters from any group of allowed characters are permitted.

TIP

If you enter full stop (".") as the initial value for a variable with selected Date or
Time data type, it displays current date or time.

Example

Edit field on a form is connected to a variable with Date selected as Data type. If full stop is
selected as Initial value, the Edit field displays current date when the form is run. Drop down
button opens Date picker with preselected current date.

Form - oEMT Y

8/11/2017
Friday, August 11, 2017
August 2017
Su Mo Tu We Th Fr Sa
1 2 3 4 5
6 7 8 9 10 11 12
13 14 15 16 17 18 19
20 21 22 23 24 25 26
27 28 29 30 31

Clear
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+ Using a dynamic value. Dynamic data sources from the toolbar are supported — two options are
available:

* Enter the source as Name in square brackets, e.g. [CurrentDate], [Counter].
+ Enter the source as Name in square brackets.
+ Select the dynamic data source from the dropdown list.

+ Using a special character:

+ Special character can be entered manually using the less than/greater than signs, e.g.
<CR>, <LF> ...

+ Special character can be selected from the dropdown list.

NOTE

Designer supports combined values as the initial value. Read more about combining
the values here.

Example
A combined initial value of a variable may contain a fixed value, a dynamic data source and special

characters. The order of inserted items can be set randomly. Three options:

1. aaal23[Variable]<CR>
2. <CR»aaal23[Variable]
3. [Variable]<CR>aaal23

TIP

Make sure the inserted initial value meets the criteria defined with Output Rules for
each data type.

Provisional value defines a custom placeholder variable value in an object while designing labels or forms.
In a label object, the provisional value is replaced by the real variable value at print time. In a form object,
the real variable value appears when the form is run.

+ Auto generated: generates the provisional value automatically. Disable this option to define and use a
custom provisional value.

TIP

By default, provisional value equals the initial value.

If the provisional value (auto generated or custom) is empty or uses an invalid format, it is generated based
on the selected variable Data type. Default formats of provisional values are listed below.
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+ Current date or time for Date data type

+ Current time for Time data type

9.999.999,99 for Floating point data type

9.999.999,99 € for Currency data type

|§ NOTE

If the variable Output rules change, the provisional value format adapts accordingly.

Prompting group of settings defines the print time behavior of a data source. Read more about prompting
here.

Dynamic value group defines how the last used dynamic value of a variable is handled.

A\ WARNING
If you use dynamic values and you store and print your labels in Control Center (in
Documents), the dynamic variables file (.dvv) must be checked out. If .dvv file is checked in,
an error will occur when printing, and labels will not print.

Instead of using dynamic values, use global variables or Save Variable Data / Load Variable
Data actions in your solutions.

+ Remember the last used value (dynamic value):Designer stores the last used value of a variable.
The last used value is stored in an external text file at the same location as the label or solution file.
Files that store the last used values have the same filename as the label or solution, followed by .dvv
extension.

|§ NOTE

When sharing labels with dynamic values, make sure not to share only label or
solution files (.nlbl or .nsln), but also files that store last used dynamic values (.dvv).

|§ NOTE

Label or solution must be saved before enabling this option.

224



Example

The last used value is useful when the continuation of numbering from the last printed label is required
(e.g., serial number). Counter's last value is stored and the numbering is continued from this point at the
next use.

6.1.1.2. Text

Text data type is used for variables that store textual content. As a result, only textual input is allowed as
the variable input data type.

Input Rules

Data group defines permitted data properties.

+ Allowed characters: definition of permitted variable input characters.

TIP

Groups of allowed characters for data input filtering are described in section Groups
of Allowable Characters.

+ Limit length: maximum length of variable value.

+ Fixed length: variable must contain the exact number of characters as defined in the Limit length.

Check range group allows you to enter the minimum and maximum permitted value of the variable. Setting
the limits is optional.

+ Minimum value: the lowest permitted variable value.

+ Maximum value: the highest permitted variable value.

NOTE

If enabled, minimum and maximum values must not be left empty.

Pick list group predefines a list of selectable input values for a variable. No other values can be used with
this variable if a pick list is defined.

Selection of pick list values for a label object is done on the printing form. The user selects one of the
available values and prints the label. If a pick list is used for a form object, it acts as an Edit Field object -
when the form is run, the user selects from the predefined values.

+ Enable pick list: enable this option to set a limited range of selectable values.

+ Pick list values: enter the selectable values. Separate individual values by placing them in lines.
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Output Rules
Prefix and Suffix are characters that are added to a variable value.

+ Prefix: text placed in front of the variable value.

+ Suffix: text placed behind the variable value.

Pad Character fills an empty character position until the maximum variable length for a variable is reached.
Pad character is enabled only if the Limit variable length in the Input rules tab is enabled.

+ Padding: defines the mode of padding.
+ Not used: does not use padding.
+ On left: adds pad characters on the left side of the data value.
+ Onright: adds pad characters on the right side of the data value.
+ Surrounding value: adds pad characters on both sides of the data value.

+ Character: character used for padding.

Example

Pad character is in most cases zero (0) added on the left side of the variable value. If the maximum variable
length is set to 5 characters and the value is 23, the padded result is 00023.

Multiline group divides text into multiple lines.

A WARNING

Avoid using this setting if possible. The recommended alternative for presenting multiline
text on a label or form is to use the Text Box object.

+ Number of lines: maximum number of lines for a variable value.
+ Line length: maximum number of characters in a single line.

+ Word wrap: divides the text into multiple lines at space character locations.

6.1.1.3. Date

Date data type stores date-related values in the selected variable. Date field displays the date value
using various date formats. The date value format can be either selected from the preloaded formats, or
customized to meet the specific local, regulatory, or industry-related requirements.

6.1.1.3.1. INPUT RULES

Input Formatting group defines the allowed date format and displays a preview.
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+ Input format: allowed date input format.

+ Sample value: displays the preview according to the selected input format.

NOTE

Designer supports a range of preloaded or customized date formats.

Check range group allows you to enter the minimum and maximum permitted value of the variable. Setting
the limits is optional.

+ Minimum value: the lowest permitted variable value.

+ Maximum value: the highest permitted variable value.

NOTE

If enabled, minimum and maximum values must not be left empty.

6.1.1.3.2. OUTPUT RULES
Output formatting sets the output date format.

+ Output format: format in which the date is displayed.

+ Output language: language selection and regional formatting for days and months.
Output Language becomes relevant when the dates that include months or dates are written in words.
In some cases, data calculations may be affected as well. For example, in the US, a new week begins
on Sunday whereas, in the EU and other countries, a new week begins on Monday.

+ Sample value: date preview according to the selected input format.

Prefix and Suffix group defines characters that are added to a variable value.

+ Prefix: text placed in front of the variable value.

« Suffix: text placed behind the variable value.

Multiline: divides your text into multiple lines.

A\ WARNING

Avoid using this setting if possible. The recommended alternative for presenting multiline
text on a label or form is to use the Text Box object.

« Number of lines: maximum number of lines for a variable value.

+ Line length: maximum number of characters in a single line.

227



+ Word wrap: divides the text into multiple lines at space character locations.

@ TIP

Input rules help the user when inserting the variable data. They act as a filter that defines
the type, length, and other input data properties.

Output rules set the final variable formatting — they define how the variable value is going to
be presented in an object.

6.1.1.4. Time

Time data type stores time values in a variable. Time field displays the date value using various time
formats. The time value format can be either selected from the preloaded formats, or customized to meet
the specific local, regulatory or industry related requirements.

6.1.1.4.1. INPUT RULES

Input Formatting defines the allowed time format and displays a preview.

+ Input format: allowed time input format.

+ Sample value: variable preview according to the selected input format.

NOTE

Designer supports a range of preloaded or customized time formats.

Check range group allows you to enter minimum and maximum permitted value of the variable. Setting the
limits is optional.

+ Minimum value: the lowest permitted variable value.

« Maximum value: the highest permitted variable value.

NOTE

If enabled, minimum and maximum values must not be left empty.

6.1.1.4.2. OUTPUT RULES
Output formatting defines the output time format.

+ Output format: format in which the time is displayed.

+ Sample value: time preview according to the selected input format.
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Prefix and Suffix group defines characters that are added to a variable value.

+ Prefix: text placed in front of the variable value.

« Suffix: text placed behind the variable value.

Multiline group divides text into multiple lines.

A WARNING

Avoid using this setting if possible. The recommended alternative for presenting multiline
text on a label or form is to use the Text Box object.

* Number of lines: maximum number of lines for a variable value.
+ Line length: maximum number of characters in a single line.

+ Word wrap: divides the text into multiple lines at space character locations.

@ TIP

Input rules help the user when inserting the variable data. They act as a filter that defines
the type, length, and other input data properties.

Output rules set the final variable formatting — they define how the variable value is going to
be presented in an object.

6.1.1.5. Floating Point

Floating Point data type specifies the representation settings for numeric values that are stored in a
variable. This Data type is used to set the digit grouping points (separators) according to the regional
specifics, and to place the decimal delimiters at the right places.

6.1.1.5.1. INPUT RULES
Input formatting specifies the allowed input number format.

+ Decimal delimiter: specifies the character that separates the integer part from the fractional part of a
number written in decimal form.

+ Decimal places: the number of decimal places to be included in the number.
+ Use 1000 separator: separator places the thousands into groups.

+ Separator: a character that is used as thousands separator.
+ Sample value: displays a preview of the current number input format.

+ Limit variable length: enables limiting the number of digits to be defined for a variable.
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+ Length (characters): allowed number digits in a variable.

Check range defines the minimum and maximum number values. Defining the minimum and maximum
limits is optional:

« Minimum value: the lowest allowed input number.

NOTE

If already defined, the initial value is taken as the minimum value.

« Maximum value: defines the highest allowed input number.

6.1.1.5.2. OUTPUT RULES
Output formatting group specifies the preferred output number format.

+ Decimal delimiter: the character that separates the integer part from the fractional part of a number
written in decimal form.

+ Decimal places: the number of decimal places to be included in the number.
+ Auto: decimal places are defined by local system settings.

+ Use 1000 separator: enabled use of a separator that places the thousands into groups.
« Separator: a character that is used as thousands separator.

« Sample value displays a preview of the current output format.

@ TIP

Input rules help the user when inserting the variable data. They act as a filter that defines
the type, length, and other input data properties.

Output rules set the final variable formatting — they define how the variable value is going to
be presented in an object.

6.1.1.6. Currency

Currency data type is used for variables that store numerical values of monetary amounts. Define
currencies for various regions and set their properties.

6.1.1.6.7. INITIAL VALUE DEFINITION
Initial value for Currency Data type is defined using one of the following methods:

+ Manually entered fixed value. The number is delimited according to the Input formatting settings.
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+ Use of a dynamic value. Dynamic data sources from the toolbar are supported — two options are
available:

+ The source is entered Name in square brackets, e.g. [Variable_1].
+ Dynamic data source selection from the dropdown list.
+ Use of a special character:

+ Special character can be entered manually using the less than/greater than signs, e.g. <CR>,
<LF> ...

+ Special character can be selected from the dropdown list.

NOTE

Designer supports combined values as the initial value. Read more about combining the
values here.

Example

A combined initial value of a variable may contain a fixed value, a dynamic data source and special
characters. The order of inserted items can be set randomly. Three options:

1. aaal23[Variable]<CrR>
2. <CR»aaal23[Variable]
3. [Variable]<CR>aaal23

6.1.1.6.2. INPUT RULES

+ Input formatting group specifies the allowed input currency format.

+ Decimal delimiter is the character that separates the integer part from the fractional part of value
written in decimal form.

+ Decimal places is the number of decimal places that is allowed to be included in the value.
« Use 1000 separator enables using a separator that places the thousands into groups.
+ Separator: character that is used as 1000 separator.
+ Currency symbol is a graphic symbol that represents a currency.
+ Placement: position of the currency symbol.
+ Sample value displays a preview of the currency input format.
+ Limit length enables limiting the number of digits to be defined in a variable.

+ Length (characters): allowed number of digits in a variable.
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Check range defines the minimum and maximum values expressed in currency. Defining the minimum and
maximum limits is optional.

+ Minimum value: the lowest allowed input currency value.

NOTE

If already defined, the initial value is taken as the minimum value.

+ Maximum value: the highest allowed input currency value.

6.1.1.6.3. OUTPUT RULES
Output formatting specifies the preferred output currency format.

+ Decimal delimiter: character that separates the integer part from the fractional part of a value written
in decimal form.

+ Decimal places: number of decimal places to be included in the value.
+ Use 1000 separator: separator that places the thousands into groups.
« Separator: character that is used as 1000 separator.
+ Currency symbol is a graphic symbol that represents a currency.
+ Placement defines the currency symbol's position. Select it from the dropdown list.

- Sample value displays a preview of the currency input format.

@ TIP

Input rules help the user when inserting the variable data. They act as a filter that defines
the type, length, and other input data properties.

Output rules set the final variable formatting — they define how the variable value is going to
be presented in an object.

6.1.2. Current Date

Current Date is a type of variable that displays the current date value. The value is obtained from the
system or printer clock.

6.1.2.1. General Tab

About group identifies the variable and defines date output format and language.

« Name: unique variable name.
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+ Description: is a field that allows adding additional information and suggestions.

Definition group sets output formatting and displays its preview.

+ Output format: format in which the date is displayed. Available date formats are listed here.

|§ NOTE

The selected clock source option (see below) defines the range of allowed date
Formats. Printer clock option only allows the use of printer supported date formats.
An error returns if a non-valid format is used. Computer (system) clock option allows
a range of preloaded or customized date formats.

+ Output language: language selection and regional formatting for days and months.

Example

Output Language becomes relevant when the dates that include months or dates are written in words. In
some cases, data calculations may be affected as well. For example, in US, a new week begins on Sunday
whereas in EU a new week begins on Monday.

+ Output preview: displays the printed current date. The range of used characters adapts to the
selected Output language and printer.

Date offset group enables adding a certain number of days, months or years to the current date. The offset
date is displayed in the object instead of the present date.

+ Days: date offset in days.
+ Months: date offset in months.

+ Years: date offset in years.

TIP

To set negative date offset, use the Date Offset function.

Printer Clock group defines which clock should be used as the date value source.

+ Always use computer clock: computer (system) clock set as the exclusive Current Date value source.

+ Always use printer clock: printer clock set as the exclusive Current Date value source. An error is
returned if the printer clock is unavailable.

+ Use printer clock if supported: printer clock set as the preferred Current Date value source. If the
printer clock is not supported, the computer (system) clock value is used instead.
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6.1.2.2. Output Rules

Prefix and Suffix values may be added to a variable value if required.

+ Prefix: text placed in front of the variable value.

+ Suffix: text placed behind the variable value.

6.1.2.3. Date Formats

Designer enables flexible use of date fields. When defining the formats, the following notations are used:

Notation
d
dd

M
MM

yy or yyyy
ddd

dddd
MMM
MMMM
J

JJJ

Ww

Custom text

Description
The number of the day in a month. Occupies one or two characters.

The number of the day in a month. Always occupies two characters — leading
zeros are added if necessary.

M is the number of month. Occupies one or two characters.

MM is the number of month. Always occupies two characters.

The year represented with 2 or 4 digit numbers.

The abbreviated name of the day of the week.

The full name of the day of the week.

The abbreviated name of the month.

The full name of the month.

The number of days since January 1. Occupies from one to three characters.
The number of days since January 1. Always occupies three characters.
The week number in current year. Occupies one or two characters.

The week number in current year. Always occupies two characters.

The weekday number. The value range takes 1-7 characters, where 1 represents
Monday and 7 represents Sunday.

Any sequence of characters is displayed unchanged. Insert dots, commas, and
other characters to present the date as required.

6.1.2.3.1. DATE FORMAT EXAMPLES

Format

d.M.yyyy

dd/MM/yy

dddd, d. MMMM yyyy
JIIWWyyyy
textd/M/yyyytext

Printed Date (English)
10.3.2016

10/03/16

Thursday, 10.March 2016
069102005
text10/3/2016text
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6.1.3. Current Time

Current Time is a type of variable that displays the current time value. The value is obtained from system or
printer clock.

6.1.3.1. General Tab
About group of settings identifies the variable and defines time output format and language.

+ Name: unique variable name. This name is used as a variable reference during its use.

+ Description: is a field that allows adding additional information and suggestions.

Definition group sets output formatting and displays its preview.

+ Output format: format in which the time is displayed. Available time formats are listed here.

|§ NOTE

The selected clock source option defines the range of supported time Formats.
Printer clock option only allows the use of printer supported time formats. An error
returns if a non-valid format is used. Computer (system) clock option allows a range
of preloaded and customized time formats.

+ Output preview displays the printed current time format.

Time offset enables adding or subtracting a certain number of seconds, minutes or hours from the current
time.

+ Seconds: time offset in seconds.
+ Minutes: time offset in minutes.

* Hours: time offset in hours.

Printer Clock group defines which clock should be used as the time value source.

+ Use printer clock if supported: printer clock set as the preferred current time value source. If the
printer clock is not supported, the system clock value is used instead.

+ Always use printer clock: printer clock set as the exclusive Current Time value source. An errorreturns
if the printer clock is unavailable.

+ Always use computer clock computer (system) clock set as the exclusive Current Time value source.

6.1.3.2. Output Rules
Prefix and Suffix values may be added to a variable value if required.

+ Prefix: text placed in front of the variable value.
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+ Suffix: text placed behind the variable value.

6.1.3.3. Time Formats

Designer enables flexible use of time fields. Select a predefined time format or create a customized one.
When defining the formats, the following notations are used.

Notation Description
h Hours in 12-hour format. AM/PM is added, if selected. Occupies one or two characters.

hh Hours in 12-hour format. AM/PM is added if selected. Always occupies two characters.
Leading zeros are added, if necessary.

H Hours in 24-hour format. Occupies one or two characters.
HH Hours in 24-hour format. Always occupies two characters.
mm Used for minutes.
sS Used for seconds.

6.1.3.3.1. TIME FORMAT EXAMPLES

Format Printed Date
h:mm {AM/PM} 8:25PM
H:mm 20:25
hh:mm:ss 08:25:36

6.1.4. Counter

Counter is a type of variable whose value increments or decrements along with the changing value of
system or printer counter.

Thermal printers are usually equipped with an internal incremental counter. This is a dedicated counter that
counts the printed labels internally. The printer only receives the first value and automatically increases

or decreases it on the subsequent labels. This option reduces the amount of data transferred between
your computer and printer as only initial value is sent to the printer. Internal counter speeds up the label
production significantly.

6.1.4.1. General Tab

About group of settings identifies the variable and defines serialization details.

+ Name: unique variable name. This name is used as variable reference.

+ Description: is a field that allows adding additional information and suggestions.

Definition group of settings defines the counter behavior.
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+ Counter type: counter value increasing or decreasing.
+ Incremental: value increases along with the printed labels.
+ Decremental: variable value decreases along with the printed labels.
« Step: amount of units that represent the next state of counter value.
+ Repetition: number of repetitions for each counter value.
+ Initial value: value that is used when the counter starts.

+ Preview: displays the counter value sequence.

Example

Counter Step = 3, Repetition = 3 and Initial value =1 are: 1,1,1,4,4,4,7,7,7,10,10,10,13,13,13, ...

Prompting group of settings defines the print time behavior of a data source. Read more about prompting
here.

Dynamic value group defines how the last used dynamic value of a variable is handled.

A WARNING

If you use dynamic values and you store and print your labels in Control Center (in
Documents), the dynamic variables file (.dvv) must be checked out. If .dvv file is checked in,
an error will occur when printing, and labels will not print.

Instead of using dynamic values, use global variables or Save Variable Data / Load Variable
Data actions in your solutions.

+ Remember the last used value (dynamic value):Designer stores the last used value of a variable.
The last used value is stored in an external text file at the same location as the label or solution file.
Files that store the last used values have the same filename as the label or solution, followed by .dvv
extension.

|§ NOTE

When sharing labels with dynamic values, make sure not to share only label or
solution files (.nlbl or .nsln), but also files that store last used dynamic values (.dvv).

|§ NOTE

Label or solution must be saved before enabling this option.
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Example

The last used value is useful when the continuation of numbering from the last printed label is required
(e.g., serial number). Counter's last value is stored and the numbering is continued from this point at the
next use.

Printer Counter defines which counter should be used as a counter variable value source.

+ Use printer counter if supported: printer counter is set as the counter of choice if supported by the
active printer. If the printer counter is not supported, system counter is used instead.

+ Always use printer counter: printer counter set as the exclusive counter value source. If the printer
counter value is not available, the default (system counter) value is used.

NOTE

An error is reported if the selected printer has no support for internal printer counter.
Printing cannot continue.

° AIways use computer counter: computer counter set as the only counter value source.

@ TIP

Input rules help the user when inserting the variable data. They act as a filter that defines
the type, length, and other input data properties.

Output rules set the final variable formatting — they define how the variable value is going to
be presented in an object.

To use internal printer counter, follow these rules:

+ The variable's maximum length is limited by the printer. The value should be included in the printer
user guide.

TIP

If the exact maximum variable length value is not available, NiceLabel recommends
making a few test prints for determining the value.

+ Set variable length to fixed.

+ Set variable format to numeric.

+ Text object that is linked to the variable must be formatted using an internal printer font.

+ Enable Always use printer counter option.

+ Ensure the Internal Element icon is visible next to the counter text.

238



+ Ensure an internal printer font is used for the counter text.

6.1.4.1.1. INPUT RULES
Data defines the counter input criteria.
+ Allowed characters: permitted characters for variable values. Groups of allowed characters for data

input filtering are described in section Groups of Allowed Characters.

Example

Non-numeric characters can also be used as counter values. Alphanumeric sets the sequence with
Step = 3 and Initial value =1as 1,4,7,A,D,G,J,M,B S,V,Y,b, e h, ...

+ Limit length: maximum length of a variable value.
* Length (characters): specifies the exact number of characters permitted.

+ Fixed length: variable must contain the exact number of characters as defined in the Limit variable
length.

Check range group defines minimum and maximum counter values.

* Minimum value: minimum counter value.

+ Maximum value: maximum counter value.

Rollover settings group defines the condition at which the counter automatically resets its value to default.

+ Using min/max: minimum and maximum counter values activates the rollover.
+ When the selected data source changes: data source value change activate the rollover.

+ When date or time changes: date or time value change activates the rollover.

NOTE

Date/time change is defined by computer clock.

6.1.4.1.2. OUTPUT RULES
Prefix and Suffix are characters that are added to a variable value.
+ Prefix: text placed in front of the variable value.

+ Suffix: text placed behind the variable value.

Pad Character fills an empty character position until the maximum variable length for a variable is reached.
Pad character is enabled only if the Limit variable length in the Input rules tab is enabled.
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+ Padding: defines the mode of padding.
+ Not used: does not use padding.
+ On left: adds pad characters on the left side of the data value.
+ Onright: adds pad characters on the right side of the data value.
+ Surrounding value: adds pad characters on both sides of the data value.

+ Character: character used for padding.

Example

Pad character is in most cases zero (0) added on the left side of the variable value. If the maximum variable
length is set to 5 characters and the value is 23, the padded result is 00023.

Multiline group divides text into multiple lines.

A WARNING

Avoid using this setting if possible. The recommended alternative for presenting multiline
text on a label or form is to use the Text Box object.

* Number of lines: maximum number of lines for a variable value.
+ Line length: maximum number of characters in a single line.

+ Word wrap: divides the text into multiple lines at space character locations.

6.1.5. Prompting

When designing labels with connected dynamic data sources, a value has to be assigned to them before
printing. Prompted variables have their values manually assigned at print time. The user is asked for the
value of every variable before each print job.

The values are entered manually. The order in which they are entered may be specified using the Prompt
order dialog.

Prompting group asks the user for manual data input - this is done after the print dialog opens.

+ Prompt at print time: enabled or disabled prompting form variable value.

NOTE

If a dynamic data source is included in the Initial value, prompting becomes disabled.

+ Prompt text: contains text that prompts the user for value input. This text serves as instruction on
what kind of values should be entered before printing.
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+ Value required: variable value status — mandatory or optional. If the prompt text is left empty if the
value is set as mandatory, printing cannot start. An error message appears.

6.1.6. Printing Form Variables

Printing form variables are automatically generated variables that store user-defined values of default
printing form objects when the printing form is run.

Printing form variables are added to a solution in two cases:

+ when adding a new printing form (go to Home tab > Customize Print > Add new form > Printing
form).

+ when editing a printing form (go to Home tab > Customize Print > Edit printing form).

Details about these two operations are described here.

These variables are listed among other connected data sources (named PrintingForm_[VariableName]).
They are all listed in the Dynamic data explorer and therefore become editable in Dynamic data manager.

Dynamic Data Manager

=+ Add new variable

[ PrintingForm_IdenticalCopies

 PrintingForm_LabelName
LabelSets

I PrintingForm_PrinterName

 PrintingForm_
 PrintingForm_PrintToFile
T PrintingForm_Quantity
 PrintingForm_SkippedLabels
. Functions

=+ Add new function
4 2 Databases

+ Database wizard

@ Internal Variables
4 & Global Variables
# Add new global variable
4D GlobalVariable
& GlobalVariable_1
&) Globalvariable_2

ke © K @ éD S szh S D
% Cut X & 9] = R Em = l% £ ) L1
o Variables Functions Internal Global  Database Excel Access SQL Text All Prompt ImportData Export
1 Copy X Delete Variables~ variable Connections = Server File Databases Order Sources  Variables
General Add Step-by-Step Database Wizard Variables  Import and Export
Search.. | G
4 @ Variables

Added printing form variables

NaFeEr

T TGentica I GpTeE

Description:

Definition
Data type: Text

Initial value:

;
Variable editing field

Auto generated
Prompting
[] Prompt at print time

[ value required
Dynamic value

[] Remember the last used value (dynamic value)

oK Cancel

All printing form variables belong to the prompted variable type. They can all be edited - renamed and
configured with customized data types, and Input/Output rules.

N

NOTE

To remain in line with best-practice recommendations, NiceLabel suggests you to avoid
editing the printing form variables. If you find editing necessary, double check that the
customized data type and Input/Output rules do not interfere with label printing.
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|§ NOTE

If an issue occurs while using a customized printing form, Recreate Printing Form option
allows you to restore the default printing form. All changes are discarded in this case.

What differs the printing form variables from "normal” user created variables is that they are:

+ reused by all other printing forms in a solution.

« after being deleted, they are recreated for any newly added printing form in a solution.

Designer printing form variables include the following:

+ PrintingForm_IdenticalCopies: stores the quantity of identical labels copies to be printed.

+ PrintingForm_LabelName: stores the name of the selected label. This variable tells the printing form
which label in the solution is printed.

+ PrintingForm_LabelSets: stores the quantity of print jobs to be sent to the printer.
+ PrintingForm_PrinterName: stores the name of the selected printer.

+ PrintingForm_PrintToFile: stores the name of the file to which the label is printed.
+ PrintingForm_Quantity: stores the quantity of printed labels.

+ PrintingForm_SkippedLabels: stores the quantity of skipped labels.

@ NOTE

Although the objects on the printing form can be connected to any type of user defined
data sources, NiceLabel recommends you to leave the objects connected to automatically
generated printing form variables.

6.2. Functions

The purpose of functions is to manipulate the data that is assigned to label objects. Functions process the
existing data source values and store the result in function-generated data sources.

Each function can be directly connected to an object and used as a part of another function.

TIP

All label or solution functions are listed in the Dynamic Data Explorer and Dynamic Data
Manager.

To add a new function to a label or solution file, click Add new function and select the appropriate function
from the list. As soon as you add a new function, a configuration dialog appears enabling you to edit
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the function according to your needs. Configuration options are described in dedicated sections for each
function type.

Dynamic Data Manager

NNV Vs B S Vs B s = %
x &) &0 = = !
Variables Functions Intermal Glebal  Database Step-by-Step Database =~ Prompt
- - Variables~ variable Connections~ Wizard ~ Order
General Add Variables
Search.
4 @ Variables

4 f, Functions
42D

5 In
4G J: Linear

+ Add new variable
t‘B’T Variable

+ Add new function

S Subset
Jf Concatenate
. Date Offset

+

+ J,; VBScript

fx VBScript Expression
f:‘ Python Script

S HIBC
S G51-123

S ANSIMH10.8.2 (ASC)
S Transfer Data Syntax for High Capacity ADC Med
J Read from File

Jfi: NDEF Message
< | mn | v

Function name: | Subset |

Cancel
Cancel

Designer includes the following function types:

Subset: extracts a specific part of data according to the user-specified rules.
Concatenate: merges two or more data source values into a single value.

Date Offset: offsets the present date.

Linear: transforms the current value using multiple types of linear functions.
VBScript: allows performing complex value transformations.

VBScript Expression: is a simplified version of VBScript function.

Python Script: allows performing complex value transformations.

HIBC: encodes the data in compliance with the health industry barcode standard.
GS1-128: encodes the data in compliance with the GS-128 barcode standard.

ANSI MH10.8.2: encodes the data in compliance with ANSI MH10.8.2-2006 standard.

Transfer Data Syntax for High Capacity ADC Media: enables the ADC users to use a single mapping
utility, regardless of which high-capacity ADC media is employed.

Read from file: function reads content from a specified file and displays it in an object.
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+ NDEF Message: function allows you to define a message encapsulation format for the exchange of
data information over an Near Field Communication (NFC) link.

6.2.1. Subset

Subset function extracts a specific part of data according to the user-specified rules.
About group identifies the function.

+ Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

Input data source defines the existing or newly added input data source (variable, function, or database
record). The final (output) value is extracted from the selected input data source value.

Definition group offers two methods for extracting the data from the input data source.
Fixed length extracts a fixed number of characters from the input data source.

+ Offset: number of characters to be skipped from the beginning of the value.

+ Length: length of extracted value.

Example:

Input value: ABCDE
Offset: 0
Length: 3

Subset value: ABC

Example:

Input value: ABCDE
Offset: 2
Length: 3

Subset value: CDE

Delimited is used when extracting the data, separated by the user-specified delimiter.

+ Delimiter: character (comma by default) that separates input value fields.

+ Text qualifier: character that encloses the values within the fields (quotation mark by default).
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TIP

If a text qualifier is used, the delimiter within the text qualifiers also belongs to the data
value. Text qualifier can be left empty.

+ Field number:the field number that is extracted from the input data source.

Example:

Input value: "A", "B", "C", "D"
Delimiter:,

Text qualifiers: "

Field number: 3

Subset value: C

6.2.2. Concatenate
Concatenate function merges two or more data source values into a single value.
About group identifies the function.

« Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

Input data source group defines the existing or newly added input data source (variable, function or
database record) or fixed text that will be used in the function.

Output Options group defines the output value format.

Delimiter is a character that is inserted between the concatenated values. The delimiting character can be
entered manually or selected from one of the additional options:

+ New Line (CR/LF): new line character.

+ Insert special character: special character is entered.

NOTE

Delimiter is an optional value. With no delimiter defined, the concatenated values are
merged without a delimiting space or character.

+ Ignore empty values: ignores empty data source values. These values are excluded from
concatenation.
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TIP

This option is useful if you want to avoid duplicated delimiters if empty values appear.

Example:

Data source value 1: A, B, C, D
Data source value 2: <empt>
Data source value 3: E, F, G
Delimiter: ,

Concatenated value with vs. without Ignore empty values: A, B,C,D,E,F Gvs.A,B,C,D,E, F G

|§ NOTE

Ignore empty values option is effective only after executing a print command. When storing
a label in store/recall printing mode or when exporting a label, the empty values are not
ignored. Delimiters appear duplicated.

6.2.3. Date Offset

Date Offset function defines the number of days, months and/or years to be added to or subtracted from
any specified date (might be the current date or any past/future date).

About group identifies the function.

+ Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

Input data source defines the input data source from which the data will be used in the function.

Offset is the number of days, months, or years to be added to or subtracted from the input data source.

Example:
Current date: March 8 2016
Offset: Days +1; Months +1; Years +1

Result: April 7 2017

Output formatting group defines the function’s output.
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+ Output format: defines the date format to be used in the connected object.

« Sample: current date in the selected Output format.

6.2.4. Linear

Linear function multiplies or divides an input data source value by a defined Multiplier. An optional value
(Addition) can also be added.

About group identifies the function.

« Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

Input data source defines the input data source from which the data will be used in the function.
Linear function parameters are:

+ Mode: linear function type.
+ a: function multiplier.

+ b: function addition.

Output formatting group defines the function output format.
Output format is the format of a modified value. more... opens additional formatting options:

+ Decimal separator: character that marks the border between integral and fractional parts of a decimal
numeral.

« Decimal places: number of places behind the decimal separator.
+ Use 1000 separator: thousands separated or non-separated by a delimiter.
+ Delimiter: character that separates the thousands from the rest of the numeral.

« Sample: preview of the formatted output value.

Example:

Input value: 123
a:2
b: 20

Output value: 2 * 123 + 20 = 266
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6.2.5. VBScript

VBScript function enables reading, writing, and manipulating the data that belongs to any of the connected
data sources.

About group identifies the function.

+ Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.
+ Function type: show which type of scripting is selected.

VBScript group allows defining the script.

+ Insert data source: inserts an existing or a newly created data source into the script.
+ Verify: validates the entered script syntax.

+ Script editor: opens the editor which makes scripting easier and more efficient.

|§ NOTE

The result of the script must be saved in the 'Result’. The value of 'Result' is inserted into the
name of the function. Such function is available as a dynamic data source for further use.

Example:

The variable NAME provides the first and last name of a person. VBScript function should break the names
apart and use only the first name as the result of the function.

NAME variable initial value: John Doe

Dim Spc
Spc = InStr(NAME, "™ ')
iT NAME <> """ then
Result = Mid(NAME, 1, Spc-1)
end if

Result of VBScript: John

NOTE

To verify if a date variable is empty, use the syntax:

Datevariable.Value == None
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6.2.6. VBScript Expression

VBScript Expression is a simplified online version of VBScript function. This Designer function allows you
to:

+ manipulate existing variables
+ extract sub-strings

« perform quick calculations

VBScript Expression reduces the need to write dedicated VBScripts. Instead of writing an entire script,
insert a single-line expression in the edit field that is validated at print time.

TIP

When compared to VBScript commands, a VBScript expression command does not require
the final value to be stored in Result.

About

« Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.
VBScript Expression

+ Insert data source: inserts an existing or a newly created data source into the expression.
« Verify: validation of the entered script syntax.

« Editor: field for script writing and editing.

6.2.6.1. Script Editor

NicelLabel 10 provides a script editor which makes your Python or VBScript scripting easier, error-free and
time efficient.
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The selection of scripting languages that should be used in Script editor differs between NicelLabel
Designer Pro and Automation Builder :

+ In Designer, double-click on the form design surface to open Form Properties > Additional Settings >
Form Scripting Language.

+ In Automation Builder, go to Configuration items > click Edit to open trigger properties > Settings >
Other > Scripting.

TIP

NicelLabel 10 uses .NET variant of Python named IronPython. It works as a fully compatible
implementation of Python scripting language which also supports .NET methods.

Editor Ribbon includes commonly used commands which are distributed over multiple functional groups.

+ Clipboard group offers Cut, Copy, Paste and Delete commands.

+ Undo Redo group allows undoing or repeating script editing actions.

+ File group allows loading and saving scripts in a file.
+ Load from file: loads a script from an external previously saved textual file.
+ Save to file: stores the currently edited script in a textual file.

+ Editing group allows finding and replacing strings in a script.
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+ Find: locates the entered string in the script.
+ Replace: replaces string in the script.
+ Insert group: Data Source command inserts existing or newly defined data sources into the script.

+ Script group: Validate script command validates of the entered script's syntax.

Available scripting elements contain all available script items which can be used when building a script.
Double-click the element or click the Insert button to insert the element at cursor position into the script.

Element description provides basic information about the inserted script element.

Error list includes the errors which are reported after the Validate script command is run.

6.2.7. Python Script

Python script function supports even the most complex data manipulations on a label or a form.

TIP

When compared with VBScript, it proves to be a more suitable option for 64-bit systems. It
is also proved to be a notably faster scripting alternative.

About group identifies the function.

« Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.
+ Function type: show which type of scripting is selected.

Python Script
+ Insert data source: inserts an existing or a newly created data source into the script.
+ Verify: validates the entered script syntax.

« Script editor: opens the editor which makes scripting easier and more efficient.

Example:

The variable NAME provides the first and last name of a person. Python Script function should break the
names apart and use only the first name as the result of the function.

NAME variable initial value: John Doe

name = NAME.Value
Spc = name.find(" °)
if name I= " and Spc != -1:
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Result.Value
else:
Result.Value

name[0:Spc]

name

Result of Python script: John

6.2.8. HIBC

HIBC is a barcode standard used specifically in the health industry, as directed by the HIBCC organization.
This standard supports composite bar codes and supports the use of multiple items such as item codes,
quantity, and a batch number in a single barcode.

TIP

Visit HIBCC website for more information about the standard.

About group identifies the function.

+ Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

Structure group selects standard version and one of the three available HIBC barcode Types:

+ Version: HIBC version selector. Labels which include legacy HIBC data encoding are opened using
version 2.5. If creating a new label, encoding works depending on the selected HIBC version — 2.5 or
2.6.

+ Type: data structure type selector.
+ Primary: mandatory fixed data structure which identifies the item and its supplier.

+ Secondary: optional data structure which is indicated using the "/" delimiter. It may have a
variable (yet predefined) structure to contain serial or batch numbers, quantity, and expiration
date.

+ Primary definition: mandatory element when defining the Secondary data structure. The
three Primary data fields of a HIBC function must be added to the Secondary data
structure. Primary definition selects the appropriate existing HIBC function.

+ Concatenated: merges the first two structure types into a single data structure.

Definition group defines the content of HIBC barcode fields:
Primary data structure fields:

+ Labeler ID code (LIC): field assigned and maintained by the HIBCC. The first character of this field is
always an alphabetic character. The LIC may identify a labeler to the point of separate subsidiaries
and divisions within a parent organization.
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+ Product or Catalog...: compressed product or catalog number.

+ Unit of Measure...: numeric representation of packaging level (0 to 9) with 0 being the lowest level or
“unit-of-use”.

Example:

A company might pack unit-of-use items in a box, boxes in a carton, and cartons in a case. One way of
labeling would be, unit-of-use = 0; Box = 1; Carton = 3; and Case = 5.

Secondary data structure fields:

+ Quantity: two- or five-digit field describing the number of units-of-use included in the package
identified by the bar code label.

- Date format: preferred date format to be used with a HIBC label. If no date should be included on a
label, select one of the formats that contain "No date".

+ Date: displays the present date.

+ Lot/Batch: field can be alphanumeric and may vary in length to up to a maximum of 18 characters. If
the field is not required, it should be left empty.

+ Serial number: field can be alphanumeric and may vary in length to up to a maximum of 18
characters. If the field is not required, it should be left empty.

* Production date: Data Identifier formatted as YYYYMMDD.

6.2.9. GS1-128

GS1-128 function encodes barcode data using the GS1-128 standard. The standard supports the encoding
of textual data, numbers, functions, and the entire set of 128 ASCII characters.

GS1-128 encodes the data and defines its meaning by defining a list of Application Identifiers (Al). These
identifiers define the content and length of the data they include.

Als include a data field that contains a fixed or variable number of characters.

TIP

For more information about GS-128 standard and encoding principles, visit the GS1
website.

The list of available Als is available here.

About
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« Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

Application Identifiers field displays the selected Als.

Edit Function Definition button opens a dialog for editing the identifiers. Function Definition dialog allows
the user to Add, Delete, Move, and edit the selected identifiers. There are four columns with identifier
properties:

+ ldentifier: column with identifier Al number and description.

+ Value: column with a manually or dynamically defined value as given by the selected Data source.

@ TIP

Value column makes sure the values are compliant with GS1-128 standard. The
values are automatically reformatted according to Al format and length.

Packaging date: 2017-03

| G51-128
| reformatted vale

(13)170301

+ Options: column with additional identifier options (if available).

Delimiter group defines the delimiting characters for separating the Als.

A single barcode may include multiple Als. These fields are separated using left and right Delimiter. By
default, the first two digits of Al are used. Custom delimiters may be defined by inserting alphanumeric
characters.

Additional function outputs group defines a subordinate function.

+ Create output function with unformatted contents creates a subordinate function that uses the
unformatted data encoded by the parent GS1-128 function.

+ Function name: the name of the newly created subordinate function.

6.2.10. ANSI MH10.8.2 (ASC)

ANSI MH10.8.2 (ASC) function encodes barcode data using the ANSI MH10.8.2-2006 standard. This
standard provides a range of MH 10/SC 8 data identifiers and GS1 application identifiers. It enables the
assignment of new data identifiers and defines the correlation or mapping of data identifiers to application
identifiers.
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TIP

For more information about ANSI MH10.8.2 (ASC) standard, visit the official website. ANSI
MH10.8.2 belongs to ISO/IEC 15418 standard, which is accessible here.

About group identifies the function.

« Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

Application Identifiers enable cross-industry standardized use of data identifiers. They are used with any
alphanumeric data carrier.

Edit Function Definition button opens the Function Definition dialog. It allows the user to Add, Delete,
Move, and edit the selected identifiers.

There are three columns with identifier properties:

+ Identifier: column with identifier ID.

+ Value: column with manually inserted value or an automatically defined value as given by the selected
Data source.

NOTE

Each Value column allows a limited number of characters to be entered. The limitation
(format) is defined by the standard and varies according to the selected identifier.

6.2.11. Transfer Data Syntax for High Capacity ADC Media

This function supports the international ISO/IEC FDIS 15434 standard for "Information technology -
Automatic identification and data capture techniques — Syntax for high-capacity ADC media".

The standard defines the manner in which data is transferred to high-capacity automatic data capture
(ADC) media from the supplier’s information system and the manner in which the data is transferred to the
recipient’s information system.

The standard uses high-capacity technologies, such as two-dimensional symbols, to encode multiple fields
of data. These fields are usually parsed by the recipient’s information system and mapped to specific data
fields in the recipient’s information system.

This function allows you to encode data in the label objects. You can combine several pieces of information
in a single message. Each part begins with a header, and is followed by the message. Each data field may
have a fixed manually entered value, or can be connected to a variable.
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|§ NOTE

Make sure the variable has the same data format as required by the data identifier. Data
identifiers usually have a strict format set by the standard.

About group identifies the function.

+ Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

+ Application Identifiers: cross-industry standardized set of data identifiers.

TIP

The purpose of identifiers is to provide a unique item identification. To manage the
identifiers, click Edit Function Definition.

Function Definition dialog allows the user to Add, Delete, and edit the selected identifiers.

+ Format Envelope: column defines the starting and ending positions for a data item in a given Format.
Each Format Envelope contains a Format Header, data and a Format Trailer.

Example:
+ Format envelope 02 represents Complete EDI message/transaction data.

+ Format envelope 06 represents data which is encoded using ASC MH 101 Data Identifiers.

+ Data Elements: column defines the identifier content. Insert the data to be encoded manually or
define a data source.

+ Format Header Data: defines two mandatory format header elements.

+ Version: organization that controls the data structure.

NOTE

Each identifier allows adding multiple elements.

* Release: release number of ADC media standard.
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6.2.12. Read from File

Read from file function reads content from a specified file. The file can be accessed locally or remotely via
the network connection.

About group identifies the function.

« Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

Read from file parameters group sets the file connection details.
File name sets the file connection.
Encoding specifies the encoding type for the sent data.

+ Auto: automatically defined encoding .

TIP

If needed, select the preferred encoding type from the dropdown list.

6.2.13. NDEF Message

NDEF Message function allows you to define a message encapsulation format for the exchange of data
information over a Near Field Communication (NFC) link. Such link is established between two NFC
devices, or between an NFC device and a tag.

TIP

NFC is a set of communication protocols that enable two devices to establish
communication by bringing them within 4 cm (2 in) of each other.

NDEF message encapsulates one or more application-defined records which appear in a variety of types
and sizes. These records are combined into a single message.

NOTE

Output of this function is in HEX format.

About group identifies the function.

+ Name: function ID, initially defined by the function type.

+ Description: function's purpose and role as defined by the user.

NDEF Message Structure group displays the NDEF records that are included in the message.
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Click Edit Function definition to open the NDEF Message dialog. This dialog allows the user to Add, Delete,
Move, and edit the NDEF records. There are two columns with record properties:

+ NDEF Record Type: identifies the record type. The listed standard record types are available in
Designer:

« Uri: contains a string of characters that identifies a web resource.
+ Text: contains textual content with information about text encoding and language code.

+ Smart Poster: includes multiple sub-records — URI, title, recommended actions, icon, size and
type.

NOTE

Smart Poster content is represented as a single record content, although
internally the structure is created as multiple (sub)records within a single record.

+ BlueTooth Handover Select: a set of records including various items — handover version, device
address string, complete local string, class of device, and service class.

+ Custom: record type which allows encoding the non-native NFC data.

@ TIP

Drag and drop the records in NDEF Message dialog to quickly change their
position.

@ TIP

Detailed descriptions of NDEF record types are available in NFC Forum technical
specifications.

+ Record Definition: settings as defined by the NDEF standard. Available options depend on the
selected record type.

Include capability container adds capability container to the encoded data. Capability container stores
control data for managing the NFC data in a tag or a device. It tells the NFC device that the received

data is an NFC message. In cases when NFC content needs to be encoded into a standard high frequency
(HF) RFID tag, enable the Include capability container option. This signalizes the reading device that NFC
content is stored in the tag. Certain NFC compliant tags already include a capability container in the tag
which means that there is no need for including it as a part of the generated content.

6.3. Databases

Databases can be used as a dynamic data source for label or form objects. To make the database content
accessible and retrievable from the selected object, the database connection must be properly established
and configured.
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The most time efficient and user friendly way of adding a database to your label or solution data sources is
to use the Step-by-Step Database Wizard.

Designer also allows the database connections to be established and configured manually. This way, the
entire range of connection settings becomes configurable. It is recommended that only experienced users
choose this option.

All label or solution databases are listed in the Dynamic Data Explorer.
Designer supports a wide selection of database types. The supported database types are listed here.
Read about how to connect to the supported database types here.

Read about other available object data sources and how to use the Dynamic Data Manager here.

PRODUCT LEVEL INFO

Creation of forms and use of form objects are available in PowerForms.

6.3.1. Supported Database Types

Designer supports multiple types of databases:

+ Microsoft Excel

+ Microsoft Access

+ Microsoft SQL Server
+ Text File databases

+ Oracle databases

+ MariaDB / MySQL

+ OLE databases

+ ODBC database

+ Google Sheets

+ Excel (Microsoft OneDrive)

NicelLabel recommends using standard database types such as Text, Excel, Access, SQL Server, and
MariaDB / MySQL. The use of standard database types is easier and more time efficient due to optimized
application performance and user interface. When working with a non-standard database type, use the OLE
and ODBC options.

Read about how to connect to the supported database types here.
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6.3.2. Database Connection Options

Designer offers two ways for connecting an object to a database. The diagram below shows the two
available options.

Database as data source
1 2 Available in Designer Pro
and PowerForms
Database wizard Manual connection
) Establish connection
Establish database
connection and configure
\ 4
Configure database
connection
Editing enabled in
Designer Proand
PowerForms
Data source added Data source added

1. Step-by-step Database Wizard offers a guided process for:
+ connecting a database to a label or form object
+ adding a database to the labeling solution's data sources

The process of establishing and configuring a wizard based database connection is described here.

PRODUCT LEVEL INFO

This segment is applicable to Designer Pro and PowerForms.

2. Manually established and configured database connection.

NOTE

This option is intended for advanced users. It allows detailed configuration and offers all of
the available database connection settings.

The process of establishing and configuring a database connection manually is described here.
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6.3.3. Step-by-Step Database Wizard

Database wizard is a guided process that allows the user to configure a connection to a database and to
select which tables and fields will be used.

Dynamic Data Manager
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o Variables Functions Intemnal Global  Database Excel Access SQL Text  All Edit Prompt | Import Data Export
h Copy X Delete - ~  Variables~ variable Connections~ Server File Databases Database | Order Sources  Variables
General Add Step-by-Step Database Wizard Variables | Import and Export
Search... About
4 @ Variables Mame: Subset
+ Add new variable Description:
®
T Variable 4
4 f, Functions Function type: Subset
o AdA naw functian

Edit Database allows you to edit all existing connected databases using a wizard.

The wizard additionally allows you to sort, filter records, and to define how many label copies will be printed
per database record.

6.3.3.1. Adding a Database

To add a database using the Database Wizard, click the preferred database button in Designer Data tab
ribbon > Step-by-step Database Wizard group.

There are three ways to start the Database Wizard:

+ Option 1: Click the preferred database button in Designer Data tab ribbon > Step-by-step Database
Wizard group.

Solution|

= h [i—
el S

Excel Access SQL  Text All
Server File Databases

Step-by-Step Database Wizard

+ Option 2: Click the preferred database button in Dynamic Data Manager > Step-by-Step Database
wizard ribbon group.

Dynamic Data Manager
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©
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+ Option 3: Click the +Database wizard command in Dynamic Data Explorer or object properties.
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Listed below are the available wizard options. To successfully add a database, follow the steps for each
database type:

+ Adding an Excel database

+ Adding an Access database

+ Adding an SQL Server database
+ Adding a Text File database

+ Adding an Oracle database

+ Adding a MySQL database

+ Adding other OLE database

+ Adding an ODBC data source

+ Adding Google Sheets database

+ Adding Excel (Microsoft OneDrive) database

6.3.3.2. Database Wizard for Excel Files

This section describes how to connect Excel database to an object using the Designer Step-by-Step
Database Wizard.

Step 1: Connection Settings

This step defines the database connection parameters.

S NOTE

The available parameters depend on the selected database type.

File name defines the database file location.

Advanced Setup opens the system configuration dialog. Data Link Properties window allows you to set the
connection properties. Data Link Properties is a Windows system dialog — read more about its properties
here.
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Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

Click Next.
Step 2: Tables and Fields

This step defines which database table and which fields of this table should be used as a dynamic data
source.

Tables group allows you to select which tables of the connected database should be used as a data source.

« Available tables: available tables in the selected database.

« Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

S NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Click Next.

Step 3: Label Copies Per Record

This step specifies the number of label copies to be printed for each database record.
Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.

Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.
Read more about how to define the number of printed copies here.
Step 4: Create Objects

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:
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+ Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.

+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.

TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.

Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

+ Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

- Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.

|§ NOTE

The number of added objects depends on the number of fields in the database.

Click Next.
Step 5: Data Preview and Other Table Settings

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Filter tab filters out the database file records. It allows you to define filtering conditions to be used when
retrieving the data.

+ Add condition: specifies single line condition(s) that filters out the content that meets the set criteria.
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- Add group: specifies group(s) of conditions that filter out the content that meets the set criteria.

Sorting tab allows you to sort the retrieved data. Sorting is done for all of the fields that are added to the
sorting list. Each field can be in ascending or descending order.

Data Retrieving tab defines how the data should be retrieved from the connected database file. Details on
data retrieving settings and options are available here.

SQL tab offers a preview of the generated SQL statements.
Read more details about database table configuration here.

Click Finish. The database is ready to be used as label or form object data source.

6.3.3.3. Database Wizard for Access Database

This section describes how to connect your Access database to an object using the Designer Step-by-Step
Database Wizard.

Step 1: Connection Settings

This step defines the Access database file connection details.

File name selects the database file.

Authentication requires User name and Password for password protected Access database files.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

Advanced Setup opens the system configuration dialog. Data Link Properties window allows you to set the
connection properties. Data Link Properties is a Windows system dialog — read more about its properties
here.

Click Next.
Step 2: Tables and Fields
Tables group allows you to select which tables of the connected database should be used as a data source.

« Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

|§ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Step 3: Label Copies Per Record
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This step specifies the number of label copies to be printed for each database record.
Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.

Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.
Read more about how to define the number of printed copies here.
Step 4: Create Objects

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:

+ Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.

+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.

TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.

Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

+ Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

- Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.
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|§ NOTE

The number of added objects depends on the number of fields in the database.

Click Next.
Step 5: Data Preview and Other Table Settings

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Filter tab filters out the database file records. It allows you to define filtering conditions to be used when
retrieving the data.

- Add condition: specifies single line condition(s) that filters out the content that meets the set criteria.

+ Add group: specifies group(s) of conditions that filter out the content that meets the set criteria.

Sorting tab allows you to sort the retrieved data. Sorting is done for all of the fields that are added to the
sorting list. Each field can be in ascending or descending order.

Data Retrieving tab defines how the data should be retrieved from the connected database file. Details on
data retrieving settings and options are available here.

SQL tab offers a preview of the generated SQL statements.
Read more details about database table configuration here.

Click Finish. The database is ready to be used as a label or form object data source.

6.3.3.4. Database Wizard for Microsoft SQL Server Database

|§ PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

This section describes how to connect a Microsoft SQL Server database to a form or label object using the
Designer Step-by-Step Database Wizard.

Step 1: Connection Settings
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This step defines the database file connection details.
Connection Information group defines which server hosts the database you are connecting to.

« Server selects the database server.

Authentication group defines the user authentication type for your database server.

+ Use Windows authentication. This option defines the Windows authentication as a verification
method for connecting to an SQL server. The user connects to a database using the domain user
name and password.

« Use SQL Server authentication. This option defines the database user name and password as the
verification method. To establish a connection, enter the user name and password provided by the
database administrator.

Show Connection String displays the current database connection string and allows it to be inserted or
modified.

A\ WARNING

Connection string editing is intended for advanced users only. To configure the database
connection, users are encouraged to use standard inputs in the dialog box.

Database Selection group selects the database on the connected server.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

Click Next to proceed.
Step 2: Tables and Fields
Tables group allows you to select which tables of the connected database should be used as a data source.

« Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

|§ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Step 3: Label Copies Per Record

This step specifies the number of label copies to be printed for each database record.
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Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.

Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.
Read more about how to define the number of printed copies here.
Step 4: Create Objects

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:

+ Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.

+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.

TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.

Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

+ Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

- Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.
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|§ NOTE

The number of added objects depends on the number of fields in the database.

Click Next.
Step 5: Data Preview and Other Table Settings

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Filter tab filters out the database file records. It allows you to define filtering conditions to be used when
retrieving the data.

+ Add condition: specifies single line condition(s) that filters out the content that meets the set criteria.

+ Add group: specifies group(s) of conditions that filter out the content that meets the set criteria.

Sorting tab allows you to sort the retrieved data. Sorting is done for all of the fields that are added to the
sorting list. Each field can be in ascending or descending order.

Data Retrieving tab defines how the data should be retrieved from the connected database file. Details on
data retrieving settings and options are available here.

SQL tab offers a preview of the generated SQL statements.
Read more details about database table configuration here.

Click Finish. The database is ready to be used as your label or form object data source.

6.3.3.5. Database Wizard for Text Files

This section describes how to use a text file as your data source in your label or form objects. A text file is
connected to an object using the Designer Step-by-Step Database Wizard.

Step 1: Text File Structure Wizard

Text File Structure Wizard window opens if a structure for a text file you are connecting hasn't been defined
previously.

The steps for completing the Text File Structure Wizard are described in a dedicated section.
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|§ NOTE

After finishing this procedure, a text definition .sch file with the same name as the text
database file and is created in the same folder. Next time the wizard is used on the same
file, this procedure is no longer required.

Step 2: Connection Settings
This step defines the text file path.

File name defines the location of the Text file to be used. Enter the location manually or click Browse to
locate it in the system.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

Click Next.
Step 3: Tables and Fields
Tables group allows you to select which tables of the connected database should be used as a data source.

« Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

|§ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

@ NOTE

Table selection is not available when adding a text file as a database. The entire text file is
treated as a single database table.

Step 4: Label Copies Per Record
This step specifies the number of label copies to be printed for each database record.
Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.
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Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.
Read more about how to define the number of printed copies here.
Step 5: Create Objects

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:

+ Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.

+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.

TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.

Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

+ Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

+ Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.

NOTE

The number of added objects depends on the number of fields in the database.
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Click Next.
Step 6: Data Preview and Other Table Settings

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Fields tab displays available and selected database fields. The settings configured in "Label Copies Per
Record" can be redone on this tab.

Data Retrieving tab defines how the data should be retrieved from the connected database file. Read more
about data retrieving here.

Click Finish. The database is ready to be used as your label or form object data source.

6.3.3.6. Database Wizard for Oracle Database

PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

This section describes how to add an Oracle database to a form or label object using the Designer
Step-by-Step Database Wizard.

Step 1: Connection Settings

This step defines the database connection details.

NOTE

Oracle Database Provider is required to establishing a connection with Oracle database.

Data Source defines the Oracle Data Source name.
Authentication provides a user name and password for establishing the connection.

Advanced Setup button opens the Data Link Properties window allowing the user to define the connection
properties. Data Link Properties is a Windows system dialog — read more about its properties here.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.
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Step 2: Tables and Fields
Tables group allows you to select which tables of the connected database should be used as a data source.

+ Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

|§ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Step 3: Label Copies Per Record
This step specifies the number of label copies to be printed for each database record.
Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.

Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.
Read more about how to define the number of printed copies here.
Step 4: Create Objects

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:

+ Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.

+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.

TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.
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Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

- Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

+ Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.

NOTE

The number of added objects depends on the number of fields in the database.

Click Next.
Step 5: Data Preview and Other Table Settings

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Filter tab filters out the database file records. It allows you to define filtering conditions to be used when
retrieving the data.

+ Add condition: specifies single line condition(s) that filters out the content that meets the set criteria.

+ Add group: specifies group(s) of conditions that filter out the content that meets the set criteria.

Sorting tab allows you to sort the retrieved data. Sorting is done for all of the fields that are added to the
sorting list. Each field can be in ascending or descending order.

Data Retrieving tab defines how the data should be retrieved from the connected database file. Details on
data retrieving settings and options are available here.

SQL tab offers a preview of the generated SQL statements.

Read more details about database table configuration here.
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Click Finish. The database is ready to be used as a label or form object data source.

6.3.3.7. Database Wizard for MariaDB / MySQL Database

|§ PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

This section describes how to add a MariaDB / MySQL database to a form or label object using the
Designer Step-by-Step Database Wizard.

0 IMPORTANT

Don't update your database connection for your label templates already connected to
MySQL. In this case, continue using the MySQL software. Your label templates work the
same as before.

Step 1: Connection Settings
This step defines the MariaDB / MySQL database connection details.

- Database: defines the exact database on a server.
* Host: defines the database address.
+ Port: defines the port of the database server.

+ Authentication: provides user name and password for establishing the connection.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

Step 2: Tables and Fields
Tables group allows you to select which tables of the connected database should be used as a data source.
+ Available tables: available tables in the selected database.

« Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

|§ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Step 3: Label Copies Per Record
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This step specifies the number of label copies to be printed for each database record.
Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.

Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.
Read more about how to define the number of printed copies here.
Step 4: Create Objects

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:

+ Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.

+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.

TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.

Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

+ Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

- Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.
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|§ NOTE

The number of added objects depends on the number of fields in the database.

Click Next.
Step 5: Data Preview and Other Table Settings

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Filter tab filters out the database file records. It allows you to define filtering conditions to be used when
retrieving the data.

+ Add condition: specifies single line condition(s) that filters out the content that meets the set criteria.

+ Add group: specifies group(s) of conditions that filter out the content that meets the set criteria.

Sorting tab allows you to sort the retrieved data. Sorting is done for all of the fields that are added to the
sorting list. Each field can be in ascending or descending order.

Data Retrieving tab defines how the data should be retrieved from the connected database file. Details on
data retrieving settings and options are available here.

SQL tab offers a preview of the generated SQL statements.
Read more details about database table configuration here.

Click Finish. The database is ready to be used as a label or form object data source.

6.3.3.8. Database Wizard for Adding Databases via OLE DB

@ PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

This section describes how to add various types of databases via OLE DB source to a form or label object
using the Designer Step-by-Step Database Wizard.

The OLE DB extracts data from a variety of OLE DB-compliant relational databases by using a database
table, a view, or an SQL command.
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Example:

OLE DB can extract data from tables in Microsoft Access or SQL Server databases.

Step 1: Connection Settings

This step defines the OLE DB connection details.

Provider defines the provider to be used for accessing the data by exposing the OLE DB interfaces.
Authentication provides the user name and password for establishing the connection.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

Authentication provides the user name and password that are used for the connection.
Advanced Configuration options are:

+ Automatically browse for tables automatically displays the available OLE database tables. If this
checkbox is cleared, you will have to enter the table name manually.

Advanced Setup button opens the Data Link Properties window allowing the user to define the connection
properties. Data Link Properties is a Windows system dialog — read more about its properties here.

@ NOTE

When connecting to a password protected database, make sure the Allow saving password
option is selected. If not, even after a successful Test Connection procedure, database
access is not going to be granted.

= Data Link Properties

Provider | Connection | Advanced | Al

Specify the following to connect to Access data:
1. Select or enter a database name:
Label Designer Express 6'Samples'database’\Pastaxds| ...

2. Enter information to log on to the database:

User name: | Admin

Password:

Blank password

Test Connection

e | e
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Test Connection button starts a connection testing procedure to confirm if a connection with your
database has been established successfully. A confirmation or error message appears.

Click Next.
Step 2: Tables and Fields
Tables group allows you to select which tables of the connected database should be used as a data source.

+ Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Step 3: Label Copies Per Record
This step specifies the number of label copies to be printed for each database record.
Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.

Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.
Read more about how to define the number of printed copies here.
Step 4: Create Objects

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:

« Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.
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+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.

TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.

Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

+ Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

- Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.

S NOTE

The number of added objects depends on the number of fields in the database.

Click Next.
Step 5: Data Preview and Other Table Settings

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Filter tab filters out the database file records. It allows you to define filtering conditions to be used when
retrieving the data.

- Add condition: specifies single line condition(s) that filters out the content that meets the set criteria.

+ Add group: specifies group(s) of conditions that filter out the content that meets the set criteria.
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Sorting tab allows you to sort the retrieved data. Sorting is done for all of the fields that are added to the
sorting list. Each field can be in ascending or descending order.

Data Retrieving tab defines how the data should be retrieved from the connected database file. Details on
data retrieving settings and options are available here.

SQL tab offers a preview of the generated SQL statements.
Read more details about database table configuration here.

Click Finish. The database is ready to be used as a label or form object data source.

6.3.3.9. Database Wizard for ODBC Data Sources

This section describes how to work with Designer Step-by-Step Database Wizard when adding an ODBC
data source.

The Microsoft® ODBC Data Source Administrator manages database drivers and data sources. This
application is located in the Windows Control Panel under Administrative Tools.

For information about detailed ODBC Administrator procedures, open the ODBC Data Source Administrator
dialog box and click Help.

Step 1: Connection information
This step defines the database connection details.
Connection Information group defines the type of database that is going to be used with ODBC connection.

+ Data Source: defines the database to retrieve the data from. Databases that are listed in the
dropdown list are managed using the ODBC Administrator.

+ Driver: displays the database driver according to the selected data source.

Authentication group includes a user name and password fields for the ODBC connection. User
authentication is necessary in certain cases - e.g., if SQL authentication is required when connecting
to an SQL server.

« User name: enter the correct user name to access the ODBC database.

+ Password: enter the correct password to access the ODBC database.

NOTE

Username and password are always shown. Their use depends on the database
administration policy.

ODBC Administrator button opens the system ODBC administration dialog. See more details about the
dialog here.
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Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

Step 2: Tables and Fields
Tables group allows you to select which tables of the connected database should be used as a data source.

+ Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

S NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Step 3: Label Copies Per Record
This step specifies the number of label copies to be printed for each database record.
Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.

Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.
Read more about how to define the number of printed copies here.
Step 4: Create Objects

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:

« Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.

+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.
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TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.

Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

+ Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

+ Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.

NOTE

The number of added objects depends on the number of fields in the database.

Click Next.
Step 5: Data Preview and Other Table Settings

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Filter tab filters out the database file records. It allows you to define filtering conditions to be used when
retrieving the data.

+ Add condition: specifies single line condition(s) that filters out the content that meets the set criteria.

- Add group: specifies group(s) of conditions that filter out the content that meets the set criteria.

Sorting tab allows you to sort the retrieved data. Sorting is done for all of the fields that are added to the
sorting list. Each field can be in ascending or descending order.
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Data Retrieving tab defines how the data should be retrieved from the connected database file. Details on
data retrieving settings and options are available here.

SQL tab offers a preview of the generated SQL statements.
Read more details about database table configuration here.

Click Finish. The database is ready to be used as a label or form object data source.

6.3.3.10. Database Wizard for Google Sheets

This section describes how to connect Google Sheets tables using the Designer Step-by-Step Database
Wizard.

NOTE
Connecting to Google Sheets requires Google authentication. Printing from NiceLabel
Automation, .NET API or Cloud Integrations is not possible.

1. Inthe Data menu, click All Databases to open Step-by-Step Database Wizard, then click Next.

e
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Dynam'»c Data Import Data Prompt RFID
Mansger  Sources  Order | o

Data Source Management | RFID

Step-by-Step Database Wizard

This step-by-step database wizard will help you connect the file to a database.
Database connection enables data retrieving and writing in label or form objects.

Inverse
Follow the wizard steps to configure the database connection and to select the
relevant database tables.

Each step of this wizard is optional. Click Finish during any step and continue with
your work.
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%
+ Add new variable m
e ]

2. Database Type Selection window opens. Select Google Sheets, then click Next.
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Database Type Selection
Select the type of database to connect to. The selection determines configuration steps that follow this step.

Connection type

Microsoft Excel

gﬁ Microsoft Access
Microsoft SQL Server

B O TextFile

2 Oracle

2 O MariaDB / MysQL

= () Other databases [OLE DB)
= ODBC Data Source

B

u' Excel (Microsoft OneDrive)

Cancel « Back

3. Connection Settings window opens. Click Sign in.

Database Wizard

Connection Settings
Set the necessary connection parameters to establish the database connection.

Connection
~ SR
Cl Sign in with Google
Spreadsheet
Spreadshest - @

Cancel < Back

4. Your web browser opens with Sign in with Google options.

G sign in with Google

Choose an account

to continue to Cl¢ it

% =
@gmail.com

(@ Use another account

To continue, Google will share your name, email address,
language preference, and profile picture with C
st1.

Click your account to log in.

5. A new window with options to access your Google Account opens. Select both options:
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+ See information about your Google Drive files.
+ See all your Google Sheets spreadsheets.

Then click Continue.

G sign in with Google

Ci st Twants
access to your Google Account
& >@gmail.com
Select what C t 1 can access
[ our persanal info on

-

ccount email

L See information about your Google Drive files.
Learn more

@ Seeall your Google Sheets spreadsheets
Learn more
Make sure you trust C i1

You may be sharing sensitive info with this site or app. You
can always see or remove access in your Google Account.

Learn how Google helps you share data safely.

SeeC t 1's Privacy Policy and Terms of
Service

Cancel Continue

6. Confirmation messages about successful connections appear in your browser and Designer. Close
the confirmation window in Designer.

L Loftware i m Grant access v |

Connect you account and grant access permissions.

Connection successful !

Close this window and return to NiceLabel. H

|

1

7. Inthe Connection Settings window select your Google Spreadsheet, then click Next.

287



Database Wizard

Connection Settings
Set the necessary connection parameters to establish the database connection.

Connection

Email address ji o@gmail.com

Spreadsheet

ICll Sign in with Google
Spreadsheet pastaMNL

4

pastahL

Cancel < Back

In the Spreadsheet list, you can also see sheets that are shared with your account. You can use the
shared sheets the same way as your own.

0 IMPORTANT

If you share your label with other clients, enable sharing of your Google Sheets so
other clients can log in with their credentials.

NiceLabel will prompt other clients for Google login when opening labels/solutions.

Test Connection button starts a connection testing procedure. It shows if a connection with the
selected Google spreadsheet has been established successfully. A confirmation or error message
appears depending on the connection status.

8. Your spreadsheet fields are now connected to your solution. You can remove the fields you don't
need. Then click Finish.

Database Wizard

Tables and Fields
Choose the table and column fields that you will use.

Table: |List1 7
Available fields: Selected fields:
Filter fields..

[ Product ID (List1.Product ID)
[ EAN code (List1.EAN code)

< Remove

<+ Remaove All

Cancel < Back Mext >

9. Finish your database wizard with the remaining wizard steps:
+ Label Copies per Record

+ Create Objects
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+ Date Preview and Other Table Settings

Your Google sheet is now connected to your label/solution.

A WARNING

Google login expires after 90 days. After login expires, Designer will prompt you to sign in
with your Google account.

6.3.3.11. Database Wizard for Excel (Microsoft OneDrive)

This section describes how to connect Excel (Microsoft OneDrive) spreadsheets stored in Microsoft
OneDrive using the Designer Step-by-Step Database Wizard.

1.

2.

NOTE

Connecting to Excel (Microsoft OneDrive) spreadsheets requires Microsoft authentication.
Printing from NiceLabel Automation, .NET API or Cloud Integrations is not possible.

In the Data menu, click All Databases to open Step-by-Step Database Wizard, then click Next.

ome

5 % 0% @&
Excel Access SQL L. Dy;;ami( Data J.msp;]:m:?h P(l)n,;}e?| I:l;w:
; : #riD

Data Source Management

Step-by-Step Database Wizard

This step-by-step database wizard will help you connect the file to a database.
Database connection enables data retrieving and writing in label or form objects.

Inverss
Follow the wizard steps to configure the database connection and to select the
relevant database tables.

Each step of this wizard is optional. Click Finish during any step and continue with
yourwork,

& Da
Search m Cancel
4R\

T ™

Database Type Selection window opens. Select Excel (Microsoft OneDrive), then click Next.
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Database Wizard

Database Type Selection
Select the type of database to connect to. The selection determines configuration steps that follow this step.

Connection type
E:[::Ii Microsoft Excel
gﬁ Microseft Access
Microsoft SQL Server
Text File
Oracle

MariaDB / MySQL

ODBC Data Source

Google Sheets

ki
=]
=]
= () Other databases (OLE DE)
=]
B
g

®) Excel {Microsoft OneDrive)

o ik

3. Connection Settings window opens. Click Sign in with Microsoft.

Database Wizard

Connection Settings
Set the necessary connection parameters to establish the database connection.

Connection

=' Sign in with Microsoft

Spreadsheet

Spreadshest

Test Connection

Cancel < Back

4. Your web browser opens with Microsoft account options.

B® Microsoft

Pick an account

E com

ndows

.onmicrosoft.com
ndows

1
Q o
_|_

Use another account

Back

Pick your account that will connect to your Microsoft OneDrive.
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@ NOTE

Some companies have restricted access to corporate OneDrive accounts. In this
case, you'll have to get the administrator's permission to connect to Excel with your
account. The following window opens:

ir ~com
Approval required
unverified

This app requires your admin's approval to:
v Maintain access to data you have given it access to
~~ Signin and read user profile

v Read user files

Emer;ust:"icatl(‘n for requesting this app e
4

Sign in with another account

Doss this app look suspicious? Repart it here

Cancel Request

If the security risk is too high, you can use or create a personal Microsoft account
and use OneDrive from that account.

5. Allow NiceLabel Designer to access your OneDrive data.

B Microsoft

o@gmail.com

Let this app access your info?

NiceLabel Spreadsheets needs you to confirm its
permission to:

+ Maintain access to data you have given
NicelLabel Spreadsheets access to

+ Read your profile

+ Open OneDrive files

Accepting these permissions means that you allow this app to use

your data as specified in their terms of service and privacy

statement. The publisher has not provided links to their terms

for you to review. You can change these permissions at
https://microsoft.com/consent. Show details

No Yes

6. Confirmation messages about successful connections appear in your browser and Designer. Close
the confirmation window in Designer.
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[ Grant access *

Connect you account and grant access permissions.

" Loftware

Connection successful

Connection successful

Close this window and return to NicelLabel.

7. Inthe Connection Settings window select your Excel spreadsheet, then click Next.

Database Wizard

Connection Settings
Set the necessary connection parameters to establish the database connection.

Connection

Email address ja >@gmail.com

=. Sign in with Microsoft ‘

Spreadsheet

]

Spreadsheet

allergens.xsx

ingredients.dsx

packagesadsx

Cancel < Back

0 IMPORTANT

If you share your label or solution with other clients, enable sharing of your Excel
spreadsheet in OneDrive so other clients can log in with their credentials.

There are two types of Microsoft accounts: personal accounts and work/school
accounts. You can share only Spreadsheets from the same type of account. You
can share spreadsheets from one personal account to another or from one work/
school account to another. You can't share a spreadsheet between personal and
school/work accounts.

NiceLabel will prompt other clients for Microsoft login when opening labels/
solutions.

In the current Designer:

+ You can create a new label or solution only with your own Excel (Microsoft
OneDrive) files.

+ You can't create a new label or solution connected to shared Excel (Microsoft
OneDrive) files.

* You can open and print existing labels or solutions connected to shared Excel
(Microsoft OneDrive) files.
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NOTE

Microsoft doesn't support . x1s files in Excel OneDrive edition.

Test Connection button starts a connection testing procedure. It shows if a connection with the
selected Google spreadsheet has been established successfully. A confirmation or error message
appears depending on the connection status.

8. Your spreadsheet fields are now connected to your solution. You can remove the fields you don't
need. Then click Finish.

Database Wizard

Tables and Fields
Choose the table and column fields that you will use.

Table: |Sheatl v
Available fields: Selected fields:

Filter fields..

ﬁ ingredients (Sheetl.ingredients)
ﬁ code (Sheetl.code)

< Remove

<< Remove All

Cancel < Back

9. Finish your database wizard with the remaining wizard steps:
+ Label Copies per Record
+ Create Objects

+ Date Preview and Other Table Settings

Your Excel sheet is now connected to your label/solution.

A WARNING

Microsoft login expires after 90 days. After login expires, Designer will prompt you to sign in
with your Microsoft account.

6.3.3.12. Database Editing

Edit Database button re-starts the Step-by-Step Database Wizard for configuring an existing database.

To properly reconfigure a database that has already been added, follow the below-listed steps.
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6.3.3.12.1. STEP 1: DEFINE DATABASE TABLE

Use this step to select among the existing databases. Select the database and the table you wish to edit.
Click Next to proceed.

6.3.3.12.2. STEP 2: CONNECTION SETTINGS

This step defines the database connection parameters.

|§ NOTE

The available parameters depend on the selected database type.

File name defines the database file location.

Advanced Setup opens the system configuration dialog. Data Link Properties window allows you to set the
connection properties. Data Link Properties is a Windows system dialog — read more about its properties
here.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

Click Next.

6.3.3.12.3. STEP 3: TABLES AND FIELDS
Tables group allows you to select which tables of the connected database should be used as a data source.

« Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

6.3.3.12.4. STEP 4: LABEL COPIES PER RECORD
This step specifies the number of label copies to be printed for each database record.
Fixed number of printed labels lets you insert the number of copies manually.

Dynamically defined number of printed labels sets the number dynamically using a data source value.
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Example:

The number of printed records can be defined using a variable value. Its value may be set in another label or
form object.

Use the same record for entire print job prints out the single selected record on the entire range of labels in
a print job.

Click Next to proceed or Finish to continue working with the object.

Read more about how to define the number of printed copies here.

6.3.3.12.5. STEP 5: CREATE OBJECTS

This step lets you decide whether new Text objects that display the content retrieved from database fields
should be added to a label/form or not.

Create Objects step is visible when:

+ Starting the database wizard from Data tab ribbon and adding a new database by clicking the
database button.

+ Starting the wizard in Dynamic Data Explorer or using a generic object Add database selector.

TIP

The Create Objects step differs if you are adding a database while designing a label or a
form. See the differences below.

Create Objects step for label designing:

+ Create a label text object for each field: adds a Text object that contains database field content.

+ Do not create any label objects: skips adding new objects.

Create Objects step for form designing:

- Create an edit field object for each field: adds an edit field object to the form. The added object(s)
contains database field content.

+ Create a form table object: adds a database table object to a form. The added object(s) contains
database field content.

+ Do not create any label objects: skips adding new objects.

NOTE

The number of added objects depends on the number of fields in the database.
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Click Next.

6.3.3.12.6. STEP 6: DATA PREVIEW AND OTHER TABLE SETTINGS

This step gives a preview of the data retrieved from the database. It also offers additional table settings
such as filtering and sorting.

Data tab displays a preview of data retrieved from the database file. You can use search controls at the top
of the preview section to find a specific record.

NOTE

Data preview shows up to 1000 rows.

Filter tab filters out the database file records. It allows you to define filtering conditions to be used when
retrieving the data.

+ Add condition: specifies single line condition(s) that filters out the content that meets the set criteria.

+ Add group: specifies group(s) of conditions that filter out the content that meets the set criteria.

Sorting tab allows you to sort the retrieved data. Sorting is done for all of the fields that are added to the
sorting list. Each field can be in ascending or descending order.

Data Retrieving tab defines how the data should be retrieved from the connected database file. Details on
data retrieving settings and options are available here.

SQL tab offers a preview of the generated SQL statements.
Read more details about database table configuration here.

Click Finish.

6.3.4. Manual Database Connection Setup

|§ PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.

Setting up a database connection manually gives you complete control over database connection settings
and configuration options.

S NOTE

This option is intended for advanced users. It allows detailed configuration and offers all
of the available database connection settings. NiceLabel recommends using the Database
Wizard.
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Manual database connections are done in three steps:

1. First step sets up the database connection.
2. Second step allows you to choose which database tables will be used.

3. Third step allows you to configure the connected database tables.

To connect to a database manually, follow the procedures described in the below-listed topics:

+ Connect to Microsoft Excel File

+ Connect to Microsoft Access File

+ Connect to Microsoft SQL Server File
+ Connect to Text File

+ Connect to Oracle Database

+ Connect to MySQL Database

+ Connect to OLE Database

+ Connect to ODBC Data Source

+ Connect to Google Sheets

6.3.4.1. Connect to Microsoft Excel File

Microsoft Excel databases can be used as a dynamic data source for label objects or form objects. Before
you manually set up a database connection, open the Dynamic Data Manager. This dialog enables the user
to manage the variable data sources for label and form objects.

Click Database Connections button in the Dynamic Data Manager ribbon and select Microsoft Excel as the
preferred database type. New database connection properties window opens.

To manually connect to an Excel file database, complete the below-listed steps.

6.3.4.1.1. STEP 1: CONNECTION SETUP
Connection type group allows you to define the type of database connection.
Connection Information group defines database file details.

+ File name: defines the database file to be used in the connection.

+ Advanced Setup: opens the Data Link Properties window. This window allows you to define the
connection properties. Data Link Properties is a Windows system dialog — read more about its
properties here.

+ Test Connection: button starts a connection testing procedure. It shows if a connection with the
database has been established successfully. A confirmation or error message appears depending on
the connection status.
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MNew Dat e Connection Properties

Connection type Connection Information

File name:
T

Text File

JAPasta.xls | £ Browse
® Microsoft Excel

Microsoft Access Advanced Setup Test Connection

Microsaft 5QL Server
Cracle

MySQL

Other databases (OLE DB)

ODBC Data Source

oK Cancel

Click OK when done. Database properties window appears.
Database Connection group defines the connection name and describes it.

+ Connection name: defines the name for the connected database file. By default, it displays the
filename of the connected file. Insert a new name to make it easy to be found in the Designer Dynamic
Data Explorer.

+ Description: allows adding additional information and suggestions for the connected database.

+ Connection: identifies the currently connected database file. To replace the currently connected file,
click the Connection Setup button. New Database Connection Properties window reappears — repeat
step 1 to connect to an alternative database file.
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Dynamic Data Manager

> @ ADe S AaslS S
¥ Cut X & [ 7] — = <En = = l%
o Variables Functions Intermal Global  Database Excel Access SOL  Text Al Edit Prompt
1 Copy X Delete - *  Variables~ variable Connections~ Server File Databases Database  Order
General Add Step-by-Step Database Wizard Variables
Search... Database Connection
4 @ Variables Connection name: Pastaxls
+ Add new variable Description: Manually Comected |
4 J; Functions ! Database connection
4+ Add new function .
4 2 Databases Connection: Microsoft Excel - Past details I]
- ) Tabl
+ Database wizard e |
4 % Pasta.xls Available tables: - Selected tables:
4 [ Pasta Filter tables...
] Pasta.Praduct 1D
Create new query
[ PastaCode_EAN = uen e Database table
[if] Pasta.Product_desc ] Pasta i lecti
[ Pasta.Package ] Pasta$ = = selection
& Internal Variables |
4 & Global Variables T il
4 Add new global variable Add >
£D GlobalVariable
< Remove
Add All =>
<< Remove All
Refresh Tables
QK Cancel

6.3.4.1.2. STEP 2: DATABASE TABLE SELECTION

Tables group allows you to select which tables of the connected database should be used as a data source.

« Available tables: available tables in the selected database.

Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

@ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Click OK when done.

6.3.4.1.3. STEP 3: CONFIGURATION OF DATABASE TABLES AND FIELDS
Read about how to configure the connected table here.

Read about how to configure the database fields here.

Click OK when done.
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6.3.4.2. Connect to Microsoft Access File

Microsoft Access databases can be used as a dynamic data source for label objects or form objects.
Before you manually set up a database connection, open the Dynamic Data Manager. This dialog enables
the user to manage the variable data sources for label and form objects.

Click your Database Connections button in the Dynamic Data Manager ribbon and select Microsoft Access
as the preferred database type. New database connection properties window opens.

To manually connect an object to an Access file database, complete the below-listed steps.

6.3.4.2.1. STEP 1: CONNECTION SETUP
Connection type group allows you to define the type of database connection.
Connection Information window defines database file details.

+ File name: defines the database file to be used in the connection.

Authentication group provides the User name and Password for connecting to a protected file.

+ Advanced Setup: opens the Data Link Properties window. This window allows you to define the
connection properties. Data Link Properties is a Windows system dialog — read more about its
properties here.

+ Test Connection: starts a connection testing procedure. It shows if a connection with the database
has been established successfully. A confirmation or error message appears depending on the
connection status.

MNew Database Connection Properties

Connection type Connection Information
File name:
Text File “\Users\Public\Documents\NiceLabel 20..\Pasta.accdb | | 5 Browse
Microsaft Excel
® Microsoft Access Authentication

Microsaft 5QL Server
Oracle Password:
MySQL

Other databases (OLE DB) Advanced Setup Test Connection

ODBC Data Source

oK Cancel

Click OK when done. Database properties window appears.

Database Connection group defines the connection name and describes it.
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+ Connection name: defines the name for the connected database file. By default, it displays the

filename of the connected file. Insert a new name to make it easy to be found in the Designer Dynamic
Data Explorer.

Description: allows adding additional information and suggestions for the connected database.

Connection: identifies the currently connected database file. To replace the currently connected file,

click the Connection Setup button. New Database Connection Properties window reappears — repeat
step 1 to connect to an alternative database file.

Dynamic Data Manager

). (e @ f <a <B =] e h & <
—1
¥ Cut X & < = =R E = = 1%
Vanables Functions Internal  Global  Database Excel Access SQL Text All Edit Prompt
0y Copy X Delete - - Variables~ variable Connections~ Server File Databases Database  Order
General Add Step-by-Step Database Wizard Variables
Search.. Database Connection
4 § Variables Connection name: Pastaxls
=
4 Add new variable Description: Manually ¢t mgcted }
4 Jfx Functions ! Database connection |
+ Add new function .
4 2 Databases Connection: Microsoft Excel - Past details I]
+ Database wizard Tables | |
4 % Pasta.xls Available tables: - Selected tables: =
4 E Pasta Filter tables... IS ~
[ PastaProductID —
(] Pasta.Code_EAN Creste pewauery Database table
ﬁ Pasta.Product_desc E Pasta Selection
ﬁ Pasta.Package E Pasta§ e
59 Internal Variables | ]
4 & Global Variables - T sl
+ Add new global variable Add >
D GlobalVariable
< Remove
Add All »>
<< Remove All
Refresh Tables
OK Cancel

6.3.4.2.2. STEP 2: DATABASE TABLE SELECTION

Tables group allows you to select which tables of the connected database should be used as a data source.
+ Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

|§ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Click OK when done.
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6.3.4.2.3. STEP 3: CONFIGURATION OF DATABASE TABLE AND FIELDS
Read about how to configure the connected table here.
Read about how to configure the database fields here.

Click OK when done.

6.3.4.3. Connect to Microsoft SQL Server Database

Microsoft SQL Server database can be used as a dynamic data source for label objects or form objects.
Before you manually set up a database connection, open the Dynamic Data Manager. This dialog enables
the user to manage the variable data sources for label and form objects.

Click Database Connections button in the Dynamic Data Manager ribbon and select Microsoft SQL Server
as the preferred database type. New database connection properties window opens.

To manually connect an object to a Microsoft SQL Server database, complete the following steps:

6.3.4.3.1. STEP 1: CONNECTION SETUP
Connection type group allows you to define the type of database connection.
Connection Information group defines database details.

+ Server: defines the database server to be used for the connection. The available servers are listed
automatically. To add a non-listed server, insert its name or location manually.

+ Authentication: selects the user authentication type.
+ Use Windows authentication to login using your Windows domain credential.
+ Use SQL Server authentication to login using the SQL server credentials.

Database selection group selects the database on the previously selected server. This database is going to
be used as a data source for the selected label or form object.

- Database: defines the server database to connect to.

Show Connection String displays the current database connection string and allows it to be inserted or
modified.

A WARNING

Connection string editing is intended for advanced users only. To configure the database
connection, users are encouraged to use standard dialog inputs in the dialog box.

Test Connection button starts a connection testing procedure. It shows if your connection with the
database has been established successfully. A confirmation or error message appears depending on the
connection status.
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MNew Dat e Connection Properties

Connection type Connection Information

Server sunset -
Text File
Microsoft Excel Authentication
Microsoft Access ® Use Windows authentication
Use 50L Server authentication
® Microsoft SQL Server
Cracle
MySQL
Other databases (OLE DB) = Database Selection

ODBC Data Source Database: AdventureWorks -

Connection string
Data Source=sunset;Integrated

Security=55P|;Database=AdventureWorks

Test Connection

oK Cancel

Click OK when done.
Database Connection group defines the connection name and describes it.

+ Connection name: defines the name for the connected database file. By default, it displays the
filename of the connected file. Insert a new name to make it easy to be found in the Designer Dynamic
Data Explorer.

+ Description: allows adding additional information and suggestions for the connected database.

+ Connection: identifies the currently connected database file. To replace the currently connected file,
click the Connection Setup button. New Database Connection Properties window reappears — repeat
step 1 to connect to an alternative database file.
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Dynamic Data Manager

> @ ADe S AaslS S
¥ Cut X & [ 7] — = <En = = l%
o Variables Functions Intermal Global  Database Excel Access SOL  Text Al Edit Prompt
1 Copy X Delete - *  Variables~ variable Connections~ Server File Databases Database  Order
General Add Step-by-Step Database Wizard Variables
Search... Database Connection
4 @ Variables Connection name: Pastaxls
+ Add new variable Description: Manually Comected |
4 J; Functions ! Database connection
4+ Add new function .
4 2 Databases Connection: Microsoft Excel - Past details I]
- ) Tabl
+ Database wizard e |
4 % Pasta.xls Available tables: - Selected tables:
4 [ Pasta Filter tables...
] Pasta.Praduct 1D
Create new query
[ PastaCode_EAN = uen e Database table
[if] Pasta.Product_desc ] Pasta i lecti
[ Pasta.Package ] Pasta$ = = selection
& Internal Variables |
4 & Global Variables T il
4 Add new global variable Add >
£D GlobalVariable
< Remove
Add All =>
<< Remove All
Refresh Tables
QK Cancel

6.3.4.3.2. STEP 2: DATABASE TABLE SELECTION

Tables group allows you to select which tables of the connected database should be used as a data source.

« Available tables: available tables in the selected database.

Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

@ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Click OK when done.

6.3.4.3.3. STEP 3: CONFIGURATION OF DATABASE TABLES AND FIELDS
Read about how to configure the connected table here.

Read about how to configure the database fields here.

Click OK when done.
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6.3.4.4. Connect to Text File
Text File database can be used as a dynamic data source for label objects or form objects.

Text files require some additional work before they are transformed into a "real" database. At the start, any
text file contains data values but has no information about the data structure, name fields, and maximum
field lengths. These missing parameters need to be specified before the text file turns into a database that
can be used as an object data source.

Example:

A widely used text database example are .csv files. In a .csv file, a delimiter separates the database fields.
Each line provides the data for a single label — therefore, it can be understood as a "record" in database
nomenclature.

Open the Dynamic Data Manager. This dialog enables the user to manage the variable data sources for
label and form objects.

Click Database Connections button in the Dynamic Data Manager ribbon and select Text File as the
preferred database type.

To manually connect an object to a text file database, complete the below-listed steps.

6.3.4.4.1. STEP 1: CONNECTION SETUP
Connection Information window defines the database file details.

+ File name defines the file location.

+ Test Connection: starts a connection testing procedure. It shows whether or not a connection with
the database has been established. A confirmation or error message appears depending on the
connection status.
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MNew Dat e Connection Properties

Connection type Connection Information

File name:

®) Text File igner\PowerForms\Samples\Labels\Databasg\Pasta.csv | | £3 Browse

Microsoft Excel

Microsoft Access T Tanmasi T
Microsaft 5QL Server

Cracle

MySQL

Other databases (OLE DB)

ODBC Data Source

oK Cancel

Click OK when done. Database properties window appears.
Database Connection group defines the connection name and describes it.

+ Connection name: defines the name for the connected database file. By default, it displays the
filename of the connected file. Insert a new name to make it easy to be found in the Designer Dynamic
Data Explorer.

+ Description: allows adding additional information and suggestions for the connected database.

+ Connection: identifies the currently connected database file. To replace the currently connected file,
click the Connection Setup button. New Database Connection Properties window reappears — repeat
step 1 to connect to an alternative database file.

306



Dynamic Data Manager

2 O A D@ S HSESEE S 1o

o Variables Functions Intermal Global  Database Excel Access SOL  Text Al Edit Prompt
1 Copy X Delete - - Variables variable Connections~ Server File Databases Database Order
General Add Step-by-Step Database Wizard Variables
Search.. Database Connection
4 @ Variables Connection name: Pasta.csv
+ Add new variable Description: Manually co.-ected
4 Jx Functions ! Database connection
+ Add new function details
4 2 Databases Connection: Text File - Pasta.csv I]
+ Database wizard Fields | DataRetrieving | Data \ }
4 E Pasta.csv ) -

ﬁ Pasta.csv.ProductlD Available fields:

Selected fields:
ﬁ Pasta.csv.CodeEAN

Filter fields..
ﬁ Pasta.csv.ProductName
ff] Pasta.csv.Package ﬁ ProductlD {Pasta.csv.Product
0 Pasta.cov.Category [ CodeEAN (Pasta.csv.CodeEAT

ﬁ Pasta.csv.Description
59 Internal Variables

4 &P Global Variables e ﬁ Category (Pasta.csv.Category|
+ Add new global variable

ﬁ Description (Pasta.csv.Descrif
D GlobalVariable . ~

ﬁ ProductMame (Pasta.csv.Proc
ﬁ Package (Pasta.csv.Package)

Configuration of
database fields

Define fields Refresh Fields

QK Cancel

6.3.4.4.2. STEP 1A: TEXT FILE STRUCTURE WIZARD

Text File Structure Wizard window opens if a structure for a text file you are connecting hasn't been defined
previously.

The steps for completing the Text File Structure Wizard are described in a dedicated section.

S NOTE

After finishing this procedure, a text definition .sch file with the same name as the text
database file and is created in the same folder. Next time the wizard is used on the same
file, this procedure is no longer required.

6.3.4.4.3. STEP 2: CONFIGURATION OF DATABASE TABLES AND FIELDS
Read about how to configure the connected table here.
Read about how to configure the database fields here.

Click OK when done.

6.3.4.5. Connect to Oracle Database

Oracle database can be used as a dynamic data source for label objects or form objects.
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Open the Dynamic Data Manager. This dialog enables the user to manage the variable data sources for
label and form objects.

Click your Database Connections button in the Dynamic Data Manager ribbon and select Oracle as the
preferred database type. New database connection properties window opens.

S NOTE

To connect to Oracle database and use the data in NiceLabel software, you must first install
and configure the Oracle client software on each computer with installed NiceLabel 10.
Details are available in the knowledge base article.

6.3.4.5.1. STEP 1: CONNECTION SETUP
Connection type group allows you to define the type of database connection.
Connection Information group defines database file details.

+ Server: defines the database server to be used for the connection. The available servers are listed
automatically. To add a non-listed server, insert its name or location manually.

Authentication group selects user authentication type.

+ Use Windows authentication: login using your Windows domain credential.

+ Use SQL Server authentication: login using SQL server credentials.

Database selection selects the database on the previously selected server. This database is going to be
used as a data source for the selected label or form object.

- Database defines the server database to connect to.

Show Connection String displays the current database connection string and allows it to be inserted or
modified.

A\ WARNING

Connection string editing is intended for advanced users only. To configure the database
connection, users are encouraged to use standard dialog inputs in the dialog box.

Test Connection button starts a connection testing procedure. It shows if your connection with the
database has been established successfully. A confirmation or error message appears depending on the
connection status.
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MNew Dat e Connection Properties

Connection type Connection Information

Data Source: Oracle database
Text File

. Authenticati
Microsoft Excel uthentication

Microsoft Access User name: username

Microsoft SQL Server Password: ssssnses
® Oracle Hide Connection String

MySCOL Connection string

Other databases (OLE DB) Provider=0raOLEDB.Oracle;Data Source=Cracle database;User

ID=username;Password=password
ODBC Data Source

Advanced Setup Test Connection

oK Cancel

Click OK when done. Database properties window appears.
Database Connection group defines the connection name and describes it.

+ Connection name: defines the name for the connected database file. By default, it displays the
filename of the connected file. Insert a new name to make it easy to be found in the Designer Dynamic
Data Explorer.

+ Description: allows adding additional information and suggestions for the connected database.

+ Connection: identifies the currently connected database file. To replace the currently connected file,
click the Connection Setup button. New Database Connection Properties window reappears — repeat
step 1 to connect to an alternative database file.
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Dynamic Data Manager

> @ ADe S AaslS S
¥ Cut X & [ 7] — = <En = = l%
o Variables Functions Intermal Global  Database Excel Access SOL  Text Al Edit Prompt
1 Copy X Delete - *  Variables~ variable Connections ~ Server File Databases Database  Order
General Add Step-by-Step Database Wizard Variables
Search... Database Connection
4 @ Variables Connection name: Pastaxls
+ Add new variable Description: Manually Comected |
4 J; Functions ! Database connection
4+ Add new function details
e g Databases Connection: Microsoft Excel - Past I]
. Tabl
+ Database wizard avles
4 % Pasta.xls Available tables: Selected tables:
4 [ Pasta Filter tables...
] Pasta.Praduct 1D
[ Pastacode EAN EG] Create new query Database table
[if] Pasta.Product_desc fH Pasta g 3 selection
[ Pasta.Package £ Pasta$ - -
& Internal Variables |
4 & Global Variables T il
4 Add new global variable Add >
£D GlobalVariable
< Remove
Add All = >
<< Remove All
Refresh Tables
QK Cancel

6.3.4.5.2. STEP 2: DATABASE TABLE SELECTION

Click OK when done.

Tables group allows you to select which tables of the connected database should be used as a data source.

+ Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

6.3.4.5.3. STEP 3: CONFIGURE CONNECTED DATABASE
Read about how to configure the connected table here.

Read about how to configure the database fields here.

Click OK when done.
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6.3.4.6. Connect to MariaDB / MySQL Database

MariaDB / MySQL database can be used as a dynamic data source for label objects or form objects. Before
you manually set up a database connection, open the Dynamic Data Manager. This dialog enables the user
to manage the variable data sources for label and form objects.

Click Database Connections button in the Dynamic Data Manager ribbon and select MariaDB / MySQL as
the preferred database type. New database connection properties window opens.

To manually connect an object to a MariaDB / MySQL database, complete the following steps:

6.3.4.6.1. STEP 1: CONNECTION SETUP
Connection type group allows you to define the type of database connection.
Connection Information window defines the database file details.

+ Database: defines the exact database on a server. Enter the correct name.
* Host: defines the database server IP address or name.

+ Port: defines the port of the database server.

Authentication group provides user name and password to establish the connection.

+ Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

MNew Database Connection Properties

Connection type Connection Information
Database: MySOL database
Text File Host: host
Microsaft Excel
Port: 3306

Microsoft Access

. Authentication
Microsoft SQL Server

Oracle User name: username

® MySQL Password: |..no..n-l
Other databases (OLE DE)

Test Connection
ODBC Data Source

oK Cancel

Click OK when done. Database properties window appears.

Database Connection group defines the connection name and describes it.
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+ Connection name: defines the name for the connected database file. By default, it displays the

filename of the connected file. Insert a new name to make it easy to be found in the Designer Dynamic
Data Explorer.

Description: allows adding additional information and suggestions for the connected database.

Connection: identifies the currently connected database file. To replace the currently connected file,

click the Connection Setup button. New Database Connection Properties window reappears — repeat
step 1 to connect to an alternative database file.

Dynamic Data Manager

). (e @ f <a <B =] e h & <
—1
¥ Cut X & < = =R E = = 1%
Vanables Functions Internal  Global  Database Excel Access SQL Text All Edit Prompt
0y Copy X Delete - - Variables~ variable Connections~ Server File Databases Database  Order
General Add Step-by-Step Database Wizard Variables
Search.. Database Connection
4 § Variables Connection name: Pastaxls
=
4 Add new variable Description: Manually ¢t mgcted }
4 Jfx Functions ! Database connection |
+ Add new function .
4 2 Databases Connection: Microsoft Excel - Past details I]
+ Database wizard Tables | |
4 % Pasta.xls Available tables: - Selected tables: =
4 E Pasta Filter tables... IS ~
[ PastaProductID —
(] Pasta.Code_EAN Creste pewauery Database table
ﬁ Pasta.Product_desc E Pasta Selection
ﬁ Pasta.Package E Pasta§ e
59 Internal Variables | ]
4 & Global Variables - T sl
+ Add new global variable Add >
D GlobalVariable
< Remove
Add All »>
<< Remove All
Refresh Tables
OK Cancel

6.3.4.6.2. STEP 2: DATABASE TABLE SELECTION

Tables group allows you to select which tables of the connected database should be used as a data source.
+ Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

|§ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Click OK when done.
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6.3.4.6.3. STEP 3: CONFIGURATION OF DATABASE TABLES AND FIELDS
Read about how to configure the connected table here.
Read about how to configure the database fields here.

Click OK when done.

6.3.4.7. Connect to Other Databases (OLE DB)

Various types of databases can be connected to label objects or form objects via the OLE DB source. Open
the Dynamic Data Manager. This dialog enables the user to manage the variable data sources for label and
form objects.

Clic your Database Connections button in the Dynamic Data Manager ribbon and select Other Databases
(OLE DB) as the preferred database type. New database connection properties window opens.

OLE DB extracts data from a variety of OLE DB-compliant relational databases by using a database table, a

view, or an SQL command.

Example:

OLE DB can extract data from tables in Microsoft Access or SQL Server databases.

To manually connect an object to other databases via OLE DB, complete the below-listed steps:

6.3.4.7.1. STEP 1: CONNECTION SETUP
Connection type group allows you to define the type of database connection.
Connection Information group defines database details.

+ Provider: defines the provider to be used for accessing the data by exposing the OLE DB interfaces.

Authentication provides the user name and password for establishing the connection.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.
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MNew Dat e Connection Properties

Connection type Connection Information

Provider: Microsoft Jet 4.0 OLE DE Provider (32 bit) A

Text File
Microsoft Excel Authentication

Microsoft Access User name:
Microsoft SQL Server Password:
Cracle Advanced Configuration
MysQL Automatically browse for tables
® Other databases (OLE DB) S et Chrinm
ODBC Data Source Advanced Setup Test Connection
QK Cancel

Advanced Configuration options are:

+ Automatically browse for tables (selected by default) automatically displays the available OLE
database tables. Cleared checkbox skips this step.

Show Connection String displays the current database connection string and allows it to be inserted or
modified.

A\ WARNING

Connection string editing is intended for advanced users only. To configure the database
connection, users are encouraged to use standard inputs or Advanced Setup dialog.

Advanced Setup button opens the Data Link Properties window allowing the user to define the connection
properties. Data Link Properties is a Windows system dialog — read more about its properties here.
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= Data Link Properties

Provider | Cormection | Advanced | Al

Specify the following to connect ta Access data:
1. Select or enter a database name:
Label Designer Express 6'.Samples'database’\Pastaxds | ..

2. Enter information to log on to the database:

User name: | Admin

Password:

Blank password

Test Connection

e | [

|§ NOTE

When connecting to a password-protected database, make sure the Allow saving password
option is selected. If not, even after a successful Test Connection procedure, database
access is not going to be granted.

Test Connection button starts a connection testing procedure to confirm if a connection with your
database has been established successfully. A confirmation or error message appears.

Click OK. Database properties window appears.
Database Connection group defines the connection name and describes it.

+ Connection name: defines the name for the connected database file. By default, it displays the
filename of the connected file. Insert a new name to make it easy to be found in the Designer Dynamic
Data Explorer.

+ Description: allows adding additional information and suggestions for the connected database.

+ Connection: identifies the currently connected database file. To replace the currently connected file,
click the Connection Setup button. New Database Connection Properties window reappears — repeat
step 1 to connect to an alternative database file.
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Dynamic Data Manager

> @ ADe S AaslS S
¥ Cut X & [ 7] — = <En = = l%
o Variables Functions Intermal Global  Database Excel Access SOL  Text Al Edit Prompt
1 Copy X Delete - *  Variables~ variable Connections ~ Server File Databases Database  Order
General Add Step-by-Step Database Wizard Variables
Search... Database Connection
4 @ Variables Connection name: Pastaxls
+ Add new variable Description: Manually Comected |
4 J; Functions ! Database connection
4+ Add new function details
e g Databases Connection: Microsoft Excel - Past I]
. Tabl
+ Database wizard avles
4 % Pasta.xls Available tables: Selected tables:
4 [ Pasta Filter tables...
] Pasta.Praduct 1D
[ Pastacode EAN EG] Create new query Database table
[if] Pasta.Product_desc fH Pasta g 3 selection
[ Pasta.Package £ Pasta$ - -
& Internal Variables |
4 & Global Variables T il
4 Add new global variable Add >
£D GlobalVariable
< Remove
Add All = >
<< Remove All
Refresh Tables
QK Cancel

6.3.4.7.2. STEP 2: DATABASE TABLE SELECTION

Click OK when done.

Tables group allows you to select which tables of the connected database should be used as a data source.

+ Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.

NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

6.3.4.7.3. STEP 3: CONFIGURATION OF DATABASE TABLES AND FIELDS
Read about how to configure the connected table here.

Read about how to configure the database fields here.

Click OK when done.
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6.3.4.8. Connect to ODBC Data Source

Various databases can be connected to label objects or form objects via ODBC Data Source Administrator.
Open the Dynamic Data Manager. This dialog enables the user to manage the variable data sources for
label and form objects.

Click Database Connections button in the Dynamic Data Manager ribbon and select ODBC Data Source as
the preferred database type. New database connection properties window opens.

To manually connect an object to a database, using the ODBC, complete the following steps:

6.3.4.8.1. STEP 1: CONNECTION SETUP
Connection Information group defines database details.

+ Data Source defines the source to retrieve the data from.
+ Driver displays the database driver according to the selected data source.
Authentication group includes a user name and password fields for the ODBC connection. User

authentication is necessary in certain cases - e.g. if SQL authentication is required when connecting to
an SQL server.

« User name: enter the correct user name to access the ODBC database.

+ Password: enter the correct password to access the ODBC database.

ODBC Administrator button opens the system ODBC administration dialog. Read more details about the
dialog here.

Test Connection button starts a connection testing procedure. It checks if Designer can successfully
connect to the database.

MNew Database Connection Properties

Connection type Connection Information
Data Source: Excel Files A
Text File
Microsoft Excel
Microsaft Access Authentication

Microsoft SQL Server User name:

Oracle Password:
MySQL

Other databases (OLE DB) ODBC Administrator Test Connection

® ODBC Data Source

oK Cancel
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Click OK. Database properties window appears.
Database Connection group defines the connection name and describes it.

+ Connection name: defines the name for the connected database file. By default, it displays the
filename of the connected file. Insert a new name to make it easy to be found in the Designer Dynamic
Data Explorer.

+ Description: allows adding additional information and suggestions for the connected database.

+ Connection: identifies the currently connected database file. To replace the currently connected file,
click the Connection Setup button. New Database Connection Properties window reappears — repeat
step 1 to connect to an alternative database file.

Dynamic Data Manager

). (- @ f (B (ﬁ =] S ik @& <
¥ Cut X & [ 7] —] = <En — = l%
o Variables Functions Intermal Global  Database Excel Access SOL  Text Al Edit Prompt
1 Copy X Delete - *  Variables~ variable Connections ~ Server File Databases Database  Order
General Add Step-by-Step Database Wizard Variables
Search... Database Connection
4 @ Variables Connection name: Pastaxls
i " =
+ Add new variable Description: Manually co.-ected
4 J; Functions ' Database connection |
+ Add new function . details
e g Databases Connection: Microsoft Excel - Past I]
. Tabl
+ Database wizard e | |
4 % Pasta.xls Available tables: - Selected tables: =
4 [ Pasta Filter tables... ~ -
] Pasta.Praduct 1D
Create new query
[ PastaCode EAN = e e Database table
[if] Pasta.Product_desc FH Pasta - selection
ﬁ Pasta.Package £ Pasta$
& Internal Variables
4 & Global Variables h T il
4 Add new global variable Add >
£D GlobalVariable
< Remove
Add All = >
<< Remove All
Refresh Tables
QK Cancel

6.3.4.8.2. STEP 2: DATABASE TABLE SELECTION
Tables group allows you to select which tables of the connected database should be used as a data source.

« Available tables: available tables in the selected database.

+ Selected tables: tables that are used as a data source.

Click Add > or < Remove buttons to add or remove the tables from the Selected fields.
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|§ NOTE

When editing an existing database, a table cannot be removed if used in a script, function,
action, or connected to a label or form object.

Click OK when done.

6.3.4.8.3. STEP 3: CONFIGURATION OF DATABASE TABLES AND FIELDS
Read about how to configure the connected table here.
Read about how to configure the database fields here.

Click OK when done.

6.3.4.9. Connect to Google Sheets

You can use Google Sheets as a dynamic data source for label objects or form objects. Before you
manually set up a database connection, open Dynamic Data Manager. This dialog enables the label
designer to manage the variable data sources for label and form objects.

NOTE

Connecting to Google Sheets requires Google authentication. Printing from NiceLabel
Automation, .NET API or Cloud Integrations is not possible.

1. Click the Database Connections button in the Dynamic Data Manager ribbon and select Google
Sheets as your database type.

@ Dota | © Layes @ Objects

Search..

2. New Database Connection Properties window opens. Click Sign in.
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w Database Connection Properties

Connection type Connection

Sign in with Google
Text File

) Microsoft Excel

Sy dsheet
O Microsoft Access preacehes

hkd
Microsoft SOL Server

Oracle Test Connection
MariaDB / MySQL
Other databases (OLE DB)

ODBC Data Source
® Google Sheets

Excel (Microsoft OneDrive)

oK Cancel

3. Your web browser opens with Sign in with Google options.

G Sign in with Google

Choose an account

to continue to Cle st

® =
@gmail.com

@ Use another account

To continue, Google will share your name, email address,
language preference, and profile picture with C
Bt 1.

Click your account to log in.
4. A new window with options to access your Google Account opens. Select both options:
+ See information about your Google Drive files.
+ See all your Google Sheets spreadsheets.

Then click Continue.
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G Ssign in with Google

Gl - st 1wants
access to your Google Account
& >@gmail.com
Select what C t 1 can access

ate you with your personal info on

[ D

ur primary Google Account email

ress

L See information about your Google Drive files.
Learn more

@® Seeall your Google Sheets spreadsheets
Learn more
Make sure you trust C a1

You may be sharing sensitive info with this site or app. You
can always see or remove access in your Google Account.

Learn how Google helps you share data safely.

SeeC t1's Privacy Policy and Terms of
Service

Cancel Continue

5. Confirmation messages about successful connections appear in your browser and Designer. Close
the confirmation window in Designer.

m Grant access . |

% Loftware

Connect you account and grant access permissions.

Connection successful

Connection successful |

Close this window and return to NiceLabel.

6. Select your Google Spreadsheet, then click OK.
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8.

Database Wizard

Connection Settings
Set the necessary connection parameters to establish the database connection.

Connection
Email address ji o@gmail.com
ICll Sign in with Google
Spreadsheet
Spreadsheet pastaML I M

pastahL

Cancel < Back

In the Spreadsheet list, you can also see sheets that are shared with your account. You can use the
shared sheets the same way as your own.

0 IMPORTANT

If you share your label with other clients, enable sharing of your Google Sheets so
other clients can log in with their credentials.

NiceLabel will prompt other clients for Google login when opening labels/solutions.

Test Connection button starts a connection testing procedure. It shows if a connection with the
selected Google spreadsheet has been established successfully. A confirmation or error message
appears depending on the connection status.

Your Google spreadsheet is now connected. Add the table(s) you would like to use to the Selected
tables.

Dynamic Data Manager

e D A D e 8 e B P

Varibles Functions Intenal  Global  Database  Step-by-Step Datsbase  Prompt  Import Data
Ih Copy X Delete - ~  Variables~ variable Connections~ ‘Wizard ~ Order Sources

General Add Varisbles  Import and Export
Search.. Database Connection
4 @ Variables Connection name: pastahiL

=+ Add new variable Description:

4 f, Functions 4
+ Add new function
4 2 Databases Connection: Google Sheet - pastaNL Connection Setup
+ Database wizard Tables
4 B pastahiL Available tables: Selected tables:
i Internal Variables Filter tables...

4 & Global Variables AT —
is
=+ ~dd new global variable

&0 GlobalVariable

&D test_pelko
Add All »>

Refresh Tables

Cancel

Columns from your selected table(s) appear in the list of your Dynamic Data Sources. Click OK.
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Dynamic Data Manager

ORRVORREN s N s s E & Q

Variables Functions Internal  Global _ Database
[ Copy X Delete - +  Variables~ varisble Connections=

Step-by-Step Database = Prompt  Import Data
izard = Orde
General Add

Sources

Variables  Import and Export

Search.. Database Connection

4 @ Variables Connection name: pastsNL
+ Add new variable Descriptions

4 f, Functions P
+ Add new function

4 2 Databases Connection: Google Sheet - pastaNL ‘Connection Setup

- - Tabl

+ Database wizard eoles

4 B pastaNL Available tebles: Selected tables:

B Lt Filter tables..
[ List1.Product ID
[ List1.EAN code 3 List1 Add > ) List1
&2 Internal Variables
4 @ Global Variables
# Add new global variable
g
‘2 G‘“ba‘\:::abh << Remove Al
& test_pe

< Remove

Add All > >

Refresh Tables

You can now connect data from your Google Sheets to your label objects.

A WARNING

Google login expires after 90 days. After login expires, Designer will prompt you to sign in
with your Google account.

6.3.4.10. Connect to Excel (Microsoft OneDrive)

You can use Microsoft Excel spreadsheets stored in Microsoft OneDrive as a dynamic data source for label
objects or form objects. Before you manually set up a database connection, open Dynamic Data Manager.
This dialog enables the label designer to manage the variable data sources for label and form objects.

NOTE

Connecting to Excel (Microsoft OneDrive) spreadsheets requires Microsoft authentication.
Printing from NiceLabel Automation, .NET API or Cloud Integrations is not possible.

1. Click the Database Connections button in the Dynamic Data Manager ribbon and select Excel

(Microsoft OneDrive) as your database type.
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SLLL B Ao % o &

Variables Functions Intemal  Global Step-by-Step Database | Prompt | Import Data Export
Iy Copy X Delete - = Variables~ variabl Wizard ~ Order Sources  Variables

General Add Varizbles | Import and Export

[Sea Microsoft Excel

4 @ Variables Microsoft Access
# Add new variable Microsoft SQL Server

4 f, Functions
+ Add new functien MariaDB / MySQL

4 = Databases Other databases (OLE DB}
+ Database wizard ODBC Data Source.

® Internal Variables

4 & Global Variables

+ Add new global variable

Google Sheets
Excel (Microsoft OneDrive)

2. New Database Connection Properties window opens. Click Sign in with Microsoft.

Connection type Connection

© Text Fil B Sign in with Microsoft
le

O Microsoft Excel
& Microsoft Access

Spreadsheet

Spreadsheet e
O Micrasoft SQL Server

.
© MariaDB / MySQL

() Other databases (OLE DB)

© ODBC Data Source

) Google Sheets

® Excel (Microsoft OneDrive)

3. Your web browser opens with Microsoft account options.

B® Microsoft

Pick an account

E com

ndows

E lLonmicrosoft.com

ndows

R ail.com

—|— Use another account

Pick your account that will connect to your Microsoft OneDrive.
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@ NOTE

Some companies have restricted access to corporate OneDrive accounts. In this
case, you'll have to get the administrator's permission to connect to Excel with your
account. The following window opens:

ir ~com
Approval required
unverified

This app requires your admin's approval to:
v Maintain access to data you have given it access to
~~ Signin and read user profile

v Read user files

Emer;ust:"icatl(‘n for requesting this app e
4

Sign in with another account

Doss this app look suspicious? Repart it here

Cancel Request

If the security risk is too high, you can use or create a personal Microsoft account
and use OneDrive from that account.

4. Allow NiceLabel Designer to access your OneDrive data.

B Microsoft

o@gmail.com

Let this app access your info?

NiceLabel Spreadsheets needs you to confirm its
permission to:

+ Maintain access to data you have given
NicelLabel Spreadsheets access to

+ Read your profile

+ Open OneDrive files

Accepting these permissions means that you allow this app to use

your data as specified in their terms of service and privacy

statement. The publisher has not provided links to their terms

for you to review. You can change these permissions at
https://microsoft.com/consent. Show details

No Yes

5. Confirmation messages about successful connections appear in your browser and Designer. Close
the confirmation window in Designer.
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[ Grant access *

Connect you account and grant access permissions.

" Loftware

Connection Successful Connection successful

Close this window and return to NicelLabel.

6. Select your Excel Spreadsheet, then click OK.

New Database Connection Properties

Connection type Connection

Email address I >@gmail.com
Mickoeott Becel E® Sign in with Microsoft
Microsoft Access

Spreadshest
Microsoft SQL Server
Oratie Spreadsheet |-
MariaDB / MySQL allergens sx =
Other databases (OLE DB) ingredients.isx n

packages.sx

(ODBC Data Source

Google Sheets

® Excel (Microsoft OneDrive)

oK Cancel

0 IMPORTANT

If you share your label or solution with other clients, enable sharing of your Excel
spreadsheet in OneDrive so other clients can log in with their credentials.

There are two types of Microsoft accounts: personal accounts and work/school
accounts. You can share only Spreadsheets from the same type of account. You
can share spreadsheets from one personal account to another or from one work/
school account to another. You can't share a spreadsheet between personal and
school/work accounts.

NiceLabel will prompt other clients for Microsoft login when opening labels/
solutions.

In the current Designer:

+ You can create a new label or solution only with your own Excel (Microsoft
OneDrive) files.

+ You can't create a new label or solution connected to shared Excel (Microsoft
OnebDrive) files.

+ You can open and print existing labels or solutions connected to shared Excel
(Microsoft OneDrive) files.
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NOTE

Microsoft doesn't support . x1s files in Excel OneDrive edition.

Test Connection button starts a connection testing procedure It shows if a connection with the
selected Excel Spreadsheet has been established successfully. A confirmation or error message
appears depending on the connection status.

7. Your Excel spreadsheet is now connected to your printing solution. Add the table(s) you would like
to use to the Selected tables.

Dynamic Data Manager

S D A DS S e 5% o

0} Copy X Delete Var\ih\es Func'tmns Internal  Global  Database Step-by-Step Database Prc’mpl Import Data

fariables > variable Connections~ Wizard Order Sources
General Add Variables  Import and Export
Search... Database Connection
4 @ Variables Connection name: ingredients xlsx
+ Add new variable Descriptions
4 fy Functions Yy
+ Add new function
4 2 Databases Connection: Excel (Microsoft 365) - ingredients.xlsc Connection Setup
- Tabl
# Database wizard erie
FR) ingredients.lsk Avsilable tables: Selected tables:
&2 Internal Variables Filter tables...

4 & Global Variables ‘
Sheet1 Add >
+ Add new global variable ‘

& GlobalVariable
&D test_pelko
Add All >>

Refresh Tables

OK Cancel

8. Columns from your selected table(s) appear in the list of your Dynamic Data Sources. Click OK.

Dynamic Data Manager

S 9 A D& 8 e & 9

Variables Functions Intermal Global  Database Step-by-Step Database ~ Prompt  Import Data
= = - Orde:

[y Copy X Delete Variables~ variable Connections~ Sources

General Add Varigbles  Import and Export
Search.. Database Connection
4 @ Variables Connection name: ingredients.xlsx

# Add new variable
4 f, Functions
+ Add new function

Connection: Excel (Microsoft 365) - ingredients.clsx
4 2 Databases ! 9

Description:

A

Connection Setup

- Tabl
+ Database wizard o
R gt Available tables: Selected tables:
Filter tables...

[T Sheetl.ingredients
[ sheetl.code [ Sheet1

S Internal Variables

| | sheetn

< Remove
4 &) Global Variables
+ Add new global variable Acd il
&D GlobalVariable << Remove All
¢D test_pelka

Refresh Tables

| oK | Cancel

You can now connect data from your Excel (Microsoft OneDrive) to your label objects.

A WARNING

Microsoft login expires after 90 days. After login expires, Designer will prompt you to sign in
with your Microsoft account.
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6.3.4.11. Database Table Configuration

Table Configuration group allows you to configure the connected database table. Use the tabs below to

browse through various configuration options.

+ Table name: displays the selected database table's name.

+ Table alias: gives a unique display name to a table. Table al

ias is useful when the same table is added

for more than once under the same database connection. Alias identifies these tables when used in

the Designer.

Dynamic Data Manager

- -

4 = Databases

# Database wizard
4 % Pasta.xls
4 @ Pasta
[ PastaCode_EaN
ﬁ Pasta.Product_desc
ﬁ Pasta.Package
59 Internal Variables
4 @ Global Variables
=+ Add new global variable
a‘ﬂ GlobalVariable

Available fields:
Filter fields..

ﬁ Product_ID

Add All 5>

<< Remove All

Refresh Fields

3 [— [—— [—1 —
¥ Cut @ j;( @ ()@ — -y <En == -r/ l
o Variables Functions Internal Global  Database Excel Access SOL Text All Edit Prompt
1] Copy X Delete - - Variables~ variable Connections~ Server File Databases Database Order
General Add Step-by-Step Database Wizard Variables
Search... Table Configuration
4 @ Variables Table name: Pasta
+ Add new variable Table alias: Pasta
4 f, Functions
& Add new function Fields | Filter | Sorting | DataRetrieving | SOL | Data

Selected fields:

[ Code_EAM (Pasta.Code_EAN)
ﬁ Product_desc (Pasta.Product |
ﬁ Package (Pasta.Package)

QK Cancel

6.3.4.11.1. FIELDS TAB

Available fields frame lists the available fields of the connected database table. Select the fields from the

list.

Selected fields display the fields that are used as a connected data source.

The fields can be added to or removed from the Selected fields using Add > and < Remove buttons. To use
the entire range of available fields, use Add all >> and << Remove All buttons.

Refresh Fields rereads the connected database table and displays the refreshed available fields.
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6.3.4.11.2. FILTER TAB

Enable filter command activates the table filter. Use it to filter out the displayed database fields as defined
by a condition or a group of conditions.

Add condition button creates a custom filter. Select standard qualifiers: equals, does not equal, is less than,
is less than or equal to, is greater than, is greater than or equal, like, not like, is blank, is not blank.

Add group button activates nesting two or more conditions for a filter. Use a group to build a more complex
filtering condition for a field. The conditions can be joined using AND (all conditions must be true in order to
display the record) or OR (only one condition must be true in order to display the record) logical qualifiers.

The list of defined conditions and groups is placed below the table. Remove the filter(s) by clicking the
Remove button.

6.3.4.11.3. SORTING TAB

Field column allows you to decide which field in a table should be used to sort the data.

Sort Order defines whether the records as displayed Ascending or Descending. Select the sort order from
the dropdown menu.

Example:

In Pasta.xlsx sample database, select Prod_desc field with Ascending order. The data appears sorted by
product description and ordered alphabetically from A to Z.

Product_ID....
Product iD Code EAN |Prn-du:| desc Package
BAS21S B021228430106 ARMONICHE 500G &
PASD 8021228500006 BIGOU 1KE 2
BASSH 8021228310001 BIGOU 250G [
PAS201 B021228430037 BIGOU 500G [
EMFSD1 8021228820050 BIGOLIFR. [
FRESO1 B021 228420168 BIGOL FR 250G &
CABDDE BINFTINN0TAES CAPPROSCCRUDO 250G-DL | 12
BASO04 8021228500037 CAPELLI D'ANGELD 1KG 2
PASS04 8021228310032 CAPELLI D'ANGELOD 250G [
PASI0Y 8021228430112 CAPELLI D'AMGELD 500G [

6.3.4.11.4. DATA RETRIEVING TAB

Data selection at print time initialization group defines database print time record selection and printing
options.

+ Show record selection at print time: enables manual selection of database records before printing.
The content of selected records is displayed in label objects and printed.
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TIP

When enabled, this option adds a selection column to the database table on the print
dialog. This column allows individual selection of the records to be printed.

+ Default print: defines which database records would be selected in the print dialog by default.
« All records: prints out the entire range of selected records.
+ First record: only prints out the first record in a table.

+ Last record: only prints out the last record in a table.

Number of copies per record group sets print quantities for individual database records.

+ Copies per record: defines how many labels should be printed per single database record.

+ Number of copies can be changed at print time: allows setting the number of printed label copies for
a single database record right before printing.

TIP

When enabled, this option adds a column to the database table in printing form. This
column allows individual settings of print quantity for the selected record.

Advanced options group allows you to set how multiple database records should be displayed.

+ Collect records: displays the content of multiple records in a single object.

+ Delimiter: defines which character should separate the database record values when displayed
in an object.

+ Limit number of collected records: enables the maximum number of displayed records in a single
object.

+ Records: sets the maximum number of database records to be displayed in an object.

+ Span multiple labels: displays collected records in an object on the first label and continues
displaying collected records which follow over the next labels in the print job.

Example:

By default, Designer prints one label for each database record.

1. With connected Pasta.xIsx database, the result is:
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Product ID: CAS006

Product description:
CASONCELLIALLA CARNE 250G

2. With enabled Collect records options (3 records), the result is:

Product ID: CAS006
PAS501
PAS502GI

Product description:

CASONCELLI ALLA CARNE 250G
BIGOLI 250G
TAGLIATELLE 250G

Note that all printed labels contain the same data from the collected table (data from
the first 3 rows) and an infinite number of labels is going to be printed by default (Print
all labels (unlimited) option selected). To limit the number of labels, enter the number of
printed labels.

3. With enabled Collect records option (3 records) and enabled Span multiple labels option,

the result is:
CAS006 PAS503GI PAS506GI
PAS501 PAS504 PAS507
PAS502GI PAS505 PAS508
CASONCELLIALLA CARNE 250G TAGLIOLINI 250G SFOG LASAGNE 250G
BIGOLI 2501 CAPELLI DANGELO 250G MACCHERONCINI 250G
TAGLIATELLE 250G PAPPARDELLE 250G RUOTE 250G

With 3 collected records defined, all labels are printed with content of the 3 collected
records. Each label includes data of these three records - if Print all labels (unlimited)
option is enabled, all database records are printed as sorted in the table.

+ Use the same record for entire print job: prints out the single selected record on the entire range of
labels in a print job.
6.3.4.11.5. SQL TAB

SQL tab displays current SQL statements that are used with the connected database. Commands in SQL
statements determine how to obtain the data from the database (fields, filters, data sorting). The displayed
SQL sentence is auto-generated.

By default, SQL statement is read-only. Designer also allows you to modify it or write your own sentence.
+ Edit SQL: converts table object into a query object. This button allows defining custom tables that are

based on SQL queries.
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|§ NOTE

This option is for experienced users only. If you make a mistake and create an invalid
SQL statement, the query results become unpredictable. No data will be returned from
the database or connection to the database will become impossible.

« Export: saves the current SQL statement as an SQL file on a disk.

+ Import: allows external SQL statements to be used with the current database.

6.3.4.11.6. DATA TAB

Data tab displays the connected database file table. Use the search field and field selector to find the
records.

6.3.4.12. Database Field Configuration

Details group allows defining the connected database field properties. Set these properties to make the use
of a database as simple and efficient as possible.

Dynamic Data Manager

Lo (pls @ f <B @ (=] @ S S bk @ < %
X & <. = = Em = T i
Variables Functions Intenal  Global  Database Excel Access SQL Text Al Edit Prompt
X Delete - ~  Variables~ variable Connections~ Server File Databases Database  Order
General Add Step-by-Step Database Wizard Variables
Search.. Details
4 @ Variables Field name: AddressLine2
+ Add new variable Field alias: Address. AddressLine2
©T Output

N When scripting in Python or VBScript, use names that contain alphanumeric and underscere characters only and do
T Variable not start with a digit.

4 f, Functions

Type: nvarchar
+ Add new function Lengh:
4 2 Databases
+ Database wizard Code page: L2 -
4 BB sunsetAdventureWorks Data
4 [ Address
[ Address AddressiD [] Limit field length (truncate excessive content)
[ Address.Addresslinet o<
[T Address Addressline2 Provisional value: Address Ling]
[ Address.City

[ Address.StateProvincell
[ AddressPostaiCode
[ addressrowguid
[ AddressModifiedDate
i Internal Variables
4 &P Global Variables

+ Add new global variable

& GlobalVariable

&D GlobalVariable_1

&0 GlobalVariable_2

Cancel

+ Field name: defined automatically by the source database file.

+ Field alias: gives a unique display name to a field.
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A WARNING

When using Python or VBScript, use field alias names that contain alphanumeric and
underscore characters only. The names must not start with a digit.

+ Type: identifies the data type of a database field. This property depends on the connected database
field and cannot be edited.

+ Length: (not available for Text File) displays the field length as defined by the database.
+ Code page: provides support for the character sets used in different countries or regions. Code pages

are referred to by number — select the appropriate one from the dropdown list.

Data group sets the database field length limitations.

+ Limit field length (truncate excessive content): enables the maximum field length limitation. Extra
characters are removed.

* Length (characters): defines the exact maximum field length using the number of allowed

characters.

+ Provisional value defines a custom placeholder variable value in an object while designing labels or
forms. In a label object, the provisional value is replaced by the real variable value at print time. In a
form object, the real variable value appears when the form is run.

TIP

In case of connected databases, the first record's value is taken as the provisional
value.

Output data group enables you to store database record content and use it in actions.

NOTE

Output data can be assigned to a variable with the following form objects: Edit Field, Memo
Field, Combo Box, List Box, and Radio Group.

+ Set value to variable: defines the output variable that stores copied value from the database variable.

Example:

The output variable is useful in the following cases:

+ Certain actions in solutions are triggered when the database content changes. The changed value is
stored in the database variable. Because the database variable value cannot be directly used to set
the action, use the output variable. This variable will obtain and store the changed value, and trigger
the action after its value will change.
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+ Changes in database fields are directly reflected in the connected database. Use the output variable
to delay such database updates.

+ In certain cases, database updates are done using a custom SQL statement. Also in this case, the
updates are done using the output variable.

6.3.4.13. Databases with Custom SQL Queries

Designer allows defining custom tables that are based on SQL queries. Two methods are available for
creating a custom SQL query:

1. Create a new SQL query.
Go to Dynamic Data Manager > Database Connection Tables and click Create new query in the
Available tables field.

2. Convert an existing database table into a query object.
Go to Dynamic Data Manager > Table Configuration > SQL Tab and click the Edit SQL button. This
converts the connected database into a Query object.

|§ NOTE

This option is for experienced users only. If you make a mistake and create an invalid
SQL statement, the query results become unpredictable. No data will be returned from the
database or connection to the database will become impossible.

@ NOTE

This option is not available for text database files.

Insert a custom query into the edit field. Click OK when done.

NOTE

SQL statement field must not be left empty. An error appears if trying to continue without
defining the statement.

6.3.4.14. Database Connection Configuration

Existing database connections are configurable at any time. To add or remove tables from a connected
database file, open the Dynamic Data Manager and double-click the database in the Dynamic Data Explorer.

Database Connection group gives information on the connection database.

« Connection name: defines the name for the connected database file.
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+ Description: allows adding additional information and suggestions for the connected database.

+ Connection identifies: currently connected database file. To replace the currently connected file, click
the Connection Setup button. New Database Connection Properties window reappears — repeat step
1 to connect to an alternative database file.

NOTE

You can add the same database table more than once if different record filtering or sorting
is required.

6.3.4.15. Using Text File Structure Wizard

A "real" database must contain structured data. Text databases lack data structure, which means that the
structure must be defined before a text file can be used as a data source. Define the structure using the
Text File Structure Wizard.

NOTE

Text File Structure Wizard opens if a text file you are connecting to has not been previously
used as an object data source.

To complete the text file structure wizard, complete the below-described steps.

6.3.4.15.1. STEP 1: WELCOME

The welcome window displays the text file you are going to convert into a database and use as a data
source of an object. Make sure the correct text file is displayed under Selected text file.

Click Next.

6.3.4.15.2. STEP 2: DATA ENCODING
This step sets the Encoding type. The following types are available:

+ Auto

ASCII

- UTF-8

UTF-16
+ UTF-16BE
When in doubt which encoding should be used, select Auto for automatic detection of encoding type.

Auto identifies the encoding type by reading the BOM unicode character. If BOM is not included or is
misinterpreted, Auto presumes, the text uses ASCII encoding.
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Inadequate character type identification might cause the database structure to be displayed incorrectly.

S NOTE

While selecting the encoding type, check the preview field. Correct values must be
displayed.

Click Next.

6.3.4.15.3. STEP 3: DATA STRUCTURE
This step defines the fields to be used in the text database. There are two options:

+ Delimited: fields are separated by a delimiter.
+ Fixed width: fields with predefined (fixed) length.

+ First row contains field names: defines if the field names are included in the first row of the database
file.

« Start import at row defines the row in the database file from which the data import starts. This
option enables skipping the rows that do not include data.

Check the preview field. Click Next if the text content is displayed properly.

6.3.4.15.4. STEP 4: SET COLUMN BREAKS
This step depends on the previously selected data structure option — Delimited or Fixed width.
Delimited opens the Fields Delimiter window.

+ Delimiter: defines the delimiting character. Select among the standard characters or insert a custom
delimiter in Other field.

+ Text qualifier: a character that indicates textual content. Text qualifier should be used if a delimiter is
a part of the text field content. Text qualifier should be used to enclose such field — the text between
two text qualifiers is treated as a single field although it contains a delimiter.

Fixed width opens the Set Column Breaks window. Use your mouse pointer to place the vertical lines where
the data fields are going to be separated. The lines indicate where new fields start.

Click Next.

6.3.4.15.5. STEP 5: FIELDS

Fields window allows you to manipulate and fine-tune the field names and the order in which they are
displayed. The below-listed settings are also available:

+ In case of Delimited fields, the Field Name can be customized.
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+ With Fixed width fields, the following settings are allowed:
+ Include: includes a field in the selection.
+ Field name: custom name for the field.
+ Offset: separation line distance from the left table edge.

+ Length: field length.

Click Finish. Text file database structure is set.

6.3.4.16. Database Connection Configuration for Text Files

Connection name defines the name for the connected database file. By default, it displays the filename of
the connected file. Insert a new name to make it easy to be found in the Designer Dynamic Data Explorer.

Description is a field that allows adding additional information and suggestions for the connected
database.

Connection identifies the currently connected database file. To replace the currently connected file, click
the Connection Setup button. New Database Connection Properties window reappears — repeat step 1 to
connect to an alternative database file.

6.3.4.16.1. FIELDS TAB

Available Fields frame lists available fields of the connected database file. Select the field(s) from the list.

Selected fields displays the fields (columns) to be further used as the data source.

Fields can be added to or removed from the Selected fields using Add > and < Remove buttons. To use the
entire range of available table fields (columns), use Add all >> and << Remove All buttons.

Define Fields opens the Text File Structure Wizard. This wizard defines the text file database fields.

NOTE
|§ (

Re)defining of fields becomes necessary when the fields are edited or when the field
structure gets changed (inserted column, deleted record, etc.).

Refresh Fields rereads the connected database file and displays the refreshed available fields.

6.3.4.16.2. DATA RETRIEVING TAB

Data selection at print time initialization group defines database print time record selection and printing
options.

+ Show record selection at print time initialization enables you to manually select the database records
before printing. The content of selected records is displayed in label objects and printed. When
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enabled, this option adds a selection column to the database table. This column allows individual
selection of the records to be printed.

+ Default print defines how many database records should be printed by default.
+ All records prints out the entire range of selected records.
+ First record only prints out the first record in a table.

« Last record only prints out the last record in a table.

Number of copies per record sets print quantities for individual database records.

+ Copies per record defines how many labels should be printed per single record. The value can be set
manually or dynamically using a data source.

+ Number of copies can be changed at print time option allows you to set the number of printed label
copies for a single database record. When enabled, this option adds a column to the database table.
This column allows individual setting for print quantity for your selected record.

Advanced options allow you to set how multiple records can be displayed.

+ Collect records displays the content of multiple records in a single object.

+ Delimiter defines how the records are separated when displayed in an object. Set New line
(CR/LF) or select a special character from the list.

+ Limit number of collected records enables the maximum number of displayed records in a single
object.

+ Records sets the maximum number of records to be displayed in an object.
+ Span multiple labels enables the records to be displayed in an object over multiple labels.

+ Use the same record for entire print job prints out the selected record only.

6.3.4.16.3. DATA TAB

Data tab provides a preview of the connected database file. It enables field filtering and record search.

NOTE

Up to 1000 rows are displayed in the preview.

6.4. Internal Variables

PRODUCT LEVEL INFO

This section applies to NiceLabel 10 Pro and PowerForms editions.
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An internal variable performs as a dynamic data source that holds a value that is automatically retrieved
from a running application and system environment.

Select internal variables by clicking the Internal Variables button in the Data Sources ribbon. Select the
appropriate variable checkboxes.

General

NOTE

S E0 S I%

Excel Access SQOL  Text All Prompt
Server File Databases Order

Step-by-Step Database Wizard Variables

The variables in this set can neither be edited nor modified. Their value is updated with

every printed label.

List of available internal variables with description:

LabelFileName
ShortLabelName
RequestedQuantity

TotalQuantityPrinted

CurrentBatchQuantity

LabelPrinterName
DefaultPrinterName

UserName

SystemUserName
ComputerName
SolutionFileName
ShortSolutionFileName
SolutionFilePath

FormName

ShortFormName

EPCData

LabelRevision

The path and file name of the currently opened label file.
The file name of the currently opened label file.

The quantity of labels requested for printing. This is the number of
labels printed.

Total quantity of the printed labels. The number is the sum of label
quantities from all label batches.

The number of labels reached in the current label batch. The value is
reset at beginning of each label batch in the printing process.

The name of the printer driver currently selected for printing.
The name of the default printer driver.

The application use rname of the currently logged-in user. It will have a
value only if in-application authentication is enabled.

The Windows user name of the currently logged-in user.

The name of the computer on which the application is running.
Current solution file name.

Current short solution file name.

Path to solution file name.

The path and name of the form application used for label printing
instead of Print dialog box.

Short name of the form application used for label printing instead of
Print dialog box.

EPCData as read from the RFID tag.

Label Revision Description.

339




AccessRoles Contains comma-separated lists of every assigned access role
for your users. Enable Authentication in Control Center to use
AccessRoles. Your solution cannot retrieve AccessRoles from Control
Center when you work offline.

6.5. Global Variables

PRODUCT LEVEL INFO
The use of NiceLabel Control Center is applicable to LMS Pro and LMS Enterprise only.

Global variable is a type of variable that can be shared among multiple NiceLabel 10 documents. Once
defined, it is stored in a file outside the current label.

The global variable's last value is stored after each confirmation and with each printing action. The stored
values are useful if continued numbering from preceding print jobs is required. Global variable values are
stored in a separate file on a disk or on a NiceLabel Control Center.

TIP
By default, your global variable storage location is set to C:\ProgramData\NiceLabel
\Global Variables\. The file nameis Globals.tdb.

You can create global variables in Designer or in NiceLabel Control Center. After you design a label or
solution that uses global variables, you must define which global variables are you going to use. Designer
can either work with global variables that are stored locally in the Globals. tdb file, or with global
variables that you created ad stored in the Control Center.

To select the right source of your global variables, go to File > Options > Global Variables.

Details on how to create and configure global variables in Control Center are available in the Control Center
user guide, page 40.

To use the global variables from your Control Center, make sure Designer and Control Center are
connected.

When creating a copy of the label file that uses global variables and using it on another computer, make
sure the global variable source is accessible (in a .tdb file or in your NiceLabel Control Center).

+ Add and manage global variables.

+ Configure global variables.
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S NOTE

If you skip this step, the labeling application won't find the corresponding global variable. A
warning message will appear.

@ TIP
All label or solution global variables are managed in Dynamic Data Explorer.

6.5.1. Adding Global Variables as Object Data Sources

To add a new global variable in the Dynamic Data Manager, use one of the following methods:

+ Click Global Variable button in the dialog ribbon. Global variable configuration window appears.

2.0 O K|ip|ép & RE RN S 1%

Variables Functions] Internal | Global Database Excel Access SOL  Text All Prompt
- - Variables = pariable Connections= Server File Databases Order
General Add Step-by-Step Database Wizard Variables

+ Click Add new global variable under Global variables in Dynamic Data Explorer. Global variable
configuration window appears.

4 [0 Variables
+ Add new variable
e,T Variable
4 f, Functions
#* Add new function
4 2 Databases
#* Database wizard
=3 Internal Variables
4 & Global Variables
#+ Add new global variable

TIP

A new global variable is listed in the toolbar and ready to be used as a dynamic object
content source. Add an object to the design surface and assign the global variable to it.

6.5.2. Global Variable Configuration

Global variable is a type of variable that can be shared among multiple labels. Once it is defined, it is stored
outside the current label.
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|§ NOTE

If a global variable is not defined or inaccessible, a warning appears on the top of the dialog
window. To create a global variable, click the link inside the warning. Make sure the correct
data source is defined in the Options dialog.

6.5.2.1. General Tab

About group of settings identifies the global variable and sets its definition.

+ Persistent ID: identifier of the global variable. It serves as a unique reference from any connected
source. Allowed values are 10000—-99999.

« Name: unique global variable name. This name is used as a user-friendly identifier.

|§ NOTE

Avoid using non-alphanumeric characters when defining the variable name.

@ TIP

Enter the name to make the variable easy to find when listed among other variables in the
Dynamic Data Explorer.

+ Description: is a field that allows adding additional information and suggestions.

+ Current value: the value that is assigned to a global variable when created. It is defined using one of
the following methods:

+ Manually entering a fixed value. Characters from any group of allowed characters are permitted.
+ Using a special character:

+ Special character can be entered manually using the less than/greater than signs, e.g.,
<CR>, <LF> ...

+ Special character can be selected from the dropdown list.

@ TIP

Make sure the inserted current value meets the criteria defined with Output Rules for each
data type.

Counter group settings allow you to configure global variables that perform the role of a counter.

+ Do not use a counter: prevents the global variable from being used as a label counter.
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+ Incremental counter: counter value increases along with the printed labels.
« Decremental counter: counter variable value decreases along with the printed labels.
+ Step: the amount of units that represent the next state of your counter value.

+ Repetition: number of repetitions for each counter value.

NiceLabel 10 allows you to simultaneously design and print multiple labels using the same global counter
variable. Because the purpose of the global counter variable is to ensure counter value continuity among
multiple labels, its value gets locked while the global variable file is in use — i.e. a label is printed. Label
preview for all labels displays the last retrieved value from the global variable file (or from NiceLabel Control
Center if used), while the counter values on printed labels obtain and show their actual values.

Example:
Label A: Current value = 1; print quantity = 5. Global counter printed values are 1, 2, 3, 4, 5.

Label B: Current value after Label A print = 6; print quantity = 5. Global counter printed values are 6, 7, 8, 9,
10.

Input Rules Tab
Data defines the counter input criteria.

+ Allowed characters: permitted characters for variable values. Groups of allowed characters for data
input filtering are described in section Groups of Allowed Characters.

Example:

Non-numeric characters can also be used as counter values. Alphanumeric sets the sequence with Step = 3
and Initial value=1as 1,4,7,A,D,G,J,M,R S,V Y, b, e h, ...

+ Limit length: maximum length of a variable value.
* Length (characters): specifies the exact permitted number of characters.

+ Fixed length: variable must contain the exact given number of characters as defined in the Limit
variable length.

Output Rules Tab

Prefix and Suffix are characters that are added to a variable value.

+ Prefix: text placed in front of the variable value.

+ Suffix: text placed behind the variable value.
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Pad Character fills empty character position until the maximum variable length for a variable is reached.
Pad character is enabled only if the Limit variable length in the Input rules tab is enabled.

+ Padding: defines the mode of padding.
* Not used: does not use padding.
+ On left: adds pad characters on the left side of the data value.
+ On right: adds pad characters on the right side of the data value.
+ Surrounding value: adds pad characters on both sides of the data value.

+ Character: character used for padding.

6.6. Adding and Deleting Data Sources

NiceLabel 10 allows you to add the dynamic data sources in multiple ways:

+ in Dynamic Data Explorer
+ in Dynamic Data Manager
+ using the label or form object properties dialog

+ when dragging objects to design surface by clicking the arrow next to the object icon

While you can add data sources in multiple ways, you can delete the data sources in Dynamic Data
Manager.

NOTE

You can only delete the data sources that are not connected to any of the objects that you
use on your label or form.

6.7. Groups of Permitted Input Characters

There are multiple variable formats that may be used to filter the input. This helps to avoid mistakes when
entering data. The user is only allowed to enter the permitted characters.

All Select this format when there is no need to limit the variable input data. For
example: a variable can be used to define changes in barcode, text and graphics.

Numeric Use this format for numeric variables such as serial numbers, EAN and UPC
barcodes. Only numeric characters in the range from 0 to 9 can be entered.

Sequence: 0123456789
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Alphanumeric Use this format when numbers and characters are mixed in the same variable.
Characters from 0 to 9 and from A to Z can be entered.

Sequence:
0123456789ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopgrstuvwxyz

Letters Use this format for variables that only contain letters.

Sequence: ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijkimnopgrstuvwxyz

Digits & Use this format for variables that only contain digits and capital letters.
Capitals

7-bit ASCII The variable will contain only characters with ASCII code from 0 to 127.
Hex Use this format to allow entering hexadecimal numbers.

Sequence: 0123456789ABCDEF
Custom Use this format to customize the range of allowed characters.

Code 39, Code Use these formats to only permit the use of characters that are included in the
128A, Code corresponding barcode standards.

128B, Code

128C, Code

128, Codabar

6.8. Special Character Shortcuts

Designer includes several predefined control characters — select them from the dropdown menu in any
dialog when text input is enabled. An arrow button on the right side of the edit field lists the shortcuts.

Example:

FNC1 character can simply be encoded as <FNC1>.

If a specific special character is not available on the list of shortcuts, see sections "Entering Characters with
Alt+<ASClI_code>" and "Entering Characters with <#hex_code> Syntax".

ASCII code Abbreviation used in Description of the character
the application

1 SOH Start of Heading

2 STX Start of Text

3 ETX End of Text

4 EOT End of Transmission

23 ETB End Transmission Block

25 EM End of Medium
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O© 00 N o o

11

10
12
14
15
16
17
18
19
20
28
29
30
31
21
22
24
26
27
188
189
190
191

ENQ
ACK
BEL
BS
HT
VT
CR
LF
FF
SO
S
DLE
DC1
DC2
DC3
DC4
FS
GS
RS
us
NAK
SYN
CAN
suB
ESC
FNC
FNC
FNC
FNC

Enquiry
Acknowledgment

Bell

Back Space
Horizontal Tab
Vertical Tab

Carriage Return

Line Feed

Form Feed

Shift Out

Shift In

Data Link Escape
XON - Device Control 1
Device Control 2
XOFF - Device Control 3
Device Control 4

File Separator

Group Separator
Record Separator

Unit Separator
Negative Acknowledgment
Synchronous Idle
Cancel

Substitute

Escape

Function Code 1
Function Code 2
Function Code 3

Function Code 4

346




7. Solutions

S PRODUCT LEVEL INFO

This section is applicable to PowerForms.

NiceLabel Designer solution acts as a container which includes multiple documents - labels, forms and
shared data sources. A single solution enables dealing with any number of labels, forms and shared
variable data sources.

How do labels and forms cooperate in a solution? A label alone can be designed and printed. Multiplied
manual printing of a single label file is time consuming and difficult if the content needs to be constantly
updated. Therefore, NiceLabel introduced the ability to create forms which are combined with labels in a
solution.

As a part of a solution, label document(s) specify the layout of printed labels. Forms make sure the content
of printed labels is easily defined, edited, and updated. Forms also offer the user the control over a wide
range of data- and print-related actions.

The advantages of keeping multiple labels and forms in a single file are:

+ Simplified management print outputs.
« Simpler and time efficient label designing and printing.

+ Simplified use of shared variable data sources.

7.1. Create or Edit a Solution

|§ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

To create a Designer solution means to create a complete labeling "kit" which includes labels and forms.

The main advantage of creating a solution is the ability to use a single compact label printing file that works
as a common frame for labels, connected data sources, actions, and forms. The final result of using a
Designer solution is greatly enhanced user experience and improved label printing efficiency.

TIP

A single solution may include multiple labels and forms. The number of label and form
solution components varies according to the requirements of the current print job.
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To start working on a solution, go to File > New and select New Solution.

New

New Label

Create a basic label for printing.

New Solution
Create an advanced labeling sclution with labels and forms.

New From Sample Templates
Create a documnent based on a selection of industry standard compliant templates.

A new empty solution page opens. The following options are instantly available on the Solution tab:

« Add new label.
+ Add new form.

+ Import into Solution.

7.2. Accessing Files in Solution

When creating a solution, labels and forms do not have to be stored within the same solution file. Decide
where you want to store the file according to the current solution requirements. NiceLabel recommends the

following approaches:

1. Labels and forms contained in a single solution file/document - suitable if:
+ Solution contains similar labels with shared data sources.
+ Label templates are rarely changed.
+ Solution covers a single process.

2. Labels stored at a separate location, forms contained in a solution file — suitable if:
+ Regularly changing label templates.
+ Solution covers a single process and uses shared data sources.

3. Labels and forms stored in separate files/documents — suitable if:
+ Each label and/or form covers a different process.

+ No shared data sources.
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7.3. Create or Edit a Label in a Solution

PRODUCT LEVEL INFO

Solution building is available in PowerForms.

To create a new label as a part of a solution, click New Label on the Solution tab of the ribbon, or add it
using the Solution Explorer.

= B
File Home Data View
I = ¥
*
Add New Add New Import into
Label Form Solution
Clipboard MNew Action Import and Export

Label Setup Wizard window opens. Follow the wizard steps to set the label.
To start working on a label, consider reading the following sections:

+ Get familiar with the workspace.
+ Set label properties.
+ Get familiar with label objects.

+ Define data sources for variable objects.

7.4. Form

@ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

NiceLabel Designer form serves as a panel for entering, manipulating, and viewing the data. The
advantages of using a form are simplified data-entry and label printing process for the end-user.

In NiceLabel Designer, a form is created within a printing solution. This means that a form is usually a
built-in combination with a predesigned label.

TIP

Forms allow you to build an entire tailor-made data handling system that is adaptable to
current business needs.
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Read about how to create, design, or edit a form here.

7.4.1. Create or Edit a Form

PRODUCT LEVEL INFO

This section is applicable to PowerForms.

To create a form, open a new or existing solution and click the New Form button in the Solution tab of the
Designer ribbon or in Solution Explorer.

To start working on a form, consider reading the following sections:

+ Get familiar with workspace.

+ Set form properties.

+ Get familiar with form objects.

+ Define data sources for variable objects.

« Get familiar with actions.

7.4.2. Form Properties

|§ PRODUCT LEVEL INFO

This section is applicable to PowerForms.

Form Properties dialog is used for defining various form properties.

TIP

To open the Form Properties dialog, double-click the design surface.
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Basic Settings Basic settings

Title:

Additional Settings

Style

F1 Help

Events
Size
Variable Events

Width:

Serial Port Data Height:
Info Initial form state
Maximized

®) Default form size
Startup form position

Screen center

Scroll bars

Form

Show form title bar
Allow closing form
Tab Order Allow resizing form
Allow minimizing form
[ Minimize to tray

1024 px

768 px

10 px

10 px

["] Show scroll bars and stop resizing form elements
0 px

0 px

Form Properties

40 4

x| |4

-

Cancel

The settings are available on the below-listed dialog panels.

Form Property
Basic Settings
Additional Settings
Style

Tab Order
F1 Help

Events

Variable Events
Serial Port Data

Info

Description
Defines form title, size, initial form state and startup form position.
Selects form scripting language.

Defines form background color and picture. It allows picture
embedding and saving as external file.

Defines the order of focus Shifting among form objects.

Contains form help text which is shown to the user after pressing F1
when the form is running.

Defines the events which occur after the form is loaded, closed, and
after a specified time interval completes.

Selects the variables that are monitored for changes in their values.
Adds a variable that stores the data received via serial port.

Defines the content which serves as a hint or as a guidance for the
form user.

7.4.2.1. Basic Settings

Basic Settings panel defines the title, size, and startup behavior of a form after you run it.

Title sets the form window title.

+ Show form title bar: window title bar is visible or hidden upon form startup.

351




+ Allow closing form: form close using the window Close button is allowed or not.

TIP

With this option disabled, the form can be closed from taskbar.

+ Allow resizing form: form size customizable or fixed.

TIP

Disable this option to lock the form size.

Minimizing forms

You can enable forms (solutions) you design to minimize to your taskbar or to your taskbar
notification area (system tray). Minimizing your forms allows them to run them in the background
and reduces inputs and prevents human errors from your operators. Use minimize options on forms
with limited inputs that don't require human interaction.

Allow minimizing form is enabled by default in Form Properties and allows minimizing your form to
the taskbar. Allow minimizing form is also possible when you disable Allow resizing form.

|§ NOTE

When you open forms made in versions earlier than V2019.3, Allow minimizing form
option automatically disables when you disable Allow resizing form.

Form Properties

Basic Settings Basic settings

Additional Settings Title: Form
. Show form title bar

i3 Allow closing form

Allow resizing form

Allow minimizing form
[ Minimize te tray

Events Size

Tab Order

F1 Help

Variable Events Width: 1024 px

4F (4

Serial Port Data Height: 768 px

Info Initial form state

Maximired

Enabling Allow minimizing form in Form Properties.

Minimize to tray enables minimizing your form to the taskbar notification area. This is useful when
you want to run your form in the background. For example, if your form is automated and doesn't need
your operators to interact with your form user interface. Your only form input is barcode scanner data,
and all your form actions execute automatically when operators scan barcodes.
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Form Properties

Basic Settings Basic settings

Additional Settings Titles Form
~ Show form title bar

dok= Allow closing form

Tab Order

F1 Help

Allow minimizing form
Minimize to tray

Events Size
Variable Events Width: 1024 px e

Serial Port Data Height:

Info Initial form state

Enabling Minimize to tray in Form Properties.
Enabling Minimize to tray with your Command Prompt

With running solutions from your Command Prompt, you can force your form to start minimized
in your taskbar (system tray). When minimized, right-click on the taskbar icon to open or exit your
running forms.

1. Open Command Prompt (CMD).
2. Navigate to your "NiceLabelWebClient.exe" or "NiceLabelPrint.exe".

3. Add the path to the form you want to minimize.

[Version 10.0.19041.

t Corporation. All ri

>"C:\Program Files\NicelLabel\NiceLabel 2019\bin.net\NicelabelPrint.exe")"C:\Documents\NiceLabel\Solutions|BestNoodles PrintSolution.nsln"|(-startAsMinimized:true

4. Type "-startAsMinimized:true" after your filepath.
5. Press Enter.

Your Form loads and immediately minimizes.

Minimizing forms to your taskbar or taskbar notification area (system tray) reduces human errors and
prevents your operators from intervening on your forms.

Size group defines the form's Width and Height.
Initial form state group defines form state upon startup.

+ Maximized: form opens in full screen mode.

+ Default form size: when run, the form appears with manually defined sizes.

Startup form position group defines the on-screen position of a form upon its startup.

+ As defined: the form appears at a location defined by the distance in pixels from Left (left edge of the
form) and Top (top edge of the form).

« Screen center: screen center is the startup form position.

Settings in Scroll bars group optimize forms for smaller screens or computers with low screen resolution.
As an alternative to making forms and objects small, and hard to read and use, enable Show scrollbars and
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stop resizing form objects at:. This option defines form Width and Height in pixels. These are minimum
dimensions at which:

+ The form gets scroll bars. You can continue reducing the form size beyond these dimensions and
make the form area scrollable.

+ The objects stop adapting their sizes to the reducing form size. This makes sure the objects remain
usable because they retain their current size beyond minimum dimensions of the form.

|§ NOTE

To make the objects resize along with changing form size, enable horizontal and
vertical resizing with form under Object Properties > Position > Size > Horizontally/
Vertically resize with form.

7.4.2.2. Additional Settings

Additional Settings panel selects form scripting language. There are two scripting languages available for
Designer form objects: VBScript and Python.

+ VBScript: scripting for advanced data operations, comparisons, and direct calculations on a form.

+ Python: suitable for 64-bit systems. A significantly faster scripting alternative to VBScript.

7.4.2.3. Style

Style panel defines form background color and/or picture. It also allows picture embedding and saving as
an external file.

+ Background color is defined by the Standard or Advanced color selection. Switch between these two
options by clicking the Advanced or Basic button.

+ Browse for the label Background picture or insert the direct path. Once the picture has been defined, it
is possible to:

+ Embed the picture to document: makes the picture an integral part of the document.
- Save embedded picture to file: embedded picture is saved to a file.
+ Remove embedded picture: embedded picture is removed from the form document.

+ Picture position: background picture to be centered, to fit the label dimensions, or to be
stretched.
7.4.2.4. Tab Order

Tab order panel defines how the focus is moving from one form object to another after pressing the Tab
key.

+ ENTER key behaves as TAB key: Enter key gets the same role as the Tab key does. After pressing
Enter, focus moves to the next object as defined on the Tab order list.
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+ Select the form Object and move it up or down the Tab order list to define the focus switching order.

7.4.2.5. F1 Help

F1 Help panel defines custom form help content to help the end-user while designing and/or using a form.
The text becomes visible after pressing F1 key when the form is run.

TIP

Enter custom text in the editing field and click OK.

7.4.2.6. Events

Events panel allows setting actions for basic form events.

+ On Form Load: the action is run upon form load.

+ On Form Close: the action is run when the form is closed.

« On Form Timer: the action is run after a given time interval.
+ Interval: duration of the time interval (in milliseconds).

+ On Form Inactivity: the action is run after the form has been inactive for a given time interval. Form
inactivity is defined as the absence of key press, mouse click, or form move user actions. Any of these
user actions reset the inactivity timer.

+ Interval: duration of the time interval (in minutes).

TIP

Click Actions ... button to set the actions that are run by the listed events.

7.4.2.7. Variable Events

Variable Events panel selects the variables that are monitored for changes in their values. If values of these
variables, the On change event triggers an action.

+ Add: adds a variable to the list.

* Delete: removes a variable from the list.

TIP

Click Actions ... to set and manage the actions that are triggered by changed values in the
listed variables.
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7.4.2.8. Serial Port Data

Serial Port Data panel selects serial (RS-232) ports to read the data from connected serial devices. The
read data is stored in an existing or a newly created variable.

+ Add: adds a serial port to the list connected serial devices.

+ Delete: removes the port from the list connected serial devices.

TIP

Click Edit to configure serial port communication settings.

7.4.2.8.1. SERIAL PORT DATA SETTINGS

Serial Port Data window defines connection parameters for the selected serial port. Parameters in this
dialog box have to match with the connected device's settings. Refer to the documentation of your serial
communication device to set the communication parameters properly.

|§ NOTE

If the settings in NiceLabel 10 and on the device do not match, communication cannot be
established.

Port group defines serial port to read the data from.

+ Port name: name of the port to which an external device is connected. This can either be a hardware
or a virtual COM port.

Port Settings group defines additional port connection settings.

+ Bits per second: speed rate used by the external device to communicate with the PC. The usual alias
used with the setting is "baud rate".

+ Data bits: specifies the number of data bits in each character. 8 data bits are almost universally used
in newer devices.

+ Parity: specifies error detection method during the ongoing transmission. The most common parity
setting, is "none", with error detection handled by a communication protocol (flow control).

+ Stop bits: halts the bits sent at the end of every character allowing the receiving signal hardware
to detect the end of a character and to resynchronize with the character stream. Electronic devices
usually use a single stop bit.

+ Flow control: serial port may use interface signals to pause and resume the data transmission.
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Example:

A slow device might need to handshake with the serial port to indicate that data should be paused while the
device processes received data.

Options group includes the following settings:

- Send initialization data: specifies the string that is sent to the selected serial port before the data is
read. This option enables the action to initialize the device to be able to provide the data. The option
can also be used for sending a specific question to the device, and to receive a specific answer. Click
the arrow button to enter special characters.

+ Use data polling: specifies that the trigger will actively ask the device for data. Within the specified
time intervals, the trigger will send the commands provided in the Contents field. This field can
include binary characters.

Filter group allows you to set the serial port data filtering criteria.

+ Use Filter: enables serial data filtering. This option filters any irrelevant characters from the received
data.

+ Start position: sets the starting character for extracted data.

+ End position: sets the ending character for extracted data.

Example:

Received raw data includes the following characters: q###12345$$81. After setting Start position to 5 and
End position to 9, the extracted data is 12345.

Execution Event group specifies when the trigger should fire and start executing actions.

+ On number of characters received: specifies that the event occurs each time the required number
of characters is received. In this case, the third party application can keep a connection open and
continuously send the data. Each chunk of data must be of the same size.

« On sequence of characters received. Specifies that the event occurs each time the required sequence
of characters is received. Use this option if you know that the 'end of data' is always identified by a
unique set of characters. You can insert special (binary) characters using the button next to the edit
field.

+ Include in data: sequence of characters that is used to determine that the event activator is not
stripped from the data, but remains included in the data. The event receives a complete received
data stream.

+ When nothing is received after the specified time interval: event occurs after the specified time
interval (in ms) passes since the last received character.
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7.4.2.9. Info

Info panel includes a Description that serves as a hint or as a guidance for the user that is going to work
with the form.

Define form Description by entering text into the field.

7.4.3. Adding Objects to a Form

After setting the form properties, it's time to start adding content to the form. Form objects are basic design
items that are used for adding and editing various content types.

Add object to a form by clicking them in the object toolbar and dragging it to the design surface. Each form
may contain multiple object in any combination.

TIP

Use visual aids when positioning an object.

7.4.4. Form Objects

PRODUCT LEVEL INFO

This section is applicable to PowerForms.

Each form object has its own role as described in the table below.

Form Object Icon Description
Frame r-=s Creates a rectangle shaped area on a form.
Frame
Text Object for inserting textual content.
T ~
Text
Picture Object for inserting graphic content.
v J g grap
Picture
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Form Object

Button

Edit Field

Memo Field

Combo Box

List Box

Radio Group

Checkbox

Database Table

Database
Navigator

Database
Search

Icon

(o) v

Button

[abd] ¥

Edit Field

abc*|
v

Memo Field

B v

Combo Box

"
"
= ¥

List Box

v

oom
111

Radic Group

[v] v

Check Box

%v

Databaze
Table

=

HAKH
Database
Mavigator

=
‘{q v

Database
Search

Description

Creates 